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Revision Log

	Date
	Revision

	07/xx/08
	· Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: 
Process Engine: 755147
· Workplace: 744396
· CFS: 393041
· Process Engine: 748619
· Process Java API: 751031
· Content Java API Compatibility Layer: 746321
FileNet P8 Documentation: 
Workplace: 744541
CFS: 556402, 556098
Process Engine: 745011, 754451
CE API: 759589

	01/17/08
	· Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: 
App Engine: 686853
Process Engine: 390821
Miscellaneous: 555577
· Process Engine: 204315 (update), 556206
· Application Engine:
Workplace: 387552
ISRA Integration: 744160
· CFS: 174707, 379198, 382437, 386592, 386685, 389260, 556078,555984
· FileNet P8 Documentation: 
CE: 686831
CFS-IS: 390964, 556024
Installation/Upgrade: 745010
Miscellaneous: 366773, 390558 

	11/16/07
	· Adds new sections for: “Accessing IBM FileNet Documentation” and “Compatibility matrices and fix packs”.
· Adds a statement in ”What’s New” for Oracle 10g support, beginning with PE Service Pack P8-3.5.3.

· Adds a Known Limitations section for Content Federation Services

· Adds or updates Known Issue DTS for the following:

· Content Engine: 209309
· Process Engine: 213386, 215266, 216825 
· Application Engine:
Workplace: 205337, 210033, 212515 
Workplace Application Integration: 188454
· CFS: 167894 (update), 207332, 208987 (updates) 
·  eForms for P8 Workplace: 555121 

· FileNet P8 Documentation: 
Developer Help: 146346

CE: 212313
Installation/Upgrade: 214176 
Process Engine: 213979
Content Java API: 212817

	08/08/07
	· Adds or updates Known Issue DTS for the following:

· Application Engine:
Workplace:  211151, 211320
· CFS: 207332, 209717, 211255

· eForms for P8 Workplace: 203950, 207980, 207994, 207996, 208099, 208836, 208839, 208853, 208734 
· FileNet P8 Documentation:
Installation/Upgrade:175082,178226,179776, 199326 
CFS: 176274
Workplace: 211470

	06/11/07
	· Corrects a support statement regarding Oracle 10g support. Now reads Oracle 10g database server support. 

· Adds or updates Known Issue DTS for the following:

· CFS: 207330, 207331, 207415, 208448, 208449, 208453, 208987, NA

	05/18/07
	· Adds or updates Known Issue DTS for the following:

· Rendition Engine:and Publishing: 204315 

· Documentation: 
Content Engine: 196233

	04/16/07
	· Adds or updates Known Issue DTS for the following:

· Application Engine: 199509, 198949, 198498, 198496, 198175, 184683, 167821, 160783, 153495, 133122

· Content Engine: 199903, 198520, 180567, 164584, 163778, 135993
· CFS: 165930, 203766, 202982, 202373, 201728, 201127, 151995
· High Availability: 200572, 199318
· Localization: 198359
· Process Engine: 204018, 201958, 200847, 198712, 196980, 163333, 140491
· Rendition Engine: 163329
· Adds descriptions of new features obtained by installing FileNet Fix Pack P8AE 3.5.1-003, 005, 006, 007. 

	01/04/07
	· Adds or updates Known Issue DTS for the following:

· Localization: 183658

· Application Engine: Workplace/File Tracker 172626

	12/19/06
	· Adds or updates Known Issue DTS for the following:

· Application Engine: 143428
Search Designer: 191297, 195626, 196853

· Process Engine: 183553

· Process Simulator: 180405

· Process Orchestration: 151907

· Content Java API: 196103

· Updates a number of DTS as “Fixed in eForms Fix Pack 3.5.1-002 and 3.5.1-003”

	11/08/06
	· Adds or updates Known Issue DTS for the following:

· CFS-IS: 175654

· eForms for P8 Workplace: 187457, 189007, 190947
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-002”

	10/04/06
	· Adds Content Java API update to the Developer’s topic of the ‘What’s New in 3.5.2’ section

· Adds or updates Known Issue DTS for the following:

· Application Engine: 190437

· eForms Designer: 187005, 188560

· Documentation: 
Developer Help: 164584
eForms Designer 177872

	09/19/06
	· Fixes formatting issues, removes duplicate DTS entries

	09/06/06
	· Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: 
App Engine: 185872

· Application Engine: 183554
Workplace: 163752 , 173878, 184357, 186345
Designer: 176003

· Process Engine Web Services: 187384

· eForms for P8 Workplace: 183896, 183902
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-001”

· Content Java API: 186984, 187287

	08/04/06
	· Employs new formatting for this document and adds Resolved Known Issues tables by Fix Pack release

· Adds or updates Known Issue DTS for the following:

· Content Engine: 168820, 177480

· Adds new section (table) of Known Issues for CFS and NTFS (includes 26 new DTS – see table page 72). 

· Process Engine: 155754 (updated description), 173593 

· eForms for P8 Workplace: 176468, 181947, 182682, 182784, 182940, 182930, 
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-001”

	07/07/06
	· Adds eForms update to the What’s New in 3.5.1section

· Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: 
Content Engine: 158222 (update), 164728

· Content Engine: 

· Application Engine: 
Workplace: 160682

· eForms for P8 Workplace: 171598, 171671, 174359, 177434
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-00x”

· Process Engine: 179008

· Process Analyzer: 180920

· Content Java API: NA, regards ‘Name override when calling Folder.addSubFolder’
· FileNet P8 Documentation:
Miscellaneous: 164584, 181427
Content Engine: 181156

	06/07/06
	· Adds a new section to Known Issues titled “Internationalization” with notes and the following DTS:

· 20261, 121184, 140217, 142201, 142826

· Adds Content Java API updates to the What’s New in 3.5.1 section

· Adds eForms 3.5.1 for FileNet P8 Workplace update to the What’s New in 3.5.1 section

· Adds Records Manager information to the What’s New in 3.5.2 section 

· Adds or updates Known Issue DTS for the following:

· Content Engine: 175969

· eForms for P8 Workplace: 160945, 169845, 171051, 171826, 173786, 175019, 175165, 175284, 175790, 175903, 176713

· FileNet P8 Platform Installation/Uninstallation: 
App Engine: 148759

· Content Java API: 178701, 179287

· FileNet P8 Documentation – CFS-NFTS: 180352
Developer Help: 180191

	04/28/06
	Adds Content Engine updates to the What’s New in 3.5.2 section

Adds Application Engine updates to the What’s New in 3.5.1section

Adds or updates Known Issue DTS for the following:

· eForms for P8 Workplace: 160945, 161141, 161170, 166355, 169827, 169321, 169522, 169718, 169732, 169818, 171051  
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-004”, including:
150327, 159854, 164387, 167938, 169063, 165017, 165020, 165805, 166507, 169635, 168987, 169035
·  eForms Documentation: Updates a number of DTS as “Fixed in eForms Designer Fix Pack 3.5.0-004”, as follows: 167938, 162948, 165282, 165500, 168942

	04/05/06
	Adds or updates Known Issue DTS for the following:
· Application Engine: 
Workplace: 152933, 153877, 156523, 158212, 170547, 170966, 172410, 172887, 173164, 173439, 174518, 174578, 173649, 174490 
File Tracker: 173620, 173633, 173637, 174102, 174373
Image Viewer: 169184

· Process Engine: 170628

· FileNet P8 Platform Installation/Uninstallation: 
App Engine: 173031, 174513
Content Engine: 167902, 171683, 172868, 172242, 174571,175499

· FileNet P8 Documentation Installation/Upgrades: 167745
Shutdown/Startup: 173257

· FileNet P8 Documentation: 172645

	03/01/06
	Unites all levels of 3.5.0 and up into one set of Release Notes (3.5.0, 3.5.1, 3.5.2)

Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: Content Engine: 158222, 162272, 165916, 167933, 171413, 170900
Misceallaneous: 171221

· Content Engine: 157956, 163287, 169386, 169865

· Process Engine: Web Services 169686

· Application Engine: 145011, Workplace 161019, updates DTS 163799

· Documentation: 172246

	01/19/06
	Adds note regarding support for RM, TCM, WCM

Adds or updates Known Issue DTS for the following:

· Content Engine: 167763

· Application Engine: Portlets: 166171, 166638, 166949, 167850, 167986

· Content Java API: 168145

	12/20/05
	Adds “What’s New in 3.5.2” section

Adds Known Issues for 3.5.2: BAM

	12/06/05
	Updates “eForms Designer" subsection of "What's New". See section for updates.

Updates “Documentation" subsection of "What's New". 

Adds or updates Known Issue DTS for the following:

· FileNet P8 Platform Installation/Uninstallation: Content Engine: 159727

· Application Engine: 164706

· Rendition Engine and Publishing: 166636
· eForms for P8 Workplace: 159437, 166372, 166386, 166390, 166393, 166508  
Also updates a number of DTS as “Fixed in eForms Fix Pack 3.5.0-003”

· eForms Designer: 167367, 167370, 167378, 167379  
Also updates a number of DTS as “Fixed in eForms Designer Fix Pack 3.5.0-002”

· Content Java API: 167430

	11/08/05
	Initial document posting.


Introduction

This document contains Release Notes for FileNet® P8 Components, and contains the following major topics: 
· What’s New in 3.5.2 – Describes new 3.5.2 features.

· What’s New in 3.5.1 – Describes new 3.5.1 features.

· What’s New in 3.5.0 – Describes new 3.5.0 features.

· Resolved Known Issues – Describes known product and documentation issues that have been fixed. These are sorted according to the fix pack release number in which they were fixed.

Accessing IBM FileNet documentation, compatibility matrices, and fix packs
Documentation
To access documentation for IBM FileNet products: 

1. Navigate to the Information Management support page (www.ibm.com/software/data/support ). 

2. Select the appropriate IBM FileNet product from the "Select a category" list. 

3. From the Product Support page, click Documentation, and then click Product Documentation.  

4. From the Product Documentation page: 

a. If necessary, display the document list by clicking the Doc Link for the appropriate component product. 

b. Click the icon in the appropriate release column to access the document you need. 

Compatibility matrices and fix packs 
To access compatibility matrices and fix packs for IBM FileNet products:

5. Navigate to the Information Management support page ( www.ibm.com/software/data/support ). 

6. Select FileNet Product Family.
7. Click Download under “FileNet Product Family support”.
8. From the FileNet Product Family support page, Search for “fix packs”.
9. From the search results page, click IBM FileNet Fix Packs.
10. From the IBM FileNet Fix Packs page, clicke a product name:
11. In the select product page: 

Compatibility matrices
Click Matrix to view the compatibility matrix.

Fix packs
Click the product version number to start the fix pack download
What’s New in 3.5.2

Application Engine

Workplace has new functionality that pertains to Records Manager 3.5.1, such as a new action and new step in the entry template process. See the Records Manager Release Notes. This document assumes you are a systems administrator and you have:

· Reviewed the IBM FileNet P8 3.5.x Hardware and Software Requirements Guide and verified that FileNet P8 supports the hardware and software components in your current configuration.

· Installed FileNet P8 according to the IBM FileNet P8 Platform 3.5.x Installation and Upgrade Guide
To download these guides from the IBM support page, see Accessing IBM FileNet Documentation.
Content Engine

· Introduces support for:

· Records Manager 3.5.1.

· Content Federation Services for Content Services and non-FileNet Repositories 3.5.1.

· Introduces support for:

· Oracle 9.2.0.7 database engine.

· Oracle 10g R2 database engine (as of fix pack P8CE-3.5.2-005)

· IBM® DB2 Universal Database™ 8.1 Fix Pack 12 (as of FileNet Fix Pack P8CE-3.5.2-001).

· Introduces sub-folder performance enhancements, primarily for Records Manager 3.5.1 and FileNet eMail Capture 4.1.0.

· Introduces a Windows Registry setting to specify a particular Object Store Service for use by COM clients.
· Enables multiple file stores to be associated with a single storage policy.

· Sets the Service Principal Name (SPN) to enable Kerberos .NET Web Services clients. (DTS 171413)

· Provides a CE Setup flag to install to drives other than c:\. (DTS 148865)

eForms Designer 

eForms Designer now supports the Autoshrink feature for the FileNet P8 target fill platform. (DTS 185718)

Process Engine

· New support for:

· Oracle 10g R2 database engine (as of service pack P8PE-3.5.3)

· IBM AIX® 5.3. 

· IBM DB2® (remote) on Solaris.

· FileNet IS 4.0.40.

Business Activity Monitor (3.5.0)

FileNet Business Activity Monitor (BAM) is an application that provides real-time visibility into business process data to enable timely response to changing business conditions.
With FileNet BAM, business managers can view process data from the desired perspective via user-configurable dashboards. Business analysts can define business logic using the integrated rules engine to dispatch alerts to specific users when process values are outside defined parameters, and if need be, can automatically initiate actions or workflows based on those alerts. Business managers can also analyze data and correlate it with business processes, as well as with data from other enterprise applications, to gain further insight into specific alerts and events. 

FileNet BAM consists of the following modules:

· FileNet BAM Workbench - Business analysts use this module to specify the queries, data views, and other items that capture the desired data, and to define the business rules for alerts.

· FileNet BAM Dashboard - Business managers use this module to view the process data as it is generated, and to receive alerts and reports.

· Predefined solutions - Three predefined projects—OOTBConfiguration, Buckets, and Thresholds—include all the objects for viewing FileNet P8 process data from several perspectives.

Process Simulator

· Process Simulator can simulate a duration for a Component step.

Developer Help

Content Java API

· For all Content Java™ API interfaces that have XML methods, the behavior has changed for any XML method that can return permissions along with a properties collection (for example, getPropertiesXML and getContaineesXML). In Release 3.5.0, if properties were not specified in the argument (for example, getPropertiesXML(null)), the returned XML differed depending on which object it was called from: CustomObject, Document, Folder, or Link. For example, Link.getPropertiesXML(null) returned properties, but also included empty permissions tags (<permissions></permissions>) in the returned string. Document.getPropertiesXML(null) returned properties but no empty permissions tags. When called on Document and Link objects, the method returned empty permissions tags if properties (but not permissions) were requested.

In releases after 3.5.0, the behavior of XML methods is now consistent as follows: if Permissions are not requested (for example, getPropertiesXML(null) is called), then the returned XML does not contain empty <permissions> tags. This behavioral change does not represent a change in the XML schema for the data returned by those methods.  The XML schema is documented in the Reference section of the Developer Help -> Developer Roadmap.

What’s New in 3.5.1

The FileNet P8 Platform software has been upgraded with new features for this 3.5.1 Service Pack release. Use this topic to review summary information on features and changes made for this release. Refer to the specific component help topics for more in-depth and detailed information. 

NOTE  Service Pack CDs contain readmes that provide installation procedures and details on particular software fixes. Those readmes, like other FileNet P8 documentation, may be updated from time to time with corrections or new information. Check the Download Patches area on the IBM Information Management support page (www.ibm.com/software/data/support) for such updates.

Installation/Upgrade/Support

· Windows Server 2003 R2 is supported. 

· The Application Engine 3.5.1 Service Pack provides updates in support of installing and upgrading Workplace. 

· A new procedure has been added to deploy multiple instances of Workplace on a single application server.

· Enhanced support has been added for upgrading the files that support Workplace customization. These files include content_redir.properties, actions.xml, icons.properties, etc.

· As of December, 2005, Records Manager, Team Collaboration Manager, and Web Content Manager are supported with FileNet P8 Platform 3.5.1. Support is offered at the following component levels:

· Records Manager: Fix Pack 3.5.0-001

· Team Collaboration Manager: Fix Pack 3.5.0-001

· Web Content Manager: 3.5.0

Application Engine

The following features are available after you install the P8AE-3.5.1-007 fix pack: 

· A new Site Preference, "Multiple Files Use Zip" is located under the Mail section of General Site Preferences. This new Site Preference allows an administrator to determine whether or not a zip file should be used when sending multiple files in email. 

· This fix pack now includes J2SE Runtime Environment 5.0 Update 9 for client machines. This JRE version is compliant with the new Daylight Savings Time regulations that take effect in March 2007.

· The caching of the Property Description XML files are changing with DTS 193940. The XML will now be cached at the application level instead of at the session level. In order to improve performance when retrieving large, complex choice lists, the internal P8 metadata relating to Document classes and properties will now be cached in an application cache instead of a session cache. This new application cache needs to be cleared in order to force a refresh from the server. This can be accomplished via a new Site Preference called "Class Description Cache", located in the Refresh section. Clearing this cache will pick up changes to existing class property descriptions and choice lists. The application cache does not need to be refreshed in order to pick up new classes. Note A user must logout and log back in to pick up the new changes. 

The following feature is available after you install the P8AE-3.5.1-006 fix pack: 

· If a user’s Simple Search property criteria settings are set to use the “contains”, “starts with”, or “ends with” operator, Simple Search will expose configurable search operands. The user may now select “contains”, “starts with”, or “ends with” via a drop down control on the Simple Search page. 

The following feature is available after you install the P8AE-3.5.1-005 fix pack: 

· Search templates now support configurable search operands. If the operands “is like” or “is not like” are used when designing the search template, at runtime when the search template is used, the user may select “contains”, “starts with”, or “ends with” via a drop down control.

The following features are available after you install the P8AE-3.5.1-003 fix pack: 
· The QuickStart feature provides a mechanism for initializing a Web browser, Java, and Image Viewer session. The background task required to initialize an Image Viewer session is done at the time when the web browser is initialized, prior to the time when the Image Viewer is actually required. This reduces the startup time of the Image Viewer. This feature is supported on various operating systems, such as Microsoft® Windows® 2000 Professional and XP. It also supports the Internet Explorer and Firefox web browsers. The QuickStart feature is not enabled by default; it must be manually enabled. 

Note To avoid having to deploy your system twice, make sure to perform the QuickStart configuration steps after you have applied the fix pack but before you redeploy your system. 

See the ‘Configure Imxage Viewer QuickStart’ instructions at the end of the Installation Instructions in the FileNet Fix Pack P8AE 3.5.1-007 readme.txt for details on using the QuickStart feature. 

· A new site preference, “Maximum number of folders to display”, limits folders displayed in Workplace. 

· The restriction in P8 3.5.x to use the Email document class or subclasses when adding email using an entry template via Application Integration has been lifted. Other document classes may now be used. 

The following features are available after you install FileNet Fix Pack P8AE-3.5.1-002: 

· File Tracker tracks a document on your local machine after you check it out from an object store. 

· Folder content caching might or might not be enabled depending on settings specified by your site administrator. 

· Annotation security has been updated for Image Viewer.

The following list provides a high-level summary of new features and functionality added to the Application Engine and Workplace.

· Application Engine now provides a list, via a .txt file (P8AE-3.5.1Changes.txt) of all new and modified source files at the root of each CD.

· The Search and My Search pages have been combined into a single Search page that provides access to your own simple search or search templates. In addition to “contains,” search now supports "starts with" and "ends with" operations. The search template view has been enhanced with a simplified view of "and/or" nesting.
· The System Properties and Properties views of the Information page have been combined. System properties are now available in the Properties view and can be configured to display in an expanded or collapsed format. In addition to selecting which properties to show and in which order, administrators can also provide their own customized names for these properties. 

· The Multi-Select Actions link has been renamed Actions Menu and is now displayed when one or more items are selected. The actions displayed in the menu depend on whether one item or several items are selected. 

· The Browse and Search list view now supports changing from a “Detailed” view to a “Magazine” view by selecting the desired view from a dropdown. Previously, this option was modifiable only through preferences.
· The Insert Hyperlink command in Application Integration now displays friendly URLs for Office. 

· The requirement to file newly-added documents into a folder has been relaxed. Workplace now supports adding documents to an object store without selecting a folder. Enabled through a site preference, the requirement to file documents in folders when they are added is optional.
· Entry Template settings can be used for checking in a document created with the template. Users will now have the same experience checking in documents as they do when adding new documents with entry templates. The templates support turning off wizard pages and setting default property values and security. Existing documents added by entry templates will now honor the template for checkin.
· In the Add wizards, the Select Class page has been combined with the Set Properties page to eliminate a step in the wizard. You can view or select the class from the Set Properties page.

· The behavior for the Home link has been improved. You can now configure the Home link to display a specific primary view. The Workplace logo is a link to the selected Home view.

· Custom objects in the Workplace user interface (UI) can now be differentiated by type, with each type identified by a unique image and title string. Custom object types are defined with a Content Engine feature AddOn. For details, see “Mapping Images to Custom Object Types” in the Workplace Integration and Customization Guide.

· UI labels for common terms and system properties can be customized in Workplace. You may find this feature convenient if you prefer site-specific labels over the Workplace defaults, or if you've upgraded from an earlier FileNet product that used different labels than Workplace. For details, see “Customizing UI Labels” in the Workplace Integration and Customization Guide.

· IntegrationServlet has been enhanced with Application Engine UI service command 2120 which displays a tree view control for selecting objects. For details, see “Integrating with Workplace” in the Workplace Integration and Customization Guide.

· The administrator may now do the following: 

· Filter object store access by applying access roles.  When access roles are applied, object stores won't be displayed in the Workplace UI to those users who do not have access rights. Object store filtering applies to Authoring, Browse, Search and Shortcuts.  In addition, users will not be able to run a search template that refers to an object store they do not have rights to view. 

· Customize the following labels with user-friendly text: object store, path, classification, file plan, profile, class, and subclass. These labels apply throughout Workplace.

· Hide or show the primary views tab bar and footer links. For example, you may see primary views listed in the sidebar or you may see them listed near the top and bottom of browse pages.  
Content Engine

The following list provides a high-level summary of new features and functionality added to the Content Engine and Enterprise Manager.

· Added support for remote Oracle9i 9.2.0 databases on Linux servers.
· Added support for Hitachi fixed store devices.
· Added the capability for customers to use the authentication mechanism of their choice so that users and client applications need sign on only once across multiple FileNet P8 applications.
· Added Content Engine support for storage policy objects. A storage policy object provides mapping to a specific physical storage area and is used to specify where content is stored for a given class or object with content (for example, a document). FileNet P8 supports one-to-one mapping of a single Storage Policy to exactly one storage object; therefore, each storage policy has only one associated file store as its storage area. (An upcoming fix pack will enable one storage policy to support multiple file stores.)
· Added Enterprise Manager support for setting minimum, maximum, and default retention period values for Snaplock and Hitachi Data Systems fixed content devices.
· Improved the import and export of large object stores. Now, the import/export process can be configured to automatically split the export into multiple files which can then be imported in a group.

· WorkplaceCustomObjectExtensions.xml has been added for incorporating the hidden CustomObjectType property to the Custom Object class. The hidden property is used by Workplace to differentiate Custom objects by type. See “Custom Objects” in the Workplace section below. 

eForms for FileNet P8 Workplace

This release provides customization capabilities by means of the eForms JavaScript™ API. With this API, you can enhance the user’s form filling experience by incorporating your own HTML content and JavaScripts which can interact with the eForm at runtime in the user’s web browser.

eForms Designer 

· eForms Designer now supports extensible authentication for authenticating to FileNet P8 Workplace. (DTS 161119)
Extensible Authentication

· As of the FileNet P8 3.5.1 Service Packs, an API framework for supporting Single Sign-On (SSO) products from leading vendors including IBM, Netegrity, Oblix, RSA and others is provided.  The APIs enable FileNet partners and 3rd party developers to develop and support solutions for the broad range of SSO products that customers use.

Process Analyzer

· The 3.5.1 Service Pack provides some changes in the measurements available for analysis on the Process Analyzer, as follows:

· These measurements were added to the Work in Progress cube:

· Average proc min current

· Average wait min current

· The Productivity Count measurement was removed from the Work Item Processing Time cube.

Process Engine

The following list provides a high-level summary of new features and functionality added to the Process Engine.

· Rule sets with longer execution times can now be executed asynchronously in the background. The functionality must be enabled in the Process Configuration Console in Set Runtime Options to enable the workflow author to identify rule sets for asynchronous processing.

· The following commands have been added or modified in the vwtool utility.

· environment: Adds the inconsistency option which allows you to reconcile cached and permanent user data environment records on the Process Engine with the possibly more-up-to-date data in an LDAP-based directory service.

· dump: Adds the ability, when dumping classes to XML, to specify whether to include inherited fields and maps. Previously inherited fields and maps were always included, which prevented converting cdl files to pep files and using pep files for classes that were based on other classes.
· trace: Adds improvements to the syntax for setting and resetting trace options.
· processmap: Displays a process's virtual memory map on a Windows-based Process Engine.

· processworkingset: Displays a snapshot of a process's working set (RAM resident pages) on a Windows-based Process Engine.

· emptyqueue: Restores the ability to delete all work items from a queue.
Process Engine Web Services
· The 3.5.1 Service Pack provides multiple region support.

Process Simulator

The following list provides a high-level summary of new features and functionality added to the Process Simulator.

· Simulation Designer 

· The initial value of workflow data fields can be set on the Arrivals page in the Simulation Designer.
· Analytical data for the Delay and the Wait for Condition system instructions can be output to the Process Analyzer.

· Simulation Console 

· Simulations are stored in the specified folder until the user deletes them—there is no expiration time limit.

· The list of scenario and simulation files displayed in folders is now automatically updated as items are added or deleted. In User Preferences, you can specify how frequently the list is refreshed.
· In User Preferences, you can now specify the maximum number of items that can be displayed in a folder. A symbol on the folder icon indicates when the selected folder has more than a maximum number of items. 

Rendition Engine

· The 3.5.1 Service Pack provides a new version of Rendition Engine software. The version has been updated from Liquent version 2.1.2 to Liquent version 2.2. As described in the following list, this version resolves numerous problems from earlier releases and has a redesigned user interface. 

· The updated Rendition Engine provides:

· Windows 2003 support.
· Office 2003 on server support.
· Improved load balancing. The Rendition Engine looks for the least-busy server to handle portions of submitted publishing jobs.

· Improved administration controls. Administrators can cancel, suspend and resume jobs at business service granularity. 

· Simplified installation process with many improvements.

· As before, the Rendition Engine works by running an application on the Rendition Engine server and printing the job to an XML printer driver. The list of applications supported by the Rendition Engine now includes the following:

	Company Name
	Application Name 
	Supported Versions

	Adobe®
	Frame Maker
	7.1

	Adobe
	Ilustrator
	10.0

	Adobe
	Pagemaker
	7.0

	Adobe
	Photoshop
	7.0

	Microsoft
	Word
	2000 sp3, XP sp3, 2003 sp1

	Microsoft
	Excel
	2000 sp3, XP sp3, 2003 sp1

	Microsoft
	Internet Explorer
	6.0sp1

	Microsoft
	PowerPoint
	2000 sp3, XP sp3, 2003 sp1

	Microsoft
	Project
	2000 sp3, XP sp3, 2003 sp1

	Microsoft
	Visio
	2000, 2002, 2003

	Corel
	WordPerfect
	12

	Lotus®
	WordPro
	9.8

	Lotus
	123
	9.8

	Lotus
	Freelance
	9.8

	Autodesk
	AutoCAD
	2004

	CambridgeSoft
	Chemdraw
	8.0

	MDL
	Isis Draw
	2.5


Workplace

User Interface (UI)

· Custom objects in the Workplace UI can now be differentiated by type, with each type identified by a unique image and title string. Custom object types are defined with a Content Engine feature AddOn. For details, see “Mapping Images to Custom Object Types” in the Workplace Integration and Customization Guide.

· UI labels for common terms and system properties can be customized in Workplace. You may find this feature convenient if you prefer site-specific labels over the Workplace defaults, or if you've upgraded from an earlier FileNet product that used different labels than Workplace. For details, see “Customizing UI Labels” in the Workplace Integration and Customization Guide.

IntegrationServlet

· IntegrationServlet has been enhanced with command 2120, which displays a tree view control for selecting objects. For details, see “Integrating with Workplace” in the Workplace Integration and Customization Guide.

Developer Help

· The 3.5.1 Service Packs provide the following API updates. 

Content Engine COM API

· New support for fixed content devices:

Classes: FSBFixedContentDevice and SnapLockFixedContentDevice classes have been added.
Properties: The ConfigurationParameters property has been updated (new XML attribute values have been added).

· The idmDocTakeFederatedOwnership constant has been added to the idmDocumentChangeFlags enumeration to support lockdown of federated content

Content Engine Web Services
· KerberosToken2 authentication capability has been added to .NET clients. 

Content Java API  
· New behavior for getProperties method (DTS 178701)

In previous releases, requesting a property that was not in the property cache always caused a round-trip to the Content Engine server to fetch the property. In release 3.5.1, this behavior has changed when requesting Id, ObjectType, InstanceType, ObjectStore, and ClassDescription properties. The Content Java API now locally synthesizes these properties if the requested property is not already in the property bag. The new behavior is as follows: 

· If you request the Id property (instead of calling getId()), an Id property is locally synthesized if the identity information provided for the object is a GUID (not a path or a name). 

· If you request the ObjectType property (instead of calling getObjectType()), an ObjectType property is locally synthesized.

· If you request a ClassDescription InstanceType property, the value is calculated and an InstanceType property is locally synthesized. 

· If you request the ObjectStore property, an ObjectStore object is locally synthesized and returned as a property. 

· If you ask for the ClassDescription property, there is often enough information available to locally synthesize a ClassDescription object and return it as a property.  (There will not be enough information to synthesize the ClassDescription object if you have only called getObject.)

· Lockdown support for federated content 

The Content Java API now supports “lockdown” of federated content during a setProperties call. A new form of setProperties with the takeFederatedOwnership parameter is available which, when set to true, permits an application (primarily Records Manager) to lockdown (take ownership of) federated content, which is document content that is stored in one or more disparate content repositories connected as a single enterprise source for business content. The location of that content is transparent to all applications. Setting the parameter prevents document content modification or deletion from the federated repository outside of the federation mechanism.
For more information, see “Working with Properties” in the Content Java API Developer’s Guide and the setProperties method in the Content Java API Reference help. For information about federated content, see FileNet P8 Content Federation Services for Image Services Guidelines. You can find the document on the  IBM Information Management support page (www.ibm.com/software/data/support).
· Support for Streaming Content Uploads

Content uploads (setContent() calls) now match downloads in streaming through the Content Java API. In prior releases, uploads were aggregated in memory in the Java application before being transmitted on the network. The streaming behavior should result in improved memory footprint and other performance characteristics. It also eliminates any content size limitations imposed by the previous model in the Content Java API.

· System Manager support 

You can monitor the performance of the Content Java API through the FileNet System Manager. The Content Java API code contains calls to the System Manager API to log performance data about the Remote Procedure Calls (RPCs) initiated for each method call. The System Manager collects and distributes performance data for installed FileNet products, independent of the operating system. The collected performance data is input to the out-of-the-box System Manager Dashboard application for analyzing the performance of FileNet P8 components.
For more information, see “System Manager and Monitoring” in the Content Java API Developer’s Guide. For information about using the System Manager Dashboard application to interpret the collected data, refer to the FileNet System Manager User's Guide, available on the System Manager media and from the Help menu of the System Manager user interface.
· Session Tunnel support 

Session tunnels represent a mechanism that provides two features in the Content Java API:

· Execution of arbitrary Remote Procedure Calls (RPCs) at a remote server (that is, "at a distance"). 

· Optional substitution of a different Session object at the "distant" end of the tunnel.

This simple mechanism splits the API client side implementation into two pieces. Upper layers of the API are performed at a source location, but the initiation of any RPC is performed at a target location, providing a simple and specialized "remoting" mechanism. You can use the optional credentials substitution, for example, to do a proxied form of API use without the need to propagate real credentials all the way to the source end of the session tunnel.
For more information and sample code, see “Using Session Tunnels” in the Content Java API Developer’s Guide and the SessionTunnel interface description in the Content Java API Reference help.

· TransportInputStream.setContentSize 

The size value set by calling this method is no longer used by setContent. Although the value will be returned by getContentSize(), it is otherwise ignored. 
Documentation

· The eForms Designer help now includes information about the FileNet P8 > Set Workplace Address menu that is available when extensible authentication is used to authenticate to P8 Workplace. DTS 163982
· The Highlight search terms option is now unchecked by default in the FileNet P8 Documentation Search page.  For details about this option's current behavior and your customization possibilities, see the Known Issues entry for DTS 154317.

· In addition to providing information on the previously mentioned features, the FileNet P8 Platform documentation has been updated as indicated below.

· Developer’s Roadmap 

Additional query examples for typical ad hoc searches have been added to “SQL Syntax Descriptions” in the FileNet P8 Developer’s Roadmap: 

· Query example using INCLUDESUBCLASSES and EXCLUDESUBCLASSES functions.

· Query example for retrieving documents based on the values of a multi-valued property, using the IN SQL operator.

· Query example using values of a float-valued property.

· Query examples for retrieving documents by a specified ID, and by ID and a document title character pattern. 

· Query example for retrieving documents by their versioning state and creator.

· Query example for retrieving the containees from a particular folder. (This can be an alternative to calling getContainees in your application program.)

· Query example for retrieving documents by content size and modification date. 

· CBR query examples using a combination of SQL and VQL (Verity Query Language) syntax with INNER JOIN.

What’s New in 3.5.0

The FileNet P8 Platform software has been upgraded with new features for this 3.5.0 release. Use this topic to review summary information on features and changes made for this release. Refer to the specific component help topics for more in-depth and detailed information. Users upgrading from release 3.0.0 should also see the FileNet P8 Platform Installation and Upgrade Guide for additional information and considerations specific to upgrading.

Cross-Component

High availability support 

High availability support has been improved when the Process Engine and Content Engine are collocated. The VWServices program has been updated so that it can be used to run multiple services, allowing each workflow server product to install and run under a unique service. This allows for a clean symmetric cluster configuration and eliminates the workarounds previously required.

The table below lists the workflow server products and the services that are used to start them.

	Workflow Product
	Service Name
	Service Display Name

	Process Engine
	VWServicesPE
	Process Engine Services Manager

	Process Analyzer
	VWServicesPA
	Process Analyzer Services Manager

	Process Simulator
	VWServicesPS
	Process Simulator Services Manager

	Application Engine
	VWServicesAE
	Process Application Engine Services Manager

	Content Engine
	VWServices
	Process Services Manager

	PJAC
	VWServices
	Process Services Manager

	Process Engine
	VWServicesPE
	Process Engine Services Manager


Security

File Store shared folder security

A more detailed description of the minimum required NTFS permissions on file store folders and their parent shared folder is now available. See the section titled "Windows permissions on file store folders" in the topic "About file stores" in the FileNet P8 Documentation.

Security caching

The following registry settings are documented for the first time: 

· TokenTTL: The Token Cache contains authenticated security contexts (tokens) indexed by principal name. The purpose of this cache is to reduce the number of round trips to the authentication provider that are necessary to authenticate a caller’s identity when the Content Engine is servicing a request. 

· PrincipalCacheTTL (Security Principal by Name Cache): The purpose of this cache is to reduce security principal name lookup times.

· PrincipalCacheTTL (Security Principal by SID Cache): The purpose of this cache is to reduce security principal SID lookup times. 

EnableUserMemberOf Attribute

· The authentication configuration parameter EnableUserMemberOf attribute may now be specified from Active Directory provider configuration information.

Required P8Apache user permissions

· This release no longer requires “view user account” permissions to be assigned to the P8Apache user.

Install and Upgrade

Application Engine
· The Application Engine installer allows specification of the following:

· The Content Engine upload and download URLs: Used when uploading document content to the Content Engine.

· The Workplace Upload and Download directories: Used by Workplace to store temporary copies of files uploaded to Workplace. The Workplace upload and download caches may also be configured to reside on shared directories. However, these directories cannot be Windows administrative shares, for example, \\server\c$.

· The Application Engine installer supports locating the bootstrap.properties on a shared directory. In addition, the Workplace upload and download caches may also be configured to reside on shared directories. Neither of these directories can be Windows administrative shares, for example, \\server\c$.

Application Engine

Process Task Manager enhancements

· When the Application Engine and Process Engine are collocated, a single instance of the Process Task Manager administers the workflow-related processes for both.

· The Process Router and Component Manager are now started as Windows services when started manually or when the Application Engine starts up.

Oracle Application Server support

· Oracle Application Server 10g, Release 2 is now supported

Sun Java Application Server support

· Sun Java Application Server 8.1 is now supported

Linux/JBoss support

· Linux/JBoss installations are now supported.

Content Engine

Administration

· Support for localization of choice lists is now provided. See “Localize choice lists” in the FileNet P8 Documentation.

· Support is now available for the propagation of meta property values using the Enterprise Manager. See “Inheritance between classes” in the FileNet P8 Documentation for an overview of this functionality.

· Users can now set the security setting per lifecycle state.

· Enhancements have been made to the event subsystem, including three new events: Lock, Unlock, and Freeze. 

· The Enterprise Manager now provides better visibility of the FileNet P8 domain resources. The AddOns, Marking Sets, Content Caches, file stores, fixed content devices, and Publishing Plug-ins available in the FileNet P8 domain are now visible in the Enterprise Manager's Resources folder.

· Object Store Security Script Wizard

· Using the security script wizard, you can add users and/or groups as an object store administrator after object store creation, with the same privileges and permissions as those given during the object store creation. See "Update an object store with new users and groups" in the FileNet P8 Documentation.

· When you encounter errors with the Security Update Script, you can now turn on tracing within the script by setting the bEnableTracing flag to TRUE. Previously, separate scripts were provided that needed to be run outside of Enterprise Manager.

· The SampleDeploymentObjectStoreSecurityScripts.vbs script, which was previously used in conjunction with the Security Script Wizard, is no longer available. The wizard now requires the specification of a new XML file, OSecurityUpdate.xml.

Database support

· Content Engine and Process Engine now support AIX-based DB2. Each engine can share the same DB2 instance but must have separate databases. The Enterprise Manager's object store wizard has been enhanced to accept DB2 configuration information.

WARNING  The Content Engine requires DB2 8.1 FP9 (aka 8.2 FP2) plus IBM interim fix14068 to be installed on all Content Engine servers.
· Content Engine and Process Engine now support sharing an Oracle database. Each engine must have its own tablespace.

Feature AddOns

· The transaction time limit has been increased to 3 minutes to allow for Feature AddOns to be contained within a single installable file. However, very large AddOns may still potentially exceed this new limit. In addition, if a large AddOn is installed at some point after object store creation, a deadlock error may occur if the installation is performed while the object store is servicing a large number of other requests. 

· A new AddOn, ContentEngineISMappingObjectAddOn, creates the custom object that is used for mapping Image Services document classes to classes in Content Engine, and Image Services document indices to Content Engine properties.

· Custom objects created in new object stores by the Feature AddOns are no longer filed in the root folder. They can be found and viewed by querying for them. 

Storage

· NetApp SnapLock is now supported as a fixed file store. The Enterprise Manager's fixed content device wizard has been enhanced to accept SnapLock configuration information.

· FileNet P8 Content Federation Services for Image Services (CFS-IS), formerly known as Enterprise (or Active) Imaging, is now available. See "About FileNet P8 Content Federation Services Server" in the FileNet P8 Documentation for a list of new Enterprise Manager features in support of CFS-IS.

· File system content creation can now be randomly distributed across multiple file stores by supplying multiple file store locations in the FileStoragePolicy.StorageLocation file.

Miscellaneous

· The forward slash character (“/”) is now supported in filenames to allow a Checkin or SetCaptureSource method call to pass a URL for the content source.

· The following Perfmon counters for Content Cache have been removed: Files Updated and Update Failures.

· The Content Engine has changed the way it constructs internal queries so that installations using a case sensitive database can distinguish between case sensitive items in a choice list. For example, items in a choice list could be set to "ITEM1" as well as "item1". Prior to this release, you would receive an error if two properties were set to choice list items that differed from one another only by case.

Developer Help

Content COM API 

· You can now apply per-state security to document states by using the ApplyTemplatePermissions property. 

· You can now change the security owner of an object by using the DefaultInstanceOwner property. 

· Localization has been added to choice lists via the addition of the DisplayNames property to the Choice class. 

· Support of filing an object and setting its security parent in a single-transaction operation (by using the idmContainmentDefineSecurityParentage flag). 

· This release of the Content Engine handles events much differently than in previous versions. The audit-only event classes of version 3.0 have been re-purposed to handle events as well as audit events and their class hierarchy has changed. This includes the CustomEvent class, which represents the base class for all user-defined custom events. A custom event is raised whenever an object to which it is subscribed calls its RaiseEvent method. 

· Three new event classes have been added: FreezeEvent, LockEvent, and UnlockEvent. 

· A new class has been created to enable you to specify the type of event to which you are subscribing: SubcribedEvent. 

Event procedures 

In previous Content Engine releases, the type of event to monitor was determined by setting the appropriate Boolean EnableOn property to True. When the event was triggered, the Content Engine would execute the appropriate "On" event procedure. All event procedures should now be coded in an event procedure named OnEvent(EventObj, Subscription). The type of event(s) to trigger your event procedure is determined by a subscription's SubscribedEvents collection property, which contains the set of EventClassDefinition object for each class of event. 

For example, if you wanted a document check-in event to trigger your event procedure, instead of placing your event code in a procedure named "OnDocumentCheckin()" and setting EnableOnCheckIn to True, you would do the following:

1. Place your event code inside a procedure named OnEvent(EventObj, Subscription), where EventObj is a CheckinEvent object, and Subscription is the subscription object subscribing to the event. 

2. Add the EventClassDescription class description object for CheckinEvent to the subscription object's SubscribedEvents collection property. 

The following event procedure names have been deprecated: OnContainer_ElementAdd, OnContainer_ElementRemove, OnDocument_CheckIn, OnDocument_CheckOut, OnObject_Create, OnObject_Delete, OnObject_Update, OnDocument_ClearException, OnDocument_Demote, OnDocument_Promote, OnDocument_ResetLifecycle, and OnDocument_SetException.

Object Model Changes 

· Classes Added 

· SubscribedEvent: Describes the events to which a subscription has been applied. 

· FreezeEvent: Represents an event that occurs when a document calls its Freeze method. 

· LockEvent: Represents an event that occurs when an object calls its Lock method. 

· UnlockEvent: Represents an event that occurs when an object calls its Unlock method. 

· Properties Added 

· ApplyTemplatePermissions: Returns or sets whether template permissions have been applied to a given document state. 

· DefaultInstanceOwner: Returns or sets the default security owner (Owner property) for an object of a given class. This property is useful if you want a group or user other than the object's creator to have owner security rights. 

· EventObject: Returns or sets the Event object to be delivered to a given EventQueueItem object (queued event action). 

· ForceCaseInsensitiveSearch: Returns or sets whether an ad-hoc query (or search) will operate in case-insensitive mode regardless of the configured behavior of the underlying database. 

· MaximumFolderCacheEntries: Returns or sets the maximum number of entries allowed in the folder cache for a given object store. 

· MaximumSecurityCacheEntries: Returns or sets the maximum number of entries allowed in the security cache for a given object store. 

· NoReferralFiles: Returns or sets whether fixed content referral files will not be created (True) or will be created (False) in a given file store. If this property is set to True, referral files will not be created in the file store and therefore full-text indexing on that file store will not be available. 

· ResourceString: Returns or sets provider-specific information for fixed content device on a given file store. 

· SubscribedEvents: Returns or sets an ObjectSet collection containing the set of SubscribedEvent objects to which a given subscription applies. 

· Enumeration changes 

· idmContainmentDefineSecurityParentage added to idmContainmentFlags enumeration: Allows the user to specify the SecurityParent property of an object when filing it. 

· Properties Deprecated

· CreatePending 

· DatabaseName 

· DatabaseServerName 

· DatabaseType 

· DeletePending 

· EnableOnCheckIn 

· EnableOnCheckOut 

· EnableOnClassifyComplete 

· EnableOnCreate 

· EnableOnDelete 

· EnableOnDemoteVersion 

· EnableOnElementAdd 

· EnableOnElementRemove 

· EnableOnPromoteVersion 

· EnableOnUpdate 

· InstanceType 

· ObjectStore 

· ObjectType 

· OIID 

· QueryOperatorDescriptions 

· SystemType (and its idmSysTypeOptions enumeration) 

· UpdatePending 

· Properties Removed

· EventOperation 

Content Java API

Support for new event subscription model 

This release includes support for the new, extensible Content Engine event model that you can use to subscribe event actions to both system and custom events. As part of the implementation of this new model, the Content Engine has moved away from having specific properties (such as EnableOnCheckin) on the Subscription class to having a new property (SubscribedEvents) that contains a list of enabled events. In addition, the Content Engine now has event types for freeze, lock, and unlock events.

Changes to the Content Java API for these Content Engine enhancements include the following:

· A new interface, SubscribedEvent, has been added. A SubscribedEvent object represents an event (such as CheckinEvent) that applies to a Subscription object.

· A new method on the ObjectFactory class, getSubscribedEvent, has been added to create a new SubscribedEvent object. You can subsequently add the new SubscribedEvent object to a Subscription object via its SubscribedEvents property.

· A new Property interface constant has been added for the SubscribedEvents property. In addition, the constants for all of the EnableOnXxx properties on a Subscription object have been deprecated. (For more information on how this change might impact existing Content Java API code, refer to the “Upgrade Custom Applications” section of the FileNet P8 Platform Installation and Upgrade Guide.)

· The raiseEvent method on a CustomObject, Document, and Folder object now raises a custom event for subscriptions (to trigger an event action) as well as for audit logging.

· ClassDescription interface constants have been added for the new Content Engine system event classes (FreezeEvent, LockEvent, and UnlockEvent).

For more information, see “Event and Subscription Concepts” in the FileNet P8 Documentation.
Batch transaction support

The Content Java API now supports batch transactions. Setting the asTransaction parameter to true on a Session.startBatch call causes the collection of items in the batch to be performed as a transaction. The exception is that calling the publish method in a batch transaction is not currently supported. (Note, however, that publishing from within a non-transactional batch is supported.) For more information, refer to “Working with Batches” in the FileNet P8 Documentation.
New methods are available to re-execute a failed batch and to retrieve the BatchResultItem object that caused the failure. See “Batch helper methods” below.

Batch helper methods

Two new transactional batch helper methods are available: BatchResultItems.getRollbackItem and Session.reexecuteBatch. The getRollbackItem method returns the BatchResultItem object that caused a rollback for a transactional batch. The reexecuteBatch method provides a convenient way to re-execute all of the items in a failed batch without having to re-accumulate the individual batch items.

Batch support for createObject

Although you can use the three-parameter form of the Object Store interface's createObject method to create an object within a batch, you cannot later reference that created object from within the same batch. In this release, this has been remedied with a new four-parameter form: createObject(String classId, Properties props, Permissions acls, and String guid). At the time you create the object inside the batch, you can assign it an ID (in GUID format), such as you might create with the new GUID generation utility class (see "New GUID class" below). Because you know the ID for the created object, you can later reference the created object from within the same batch. For more information, refer to the javadoc documentation for the createObject method and to the section entitled “Creating an Object within a Batch” in the “Working with Batches” topic of the FileNet P8 Documentation.
New GUID class

This release includes a new utility class, GUID, which you can use to generate a new, randomly valued GUID object. The class includes methods to convert the object into a String of the same format used by Content Engine objects or into a byte array. For more information, see the javadoc documentation for the GUID class.

Set security parent

Two new forms of ContainableObject.file methods are available with which you can explicitly set the security parent of an object at the time it is filed into a folder:

· file(destinationFolder, resolveUniqueness, asSecurityParent)

· file(destinationFolder, resolveUniqueness, containmentName, asSecurityParent)

These new method signatures take a Boolean parameter, asSecurityParent, which when set to true, designates the folder being filed into as the security parent of the object being filed. In this case, the object's security will be inherited from the folder into which you file the object. This has better performance than filing the object and later calling setSecurityParent.

New getCollection method

The ObjectFactory.getCollection(Class cls) method creates a new, empty collection object of the type specified by the input class. Any Content Java API collection interface that extends BaseObjects can now be instantiated via this new method. Note that this method does not apply to third-party collection interfaces that implement or extend Content Java API collection interfaces.

Search path for locating WcmApiConfig.properties

The Content Java API now searches in more places for the WcmApiConfig.properties file. Since more locations are searched, there is a remote chance that a previously unnoticed (and possibly redundant) configuration file may be found. The order of the searching for the file is unchanged. For more information, refer to the section entitled “Sequence for Locating the Configuration Properties File” in the “Configuration and the Content Java API” topic of the FileNet P8 Documentation.
Changes to getAccessMask 

The scope of the getAccessMask() method has been widened to include more object types by moving it from the Annotation, CustomObject, Document, Folder, and Link interfaces to the ReadableSecurityObject interface.

Signed javaapi.jar

The javaapi.jar is now signed. FileNet will periodically distribute a fix pack that updates the signature on the JAR file. Benefits associated with a signed JAR file are: 

· When working with security policies, you can now identify the Content Java API code base by its digital signature instead of by its location.

· When writing an applet, messages about downloading unsigned code are eliminated.

New JAR file for resource strings 

A new JAR file, p8cjares.jar, is added to the required list of JAR files for the Content Java API. This JAR file contains the localizable resource strings for Content Java API classes. See “Overview” in the Content Java API section of the FileNet P8 Documentation.
Content Java API interactions with a Java Security Manager

Documentation has been provided to guide those installations in which a Java Security Manager has been implemented. Refer to “Content Java API Interactions with the Java Security Manager” in the FileNet P8 Documentation.
Deleting document content elements 
The Document interface includes a new method, deleteContentElement(int contentElement), which removes a specified content element from a reservation document that already has content persisted to the object store. 

Retrieving content element sequence numbers 
Each content element for a document or annotation has an ElementSequenceNumber property that contains a server-generated, unique, and unchanging identity (within a given Document) for the content element. You can retrieve content element sequence numbers via the following new methods on Document and Annotation objects:

· getContentElementSequenceNumbers()

· getContentReferenceElementSequenceNumber()

· getContentReferenceElementSequenceNumber(contentElement)

In addition, the TransportInputStream interface includes a new method, getElementSequenceNumber(), that retrieves the element sequence number for a content transfer element.

For more information on content element sequence numbers, see "Retrieving a Document's Content" and "Retrieving an Annotation's Content" in the Content Java API section of the FileNet P8 Documentation.
New exception class

A new exception class, ResourceContentionException, has been added. This exception is thrown when a resource manager on the Content Engine fails an operation upon detecting that multiple threads are attempting incompatible access to the same resource.

New registry settings

New registry settings are available for control of retry attempts for a ConcurrentUpdateException failure (which can occur when attempting to save an object to the object store) and a ResourceContentionException failure (which can occur when there is contention for a resource, such as two users attempting to access the same resource at exactly the same time). The registry settings are: ConcurrentUpdateMaxRetries, ConcurrentUpdateRetryDelay, ResourceContentionMaxRetries, and ResourceContentionRetryDelay. The delay values define the number of milliseconds to wait before attempting a retry; the maximum retry values prevent excessive retry attempts. For more information, see the “Transient Failure Retry Settings” heading in “Getting Started” in the Content Java API section of the FileNet P8 Documentation.
New properties 
In addition to the new SubscribedEvents property described above (in "Support for new event subscription model"), the following new properties are exposed in the Content Java API:

· DefaultInstanceOwner, which applies to ClassDescription objects, specifies the default owner for an object of a given class. For more information, refer to the “Setting the Owner at Object Creation Time” in “Getting Started” in the Content Java API section of the FileNet P8 Documentation.
· ForceCaseInsensitiveSearch, which applies to ObjectStore objects. Your database system is configured at installation time with a case sensitivity option. However, the value of the ForceCaseInsensitiveSearch property on your object store can cause an ad hoc property search to operate in a case-insensitive manner irrespective of the underlying database behavior. For more information, see the “Case Sensitivity” heading in “Working with Search-Related Objects” in the FileNet P8 Documentation.
· MaximumFolderCacheEntries and MaximumSecurityCacheEntries, which apply to ObjectStore objects. The values of these properties control the maximum number of entries in the folder cache and security cache, respectively.

· UsesLongColumn, which applies to PropertyDescription objects of type String. Your application can use this property to determine if a string-valued property uses a long or short database column to store the property's value (long columns are only queryable using the operators LIKE and IS (NOT) NULL).

Deprecated constants in the Property interface

The following constants in the Property interface have been deprecated:

· WCM_APPROVED 

· WCM_DEPLOYABLE 

· WCM_DOCUMENT_STATUS 

· WCM_VERSION_STATUS 

· WCM_PUBLISH_OPTIONS 

These constants, which are related to object stores that have been enabled for the Web Content Manager (WCM) feature add-on, are no longer used and will be removed from the Property interface in a future release.

Support dropped for WCM-related constants in the Permission interface. The Permission.RIGHT_ARCHIVE  and Permission.RIGHT_DEPLOY constants, which are related to the Web Content Manager (WCM) feature add-on, are no longer used. They will be deprecated from the Permission interface in a future fix pack, and ultimately removed in a future release.

Retrieving Referential Containment Relationship objects by path 

The ObjectStore interface's getObject method now supports retrieving ReferentialContainmentRelationship and DynamicReferentialContainmentRelationship objects by path name.

Retrieve a specified PropertyDescription

The ClassDescription interface includes a new form of the getPropertyDescriptions method that takes a String array as a parameter, whose elements specify the symbolic names of the PropertyDescription objects to retrieve.

Unfile method behavior change 
In previous releases, if you called the unfile method on a ContainableObject object that was filed more than once in a folder and you did not specify the containment name of the reference to remove, one reference to the object would be removed from the folder (but which reference was removed was unpredictable). Now calling the unfile method under the above-mentioned circumstance will remove all references to the ContainableObject object from the folder. (Note that this change was also included in the P8AE-3.0.0-004 fix pack and subsequent fix packs.)
New behavior when retrieving Domain name

The Domain object does not have a “Name” property. In previous releases, when a Domain object was instantiated, internal logic obtained the Domain object’s ID and stored it in property cache as a property named “Name”. Calling Domain.getName(), Domain.getPropertyValue(“Name”), or any other getProperties() method variant specifically asking for the “Name” property, returned that cached property value as the Domain object’s name. If you first called Domain.refresh(), directly or indirectly (for example, by asking for a non-existent property), the “Name” property was flushed from cache and the method calls noted above would fail. In the current release, this behavior has changed. Now, a call to Domain.getName() forwards to Domain.getId() to return the value of the ID property. As a result, Domain.getName() will always succeed. Because an explicit call to Domain.getPropertyValue(“Name”) can now sometimes fail, callers should avoid calling that method, even though it worked in some circumstances in previous releases.

New fallback behavior for non-batch setContent method 

When used in a non-batch environment, the setContent method now uses the upload URL entry in the WcmApiConfig.properties file as the target. If there is a problem getting the upload URL (for example, it isn’t present in the configuration file), setContent uses the main SOAP request URL (RemoteServerUrl) as an alternative target. For more information, refer to “Configuration and the Content Java API” in the FileNet P8 Documentation.
Behavior change for createObject with multi-valued marking property
When creating a new object with createObject, you can pass into the method a value for a multi-valued property controlled by a MarkingSet. In FileNet P8 Content Java API release 3.0.0, if you pass in a value that contains, for example, two values, with the creator granted Use rights on one marking and Add rights on the other marking, a BadPropertyValueException is thrown. In release 3.5.0, this same scenario throws an InsufficientPermissionException, which is a more specific indication of the problem.

Behavior change for Search.getClassDescriptions 

Both forms of the Search interface's getClassDescriptions method return a ClassDescriptions collection. The IsHidden property, which was not included in previous releases, is now also returned in the metadata for each ClassDescription object in the collection. With the availability of this new behavior, you can filter out hidden classes, which usually results in a performance improvement. For more information, refer to “Working with ClassDescriptions” in the FileNet P8 Documentation.
Enhanced SQL support in ad hoc search

· When creating the SQL query string for an ad hoc search, the standard form of the IN expression with a list of constants on the right-hand side is now supported. This can be used as an alternative to ORing a list of values when searching for multi-valued properties.

· SQL query syntax now supports Full Outer Join in Oracle RDBMS environments. (Note that the Search Designer application does not support Full Outer Join.)

· SQL query syntax now supports using the LIKE operator to perform wildcard matches on multi-valued properties of type String.

For information on the SQL syntax, refer to “SQL Syntax Descriptions” in the FileNet P8 Documentation.

Content Engine Web Services

· A new tool, the WSI Configuration Utility, allows you to handle web service SSL security requests and gives you the ability to enable the HTTP and HTTPS transports without having to manually modify the config.xml file. 

· WebSphere® Java clients are now supported. 

· The ObjectResponseType element, which holds the output of a web services operation, has been changed to an abstract element from which three new concrete elements are derived: SingleObjectResponse, ObjectSetResponse, and ErrorStackResponse. 

· A new element, FaultStackType, has been added. It is identical to the ErrorStackType element and is used to handle SOAP faults. 

· A value of -1 is now allowed for updateSequenceNumber attribute of the ChangeRequestType element in order to allow you to indicate that it is not specified. 

· The ParentReference sub-element has been added to the Unevaluated element to enable you to specify the identity of the parent object. 

· The RESERVATION_EXISTS error has been added to the list of error codes. 

Process Engine API 

DB2 Support

VWWorkObjectNumber is a new class created for use as a substitution variable (substitutionVars parameter) for VWQueue.createQuery, VWRoster.createQuery, and VWLog.startQuery. 

Localization Enhancements

The following JAR files have been changed:

· eProcess.jar is renamed to pe.jar
· fnpe3pt.jar is renamed to pe3pt.jar
· pw.jar is no longer used (contents have been merged into pe.jar and pe3pt.jar)

Workflow Inheritance Enhancements

The VWRuleSetDefinition class has been changed. The data member previously called "value" has been changed to "name," a more accurate indication of its meaning. The getValue and setValue methods have been deprecated, but will continue to function as before, although internally they are setting the "name" value. New methods to get and set the "name" (setName() and getName()) have been added.

The VWWorkflowDefinition class has been changed. A new method has been added to delete a ruleset by name: deleteRuleSet(String theRuleSetName). The method deleteRuleSet(VWRuleSetDefinition theRuleSet) has been deprecated, although it will continue to function by internally calling the new method. These changes were needed because of ruleset inheritance.

The VWMapNode class has changed. The methods getRuleSets() and setRuleSets() which take or return VWRuleSetDefinition[] have been deprecated. They are replaced by getRuleSets() and setRuleSets() which take or return String[]. These changes were made because we now store the ruleset name instead of the ruleset indices. Due to the inheritance of rulesets, the indices would not be known until transfer time.
Process Orchestration Enhancements

· The VWCompoundStepDefinition class has the new method createTerminateBranchInstruction(), and the constant VWActionType.ACTION_TYPE_TERMINATE _BRANCH has been created. 

· VWCompoundStepDefinition.createTerminateInstruction() has been deprecated and replaced by createTerminateProcessInstruction(), and the constant VWActionType.ACTION_TYPE_TERMINATE has been deprecated and replaced by VWActionType.ACTION_TYPE_TERMINATE_PROCESS.

· The VWReceiveInstruction class has the new methods getSecurityGroup(), setSecurityGroup(), toXML(), and validate().

· The VWSession class has the new method fetchFileFromServer().

· The VWWorkflowDefinition class has the new boolean flag validateUsingSchema. The new methods getValidateUsingSchema(), getVersionAgonostic(), and toXML() have also been added.

Process Designer Suite-Based Functionality

The VWSession class has the new method fetchLimitApplicationFunctionalityFlag().

VWSession Serialization for Session EJBs

The VWSession class is now serializable. It is the only object that is serializable for use with session beans. No other Process Engine Java API objects are guaranteed to be serializable for return to the client.
Process Engine Web Services Name Substitution

The VWQuery, VWRoster, and VWLog classes have the constant QUERY_RESOLVE_NAMES. This supports conversion of user names to IDs for Process Engine Web Services to perform queries using user ID fields within an index or filter.
System Manager

The FileNet System Manager provides a centralized mechanism for collecting and distributing performance data on FileNet products installed at a site. The gathered data can be made available to industry-standard monitoring and reporting tools, as well as to the out-of-the-box System Manager functions. The System Manager is composed of a single Listener and one or more Managers. Developers may customize the Managers and the Listener, using industry-standard APIs. For information on setting up your system to use a Manager, see the FileNet System Manager User's Guide on the FileNet System Manager media. For information on setting up your system to use a Listener, see the topics under “System Manager” in the FileNet P8 Documentation.

System Manager Listener C++ API

The System Manager Listener C++ API provides C++ programming interfaces for integrating with the Listener. Using the interfaces in this API, the application can create and configure the Listener, listen for events, gather performance data regarding the events and related event attributes, accumulate the data for analysis, and communicate with connected Managers. For information on the System Manager Listener C++ API, see the “FileNet System Manager Listener C++ API Help” in the FileNet P8 Documentation.

System Manager Listener Java API

The System Manager Listener Java API provides Java programming interfaces for integrating with the Listener. Using the interfaces in this API, the application can create and configure the Listener, listen for events, gather performance data regarding the events and related event attributes, accumulate the data for analysis, and communicate with connected Managers. For information on the System Manager Listener Java API, see the “FileNet System Manager Listener Java API Help” in the FileNet P8 Documentation.

Web Application Toolkit Developer’s Guide

The multilingual feature has been enhanced with client-based localization. To support a multilingual client base, a single Toolkit-built application can serve up UIs in multiple languages. 

Workplace Application Integration

Application Integration provides new menu options. You can now add a new folder, perform quick checkins, view checked out documents and Workflow task inboxes. Search is now supported when you insert a hyperlink. Outlook profiles are simplified. 

Workplace Application Integration API Toolkit

· Support has been added for customizing the File, Insert, and Help popup menus of Microsoft® Outlook, Word, Excel, and PowerPoint. FileNet utilizes COM Add-Ins to extend these applications by adding custom Add-In menus. These custom menus can be modified by developers through the use of XML files provided by FileNet, which contain information used by Application Integration to configure the menu contents for the Microsoft applications.

· The ability to share a single, unified login between all FileNet Office Add-Ins is now available.

· The ISessionLogin interface has been modified to include two new initialization methods, InitializeUnifiedLogin and InitializeViaSessionName which supersede the deprecated ISessionLogin::Initialize method. These two methods support different types of SessionLogin component initialization, including the use of the Office Add-In unified login. 

· ISilentSessionLogin, a new core component interface, is similar to ISessionLogin but does not present a GUI to the user and cannot be used to implement support for unified login. The ISilentSessionLogin interface is supported by the miscellaneous component interface, IBaseServerURL.

· Several command and response interfaces have been added: AddFolder, ICheckinCmd2, IDownloadCmd2, IsCheckedOut, IOpenRsp2, QuickCheckin, ISelectObjectCmd2, ISelectObjectRsp2, and Tasks. 

· Several command and response interfaces have been modified: Checkin, CheckoutList, Download, Open, and SelectObject.

· Two command and response interfaces have been deprecated: ICheckinCmd and ISelectObjectCmd.

Workplace Application Integration ExpressAddin

The ExpressAddin is a developer tool that enables two-way communication between a third-party application and the FileNet Application Integration infrastructure. The tool is implemented via COM interfaces and methods, and communication with the Application Integration framework is achieved through the use of an event sink and event handlers. The ExpressAddin is delivered with the Add-In sample application, which demonstrates how to use the ExpressAddin to integrate a third-party application with the FileNet Application Integration infrastructure.

Workplace Application Integration and Customization

The following new commands have been added to the IntegrationServlet:

	
	

	1012
	Add Document with User-Selected Template

	1015
	Add Object

	1090
	Launch Workflow or Workflow Subscription

	1100
	Get User Token

	1200
	Get Processor

	2020
	Select Entry Template

	2035
	Cancel Checkout from List

	2037
	Check In from List

	2100
	Select Multiple Objects

	2110
	Select Public Inbox


Documentation

eForms 

· A new document called “Solution Integration Guide” is provided on the eForms installation CD. This guide describes how to open a new form using a URL. It also explains how to add parameters on the URL query string to have the form open with data pre-filled in the fields that you specify on the string. 

· In the eForms Installation Guide, a new task entitled “Enable Secure Login to Delete I-Sign Signatures” has been added. By setting the variable LoginToDeleteSignature to true, only the user who originally signed the form can delete their I-Sign signature.

eForms designer

· In the eForms Installation Guide, instructions for Wizard pages are now presented in an easy to use table format.

· The eForms Designer help now includes information about the FileNet P8 > Set Workplace Address menu that is available when extensible authentication is used to authenticate to P8 Workplace. (DTS 163982)

· The Help for eForms Designer 5.0.0 now applies to all the currently supported fill platforms.

· For eForms Designer 5.0.0, context-sensitive Help has been added for functions. In the Value dialog box, when you select a function from the list, its parameters are displayed in the left side of the status bar. To display the Help topic for the selected function, click the parameters text in the status bar.

Installation/Upgrade

The installation and upgrade information for this release now appears in a single PDF document (FileNet P8 Platform 3.5.0 Installation and Upgrade Guide).

Optional features

The documentation for each optional feature now comes on its own documentation CD. While it can be viewed from the CD, it is not fully functional until installed on top of an existing FileNet P8 Documentation web site.

Shutdown and Startup Procedures

The “Shutdown and Startup Procedures for the FileNet P8 Platform Components” technical note, formerly in PDF format, is now incorporated into the online FileNet P8 Documentation in HTML format.

eForms

Form enhancements

Calendar

A new calendar feature allows you to choose a date from a pop-up calendar instead of typing a date in a cell. 

Signing

· The sign, remove and delete buttons in a signature field have been replaced. 

· For signing, you click the Click Here to Sign link to display the Sign dialog box. Once a form has been signed, a Status Unknown icon appears next to the signature. 

· Once a signature has been verified, you'll see a Status Failed or Status Verified icon next to the signature. 

· If you use the I-Sign secure signature to sign forms, only the person who signed the form can delete signatures. 

Form Lookups

If the value you enter in a lookup field has more than one match, a dialog box now displays allowing you to select the correct entry. 

Form Appearance 

· Buttons that link to websites can now appear on forms. 

· The picture icon was replaced with a Click to Insert link. 

· The eForms toolbar can now be displayed at the top, bottom, or in both locations on a form. As well, the form author can control which buttons appear on the toolbar. 

The order that toolbar actions occur has also changed. For example, if you click the Submit button while a lookup is taking place, the lookup action is completed before the form is submitted. 

Regions

A form can appear with regions  areas that are not part of the form and which display at the left, right, top, or bottom of the form. These areas could contain a link to a company website or other information. 
Router Region 

A form can display with a router region immediately below or above it. This region can contain instructions, a deadline, or a place for you to add comments or a response. 

Message Banner 

A small banner can display immediately above the form to indicate its status (for example, "Read-only") or to display an important message about the form. 

Form Template Policy 

For form template policy authors, there are some new, customizable features that have been added to the step manager wizard of the workflow policy and the document manager wizard of the document policy.

· Toolbar commands for a workflow policy: For the launch step and post launch steps, you can show or hide optional toolbar commands, change the alias name, and provide a user-friendly tool tip to describe the command. Toolbar commands include Launch (at the launch step only), PDF, Save, Attachments, Workflow Groups, and Close. 

· Toolbar commands for a document policy: You can show or hide the PDF button, and change the alias name, and provide a user-friendly tool tip to describe the PDF, Save, and Close commands. 

· Layout options: The location of the toolbar, attachment behavior (workflow policy only), regional layout, and router region settings (workflow policy only) are now configurable. You can: 

· specify that the toolbar be displayed below the form, or in top and bottom positions. 

· set the layout options such as alias names and commands for each configured attachment in the workflow properties of the workflow definition (workflow policy only). 

· modify areas or frames surrounding the form with custom text or graphics and resize by pixel height or width depending upon the region. 

· display a routing slip in the router region that contains workflow step information such as instructions, deadline, responses, subject, and comments. 

Test form template 

After a form template is added to a FileNet P8 Workplace, you can test it using the Test Form Template feature in Workplace. This feature allows you to test your form template before you create a form template policy. 

eForms Designer 

· eForms Designer now supports extensible authentication for authenticating to P8 Workplace. (DTS 161119)
· A new signing service, I-Sign (Ink), allows users to integrate handwritten signatures into forms. (DTS 149393)

· eForms Designer is now available in a Macintosh version.  

· eForms Designer 5.0.0 has been unified to support multiple fill platforms. Previously, it was necessary to use a different version of Designer for each fill platform. Now, the application's user interface and capabilities change to match the target fill platform that you select. The following fill platforms are currently supported: Desktop eForms, Forms Manager eForms, Open Client eForms, FileNet P8 eForms, and Web Services eForms. 
· A new template report called Platform Validation has been added that identifies elements on a form template that are not valid for a different target platform. 

· A new button type allows you to configure a button on a form template with a hyperlink to any web page. 

· The following functions are now supported for Forms Manager eForms, Open Client eForms, and FileNet P8 eForms:

· URLEncode

· URLEncoding 

· The following number formats are now supported for Forms Manager eForms, Open Client eForms, and FileNet P8 eForms: 

· 0;(0) 

· 0% 

· 0.00;(0.00) 

· #,##0;(#,##0) 

· #,##0.00;(#,##0.00) 

· #,##0.00;(#,##0.00);zero 

· #,##0.00 Cr;#,##0.00 Dr; 0.00 

Process Analyzer

Canceling the Prune Events operation

You can now cancel the Prune Events operation while it is in progress. See “Prune events on the Process Analyzer” in the FileNet P8 Documentation.

Database compression wizard 

There is now a compression wizard to allow you to reduce the size of the Process Analyzer database by aggregating, or "rolling up," measures across common dimensional values, with a resulting loss of information.

Process Engine

Use of a private JRE

The Process Engine uses the JRE it installs in a "private location" (/fnsw/jre for UNIX®, \fnsw\jre for Windows) instead of the JRE specified in the server's path statement. As a result, other JREs can be installed on the server without affecting the Process Engine.

Database support

· Content Engine and Process Engine now support AIX-based DB2. Each engine can share the same DB2 instance but must have separate databases. 
· Content Engine and Process Engine now support sharing an Oracle database. Each engine must have its own tablespace.

User-configurable user cache refresh

You can now configure the interval (in hours) for updating the memory cache containing user and group information for the Process Engine.

Oracle database users and groups

The Process Engine installer no longer requires the following users and groups when the database is Microsoft SQL Server: dba (group), ORA_DBA (group), and oracle (user). 

Workplace

Miscellaneous

· Workplace supports language preferences defined by your browser's language setting. 

· My Inbox and Public Inbox views can now filter work items. 

· Workplace supports documents consisting of more than one file. See “Multi-content documents” in the FileNet P8 Documentation. 

· Image Viewer now opens GIF documents, and Image Viewer supports multiple content element documents. See “Work with Image Viewer” in the FileNet P8 Documentation.
Portal Integration / Portlets

· FileNet P8 Portal Integration has been renamed FileNet P8 Portlets.
· While there are no changes to FileNet's user interface, FileNet P8 Portlets are now compliant with industry standard JSR 168. That is, FileNet P8 Portlets leverage the interoperability of portals and portlets available through the standard Java APIs defined by JSR 168.
Workplace Actions

· You can email a link to a document, folder, or custom object, or send a document as an email attachment. See “Send Mail action” in the FileNet P8 Documentation.
· You can view and copy the hyperlink URL for an item in Workplace. See “Show Hyperlink action” in the FileNet P8 Documentation. 

· You can quickly check in a document without changing the document class, properties, or security. See “Quick Checkin action” in the FileNet P8 Documentation. 

· The Save action has been renamed to Save Content. See “Save Content action” in the FileNet P8 Documentation. 

· Shortcuts now support the Rename action. See “Bookmarks and shortcuts” in the FileNet P8 Documentation. 

· With the optional eForms add-on, Workplace now supports forms in Test mode. See “Test Form Template action” in the FileNet P8 Documentation.

Process Designer 
Improved usability
· Process Designer now allows creation of data fields directly in the Expression field for queue operation parameters, component operation parameters, and operation parameters for Invoke, Receive, and Reply system functions.

· The icons for all steps are changed; the selected step is more distinctive, making it easier to find on the map.

Suite-based functionality
· Functional expansion software modules, such as FileNet Web Content Manager, include access to a subset of essential Process Designer features to create workflows appropriate for use with the module. 

· Full Process Designer features  all step palettes, submaps, Web Services, rules, etc., are available only with the full BPM package. Note The standard installation process configures Process Designer for only the essential features. If your software license includes the full BPM package, an administrator must enable full workflow functionality on the Process Service/General tab in Process Task Manager. 

Workflow inheritance
· A new workflow preference is available to show or hide inheritance features such as base workflow selection, inherited submaps and fields, and other inherited items. 

· The workflow main map can be deleted to use the inherited base map. 

· In the Workflow properties dialog, where inherited items are listed with items defined in the current workflow, symbols show which items are inherited and which are overridden. 

System functions
· New TerminateProcess system function terminates a running workflow. 

· TerminateBranch system function terminates a branch in a running workflow. This replaces the existing Terminate system function. 
· Expression Builder

· New xmlencode and xmldecode functions to convert between string format and XML format. 

· Process Orchestration enhancements

· In Process Designer, an XML schema can be loaded from the Process Engine, allowing the workflow author to view the schema. The workflow author can also copy the schema and modify the copy. See “Web Services - schemas“ in the FileNet P8 Documentation.

· The Receive system function has a new option for authentication allowing the workflow author to specify LDAP users and/or groups or a workflow group as valid users to invoke the Receive function.

· A new option, Verify messages at runtime, will verify incoming and outgoing web services messages against the schema in the WSDL. See “Web Services - General properties “ in the FileNet P8 Documentation. 

· A new option, Finalize existing web services operations, replaces the Ignore Version option on the Workflow Properties >> Web Services >> General tab. When this option is enabled, the input and output parameters are made permanent for existing web services Receive and Reply operations. This ensures consistent input and output parameters for the web services. 

· In addition, the partner link of a finalized web service does not identify a specific version of the FileNet workflow. The invoking process invokes the latest version of the workflow providing the web service.

· Partner Links can now be inherited from a base workflow. 

· Publishing Designer

· Publishing Designer now supports multiple languages.

· Users can download a certificate if they are using Publishing Designer in an SSL environment.

Search Designer

· Search Designer now supports multiple languages.

· Users can download a certificate if they are using Search Designer in an SSL environment.

Simulation Animator

A new option, Set Playback Rate, allows the user to control the rate at which the animation plays back the workflow events. 

Simulation Designer

User interface

The user interface is reorganized to make it easier to define the properties of each of the imported workflows (arrivals, step durations, route weights), and the properties of the scenario (name, start and end dates, shifts, jobs, and resources).

· The Main window (formerly the Workflows tab) displays the list of imported workflow, and the Arrivals and Step tabs.

· Scenario properties (Scenario name, start and end dates, shifts, jobs, and resources) are now accessible from a new toolbar button (Scenario Properties) and from Scenario Properties on the View menu, 

New features 

· Durations can be defined for System and Component steps, in addition to General steps.

· A new Shifts table provides a way to associate a shift (and job) with a resource.

· A new Preferences option, Create default entries in a new scenario, will create a default shift and a default job duty, which will include all of the work queues. This makes it easier to create a scenario and launch a simulation with minimum input. 
Known Issues

The following notes describe known issues and critical information for this release. Where applicable, each note includes the associated Defect Tracking System (DTS) number for reference and tracking purposes. For some entries, known issues may be cited in two or more sections. For instance, an installation problem involving the Content Engine may appear in the installation section as well as the Content Engine section. We recommend you review the entries for each of the FileNet P8 components that are installed at your site.

For an overview of 3.5.x Known Issues that have been fixed by a Service Pack or Fix Pack, see the appropriate readme. 

As these known issues are fixed, they will be moved to a corresponding section under Resolved Known Issues.

FileNet P8 Platform Installation/Uninstallation

Content Engine

	Defect ID
	Description

	175512
	FileNet does not recommend configuring IBM IICE 8.3 in a cluster environment when you use it as part of your FileNet Confederation Services solution. Clustering IICE 8.3 can lead to unstable fixed content device connections, and after some use, the federation processes can begin to fail. To avoid this situation, ensure that the IICEWebServicesURL is pointing directly to the Application Server.

	175499
	FileNet recommends using only one importer on one CE server, regardless of how many CE object store service servers you have installed (such as in a server farm environment). Using multiple importers on multiple servers can lead to importing duplicate documents, document federation failure, and also to deadlock errors on any server where the additional importer is started after the first importer was started. (Doc DTS 175588)

	172868
	The IBM II CE Administration Tool help does not provide instructions for setting the Property Description field in the Data Map Designer. IBM has recommended the following settings.

Date/Time Type CS property.  If you want the query with this setting to return correct results and you want the date picker to display in the IICE web client and Federator Admin application, use these settings:

Data Type: DateTime
Extended Data Type: None
Editor_Type: Editor_Date

For String Type, use these settings:
Data Type: String
Extended Data Type: None
Editor_Type: Editor_Undefined

For Integer Type, use these settings:
Data Type: Integer
Extended Data Type: None
Editor_Type: Editor_Undefined

IBM has a documentation defect opened for a future release to add information about the Data Map Property Description. Check the IBM Information Management support page (www.ibm.com/software/data/support) for documentation updates.

	172242
	When creating an FCD for CFS-CS, the Create a Fixed Content Device wizard does not verify the parameters you enter on the “Federator Database Parameters” page. It may appear that you have created an FCD without error, even if you have entered database parameters incorrectly. To avoid issues, carefully validate the entries on the “Federator Database Parameters” page before finishing the wizard. (Doc DTS 174706)

	171683
	If you choose to install IICE without Subscription Services (by leaving the Subscription Services checkbox in the IICE installer unchecked), you may find that the SSOServer will not run correctly. The SSOServer has a dependency on the vbr_subsciption.jar. To remedy the issue, manually add the vbr_subscription.jar to the VeniceBridge.ear file. (Doc DTS 171887)  

	170900
	FNCEUpgrade.exe has a non-existent path when attempting to create a trace log file.   (Doc DTS 171082)

	167933
	Because of a known limitation in IBM WebSphere Information Integrator Content Edition 8.3, FileNet Enterprise Manager cannot check the user or group you specify as the LockdownPrincipal when creating a fixed content device. A user or group federating NTFS documents can be any valid local machine or domain user or group for the machine that hosts the NTFS device. To check the validity of a user or group for locking federated Content Services documents, launch a browser and log on to Panagon Web Services thin client. (Doc DTS 169338)

	167902
	The following notes about the process of installing and configuring IICE can help you avoid issues with Content Federation: 

· The IICE administration tool does not check for duplicate CS connector names.  When configuring a new CS connector, be sure to specify a name that does not match the name of an existing CS connector. Otherwise, Federator Exporter will fail when attempting to export documents from the CS library whose CS connector name was duplicated.

· If a problem arises with the IICE SessionPool, it might be easier to delete the existing session pool and recreate it than to spend time debugging it.

· Data maps must be edited in the proper manner, which requires loading the CS connector properties first.  Do not add a CS property name manually without first loading the connector properties, as this may cause the data map to become corrupted.

	165916
	Logons to the SSO Server of WebSphere Information Integrator Content Edition v 8.3 fail if subscription event services are not installed. For a workaround, refer to the IBM Technote (FAQ) Reference # 1225105 at:

http://www1.ibm.com/support/docview.wss?rs=2169&context=SS5K3U&dc=DB520&uid=swg21225105&loc=en_US&cs=UTF-8&lang=en. (Doc DTS 169338)   

	164728
	During an upgrade from 3.0 to 3.5, if the "Use Default Accounts" option in the Global Configuration Data wizard screen is checked and grayed out, the user may require Domain Account Operator privileges to continue the installation successfully. (Doc DTS 164733)

	163213
	The Content Engine silent installer unexpectedly ignores the <INSTALLDIR> tag in the silentsetup.xml response file. To work around this problem, you must pass the following parameter to Msiexec.exe to specify the installation directory path for the Content Engine components you want to install:

    INSTALLDIR=<drive>:\<ce_components_install_directory>  

	162272
	When CE is installed on a Windows 2000 SP4 with RollUp 1 system, certain behavior is seen:

· Content Engine Object Store service does not start after rebooting the CE – it must be started manually.
· During the 3.5.1 Content Engine installation, clicking "cancel" on the install does not stop the installation.
Details:
The Object Store service depends on the MSDTC service to be running when it attempts to start. After applying this rollup, MSDTC appears to start a few seconds after the Object Store service and thus causes the Object Store service to fail on initial startup.

Resolution:
To resolve this issue, MSDTC must be added as an explicit dependent service for the Object Store service. This can be done via 
the registry (HKLM-->CurrentControl-->Services-->Content Engine Object Store Service-->DependOnService--> Add "MSDTC".
For information on the Microsoft rollup, go here:
http://support.microsoft.com/default.aspx?scid=kb;en-us;891861

	159727
	Before uninstalling Content Engine, comment out the following line in the main Apache server configuration file httpd.conf. Otherwise, the Apache2 service will fail to start when you restart the machine after the Content Engine uninstall completes. 
LoadFile "C:/Program Files/FileNet/Content Engine/Listener.dll"(Doc DTS 163973)

	158222  
	Some installations of Windows 2000 and Service Pack (SP) 4 may not include the Authorization Framework (Authz.dll) file. If you upgraded to SP4 from a previous version (such as SP3), Authz.dll should be installed. If you installed Windows 2000 with SP4 included (i.e., "slipstream"), it is likely that Authz.dll is missing. This can be corrected by installing SP4 separately or by installing a hotfix as described in Knowledge Base Article 320211. You can obtain the hotfix through Product Support Services (PSS) when you reference this Knowledge Base article. Authz.dll is used by Reporting Services to perform authorization checks when the report server executes a scheduled process (such as a subscription or snapshot refresh). If the file is not installed on your computer, a warning is displayed during the prerequisite check in Setup.
Update, July 6, 2006: It has been established that if the Authz.dll file is missing from your system32 folder, prior to aplying the fix pack, you must first apply Microsoft Security Patch MS05-018 (KB 890859). 
http://support.microsoft.com/kb/890859/en-us

	155459
	Upgrades of Content Engine from version 3.0.0 to 3.5.0 do not restore the CIDFont directory, located at \Program Files\FileNet\Content Engine\Verity\common\PDFResource\windows. The missing directory causes installation of FileNet Fix Pack P8CE-3.5.0-002 to fail. 
As a workaround, before installing P8CE-3.5.0-002, do the following on each machine where Content Engine is installed: 

12. In the Windows Control Panel, double-click Add/Remove Programs, choose FileNet Content Engine, and click Change. 

13. At the Welcome screen of the Content Engine Setup wizard, click Next. 

14. At the Program Maintenance screen, click Repair, and then click Next. 

15. At the Install third-party software screen, click Next. 

16. At the Ready to Repair screen, click Repair. (The repair may take several minutes.) 

17. At the Completing the Content Engine Setup screen, click Finish. (Doc DTS 160380)

	153211
	When upgrading Content Engine from version 3.0.0 to 3.5.0, the Content Engine Setup wizard prompts you, at the Content Engine Global Data Configuration screen, to type the existing password for the FNCE_<machine_name> Windows Service Logon account (for Content Engine services logon and the COM+ application). 
When you click Next (to go to the next wizard screen) after typing the password, an error message appears (indicating there is no such object on the server) if your Windows Service Logon account has fewer than 13 characters. 

To work around this error, exit the wizard, and do the following: 

18. Open the Windows registry on the Content Engine server.

19. Navigate to HKEY_CURRENT_USER\Software\FileNet\ECM\Content Engine\GCDValues.

20. Locate the "Windows Service Account" key. The value of this key is most likely of the form <username>. Replace the key value with the following (in Windows SamAccount format):

<windows domain>\<username>

NOTE The value of <windows domain> can be any string value, as long as it is followed by a slash (“\”). The value and slash will be stripped off when you re-run the GCD Wizard after the registry change. 

21. (Windows 2000 only) Reboot the machine.

22. Re-launch the GCD Wizard (configgcd.exe) and continue at Step 3 of “To upgrade Content Engine software” in the FileNet P8 3.5.0 Platform Installation and Upgrade Guide topic “Upgrade Content Engine”.

	151663
	If you intend to install CFS-IS, be aware that the CFS Connection Monitor tool does not get installed on the machine unless one of the following conditions holds true: 

· You are also installing Object Store Service along with CFS-IS. 

· Object Store Service is already installed on the machine. 

If you install CFS-IS on a machine for which neither of the above conditions holds true (for example, File Store Service is the only other CE component installed or being installed), then after the installation completes you will need to copy the CFS Connection Monitor tool (CfsConnectionMonitor.exe) to the FileNet\Content Engine directory on the machine from some other machine where it is installed.

	147856
	The Process Engine Web Service fails to be automatically deployed during Content Engine installation.

As a workaround, you must do a manual deployment by the following procedure after Content Engine installation is complete:

23. On the Content Engine server, use a text editor to open the file:

C:\Program Files\Common Files\Systinet\wasp\bin\env.bat.

24. Remove one % symbol before and after JAVA_HOME in the SET JAVA_CMD line. That is, replace this line:

SET JAVA_CMD=%%JAVA_HOME%%\bin\java

with this line:

SET JAVA_CMD=%JAVA_HOME%\bin\java

25. Replace this line:

SET WASP_HOME=C:/Program Files/Common Files/systinet/wasp

with this line:

SET WASP_HOME=C:\Program Files\Common Files\systinet\wasp
26. Save (as a DOS file) and close env.bat.

27. If Wasp Server for Java service is not already running, start it in the Services node of the Computer Management snap-in.

28. Open a DOS command-prompt window and set the current directory to:

C:\Program Files\Common Files\Systinet\wasp\bin.

29. Assuming that the following is true:

· WASP47 (that is, the bin and lib folders for the WASP server) is installed to C:\Program Files\Common Files\Systinet\wasp, 

· pews.jar is in C:\Program Files\FileNet\Content Engine, and

· user admin password is “changeit”

30. Run the following command at the DOS prompt to deploy Process Engine Web Service:

deploy --target http://localhost:6060 --redeploy --force --username admin 
--password changeit “C:\Program Files\FileNet\Content Engine\pews.jar”

NOTE Although the command above spans two lines, you must type it without carriage returns.

31. Verify the deployment of Process Engine Web Service by navigating to the following location on the Content Engine server:

http://localhost:6060/ProcessEngineWS
If the deployment has succeeded, you should be viewing a Web Services Description Language (WSDL) web page.

	101173
	An error is returned when attempting to install/upgrade a Content Engine via Terminal Services.

	95630
	The backup script created by Enterprise Manager does not function with Windows 2003. This is caused by leading characters in the script file that are related to the unicode file.


Rendition Engine

	Defect ID
	Description

	742862
	Highlighted text in MS Word does not get rendered to PDF files.

To enable highlighting of text to be rendered to PDF files from MS Word, the Highlight checkbox should be selected when configuring MS Word for Rendition Engine, not unchecked as suggested in the Rendition Engine Installation and Upgrade Guide. 

When installing Rendition Engine, as part of the task "Configure Native Applications," do the following:

1. In Microsoft Word, choose Tools > Options > View.

2. Check the Highlight option. (Docs Defect 745008)


Process Engine

	Defect ID
	Description

	755147
	When you upgrade a PE database from SQL 2000 to SQL 2005 after a PE software upgrade, the "fn_setup_rdb -u" tool creates a duplicate data source (named fn_is_dsn) during the process of upgrading the database type to ODBC. Subsequently, PE ignores the original data source and uses the new one created by fn_setup_rdb.

Workaround:

1.  Select Program > Administrator Tools > Data Source (ODBC), and verify that the following options are set for the original data source:

          ANSI PADDING ON

          ANSI QUOTED IDENTIFIERS ON

2.  After you verify these settings, launch the System Configuration Editor, fn_edit.

3.  Select the Relational Databases > RDB Objects tab. 

4.  Change the "data_source_name" parameter to the name of the original data source.

5.  Save your changes and exit from fn_edit.  

6.  Run "fn_build -a" to rebuild the system configuration files which enables the change.

	390821
	The version.txt file for the Process Engine 3.5.2a release states that the build is pe183.005 but the vwtool and vwspy utilities indicate that the build is pe183.004.  The reason is that the installer was rebuilt again after the last build of the software binaries. (Docs Defect 393469)

	196353
	When installing or upgrading to Process Engine 3.5.x on a UNIX platform with a DB2 database, you might get a mini-installer error "INFO: ERROR: Incorrect version of remote DB2 installed" even though you have installed the supported DB2 version 8.1 with FixPak 4 or above.  The problem occurs because the mini-installer cannot correctly parse the output of the db2level program in some cases.  The mini-installer looks for the FixPak version following the word "FixPak".  However, db2level wraps its output at character position 80, so in some cases the word "FixPak" appears at the end of one line and the version number appears on the following line.  See the example below:

DB21085I  Instance "bofp3" uses "64" bits and DB2 code release "SQL08023" with

level identifier "03040106".

Informational tokens are "DB2 v8.1.0.96", "s050811", "U803921", and FixPak

"10".

Product is installed at "/opt/IBM/db2/V8.1".

To work around this problem, you need to temporarily replace the db2level program with a shell-script file that echoes the information the mini-installer needs.  Perform the following steps as user root:
1. Locate the db2level program by running "which db2level".  Assuming that the DB2 instance owner is fnsw and that the fnsw home is /home/fnsw, you would normally find db2level in /home/fnsw/sqllib/bin.

2. Rename db2level to db2level.sav:


mv db2level db2level.sav
3. Run db2level.sav and redirect its output to db2level:


./db2level.sav > db2level
4. Edit db2level to put each sentence on one line and put "echo" in front of each line.  In vi, you can use the J command to join the next line to the end of the current line.  The result would appear as follows:

echo DB21085I  Instance "bofp3" uses "64" bits and DB2 code release "SQL08023" with level identifier "03040106".

echo Informational tokens are "DB2 v8.1.0.96", "s050811", "U803921", and FixPak "10".

echo Product is installed at "/opt/IBM/db2/V8.1".

5. Run chmod and chown to give the new db2level the same owner and permissions as the old db2level.

6. Run the new db2level and verify that it displays the correct information.

After the PE installation, you should restore the old db2level. (Docs DTS 198712)

	150772
	If you install CFS-IS on a machine where Process Engine is already installed, the CFS-IS software will be installed in the FNSW directory of Process Engine regardless of where you specify the CFS-IS software to be installed.  
Although the CFS-IS software will function normally in that location, you can move the software to another location, as follows:

· Copy the CFS-IS software folder <current install location>\FNSW\client to the desired location.

· Open the Windows registry on the machine and navigate to HKEY_LOCAL_MACHINE\SOFTWARE\FileNet\WAL\CurrentVersion.

· Change the WAL_ROOT key value to be the new location of the CFS-IS software folder. For example if you copied the CFS-IS client folder to C:\Program Files\FileNet\FNSW in step 1, then set the WAL_ROOT key value to "C:\Program Files\FileNet\FNSW".

· Modify the PATH system environment variable to include the new locations for the bin and shobj directories under the CFS-IS client folder. Using the example in step 3, you would modify the PATH environment variable to point to the new locations 

C:\Program Files\FileNet\FNSW\client\bin;

 C:\Program Files\FileNet\FNSW\client\shobj.

	149824
	Process Engine setup allows a maximum of nine drives.  If there are more than nine, setup does not prompt for the Executable Files drive or the Configuration Files drive.

If the problem occurs with the prompt for Configuration Files drive in a clustered environment, you can use the following workaround: Temporarily hide some of the clustered disks by changing the Name parameter in the registry entries under HKLM\Cluster\Resouces.  Find Disk entries that are not needed for the Process Engine install and change "Disk X:" to something like "isk X:" so you have no more than nine shared disks.  Do not rename the disk for the quorum drive.

If the problem occurs with the prompt for the Executable Files drive or the prompt for the Configuration Files drive in a non-clustered environment, you might be able to work around the problem if some of the local drives are virtual drives created with the subst command or similar commands.  Temporarily delete virtual drives that are not needed for the installation using a command like the following:


subst z: /d

Delete enough virtual drives so that you have no more than nine local disks.  For more information, run help subst from a command prompt. (Doc DTS 151452)

	102787
	Process Engine does not currently support Veritas volume manager on the AIX platform.


Application Engine

	Defect ID
	Description

	686853
	Application Engine Installation/Configuration instructions for WebSphere 6.1 are not included in the Installation and Upgrade Guide

For instructions on installing and configuring Application Engine 3.5 on WebSphere 6.1, refer to the fix pack readme for AE-3.5.1-010.

To access the fix pack readme for AE-3.5.1-010

1. Navigate to the Information Management support page (www.ibm.com/software/data/support/).

2. Select FileNet Content Manager from the Select a category list.

3. From the Product Support page, under Download, click IBM FileNet Fix Packs.

4. From the IBM FileNet Fix Packs page, click IBM FileNet P8 Platform.

5. From the Fix Packs for FileNet P8 Platform page, under FileNet Application Engine, click 3.5.1.

6. Follow the prompts to sign in.

7. From the FileNet Fix Packs page, scroll down to P8AE-3.5.1-010 and download readme-ae351-010.htm.

	198091
	When you run Application Engine Uninstall, if you click No when prompted for whether you want to delete configuration files that have been modified, your answer is ignored, and the following files are removed anyway: 

· Integration.xml, ConfigurableLabels.xml, pagingConfiguration.xml (under C:\Program Files\FileNet\Workplace\WEB-INF\)

· xml-apis.jar, xercesimpl.jar, p8ciops.jar (under C:\Program Files\FileNet\Workplace\WEB-INF\lib\)  (Doc DTS 198498)

	185872
	An erroneous "The specified service does not exist as an installed service" message is returned after installing Application Engine source code. However, the source code is installed as expected and you can ignore this message. (Doc DTS 185873)  

	174513
	For client machines with Windows 2000 SP4 and Internet Explorer 6, if you install File Tracker to a user-selected folder and attempt to perform an action such as add or checkout, a C++ runtime error occurs. 

Workaround: Uninstall File Tracker, and then reinstall. Accept the default directory for the program files. (Doc DTS 151452)

	173031
	Upgrading Application Integration with the P8AE-3.5.1-002 fix pack changes the Site Preference settings for Application Integration. The settings "Open Options > Document directory" and "Open Options > Qualified path" are replaced with the settings "File Tracking > Document directory" and "File Tracking > Qualified path". During the upgrade, any existing settings are replaced with the default values. "Document directory" is set to Workplace Settings, and "Qualified path" is set to an empty field. You must manually change the settings to match your site needs. (Doc DTS 173032)  

	165493
	The installation instructions currently contain an incorrect code sample for Sun Java application server configuration.

The instructions on how to update the Sun Java application server server.policy file are incorrect, causing a server startup error. The last entry in the code sample is missing a semicolon after the java.security.AllPermission entry. The correct code sample is as follows: grant codeBase "file:${com.sun.aas.instanceRoot}/applications/j2ee-modules/Workplace/WEB-INF/-" {permission java.security.AllPermission; };(Doc DTS 165508)

	163937
	The Application Engine 3.5.1 service pack installer on HP-UX machines fails to run the upgrade script. The failure is apparent if you do the following after the service pack installation finishes:

32. Launch FileNet Workplace.

33. Select a document from the list view.

34. Right-click the document icon and note that the submenu for Get Info includes two items (among others): System Properties, and Properties. If the upgrade script had run, the System Properties item would not be present.

As a workaround, manually rerun the upgrade script following one of the following procedures:


If you have not yet performed the Service Pack 3.5.1 installation

35. Follow the instructions in the readme included on the Application Engine Service Pack CD, stopping after Step 6: Upgrade Application Engine.

36. On the Application Engine server, navigate to the following directory:

 <AE_installation_path>/FileNet/backup-3_5_1. 

37. Run the upgrade script upgrade.sh. 

38. After the script completes, verify that the following files are in the directory:

-  Actions.xml.old 
-  web.xml.old 
-  icons.properties.old 
-  UpdateWeb.xml.old 
-  UpdateActions.xml.old
-  UpdateProps.xml.old

39. (WebSphere or other application server that deploys a .war file) Recreate the app_engine.war file.
a. (WebSphere only) Move the file commons-logging.jar out of the <AE_install_path>/WEB-INF/lib directory.

b. Rebuild the .war file by running:

c. <AE_install_path>/FileNet/Workplace/create_app_engine_war.sh.

d. (WebSphere only) Move commons-logging.jar back to <AE_install_path>/WEB-INF/lib.
40. Follow the instructions in the readme included on the Application Engine Service Pack CD, starting with Step 7: Re-deploy, configure, and start Application Engine.

If you have already installed and deployed the 3.5.1 service pack and have made any changes to your configuration

If you have already started working with the service pack installed, you must copy any changed files to the installed directory, re-run the upgrade script, and redeploy the application.

41. Follow the instructions in the readme included on the Application Engine Service Pack CD, stopping after Step 5: Copy existing configuration files.

42. On the Application Engine server, navigate to the following directory:

 <AE_installation_path>/FileNet/backup-3_5_1. 

43. Run the upgrade script upgrade.sh. 

44. After the script completes, verify that the following files are in the directory:

-  Actions.xml.old
-  web.xml.old 
-  icons.properties.old 
-  UpdateWeb.xml.old 
-  UpdateActions.xml.old 
-  UpdateProps.xml.old

45. (WebSphere or other application server that deploys a .war file) Recreate the app_engine.war file.

a. (WebSphere only) Move the file commons-logging.jar out of the <AE_install_path>/WEB-INF/lib directory.

b. Rebuild the .war file by running:

<AE_install_path>/FileNet/Workplace/create_app_engine_war.sh.

c. (WebSphere only) Move commons-logging.jar back to <AE_install_path>/WEB-INF/lib.

46. Follow the instructions in the readme included on the Application Engine Service Pack CD, starting with Step 7: Re-deploy, configure, and start Application Engine. 


If you have already installed and configured Service Pack 3.5.1, and have retained the installed directory, and have not made any changes to your configuration

If you have already installed and deployed the Application Engine 3.5.1 service pack, and have made no configuration changes, and have kept the installed directory (<AE_install_path>/FileNet/Workplace) exactly the way it was before you deployed the application, you must re-run the upgrade script, and redeploy the application.

47. Follow the instructions in the readme included on the Application Engine Service Pack CD, stopping after Step 4: Back up, undeploy, and remove the Workplace web application from the J2EE application server.

48. On the Application Engine server, navigate to the following directory:

<AE_installation_path>/FileNet/backup-3_5_1. 

49. Run the upgrade script upgrade.sh. 

50. After the script completes, verify that the following files are in the directory:

-  Actions.xml.old
-  web.xml.old 
-  icons.properties.old 
-  UpdateWeb.xml.old 
-  UpdateActions.xml.old 
-  UpdateProps.xml.old

51. (WebSphere or other application server that deploys a .war file) Recreate the app_engine.war file.

a. (WebSphere only) Move the file commons-logging.jar out of the <AE_install_path>/WEB-INF/lib directory.

b. Rebuild the .war file by running:
 <AE_install_path>/FileNet/Workplace/create_app_engine_war.sh.

c. (WebSphere only) Move commons-logging.jar back to <AE_install_path>/WEB-INF/lib.

52. Follow the instructions in the readme included on the Application Engine Service Pack CD, starting with Step 7: Re-deploy, configure, and start Application Engine.

	
	

	165493
	The installation instructions currently contain an incorrect code sample for Sun Java application server configuration.

The instructions on how to update the Sun Java application server server.policy file are incorrect, causing a server startup error. The last entry in the code sample is missing a semicolon after the java.security.AllPermission entry. The correct code sample is as follows: grant codeBase "file:${com.sun.aas.instanceRoot}/applications/j2ee-modules/Workplace/WEB-INF/-" {permission java.security.AllPermission; };(Doc DTS 165508)

	147386
	Log4j warnings during Application Engine startup can be ignored.  

During Application Engine startup on WebLogic, a number of log4j warnings display. These warnings indicate that log4j logging has not been enabled on the application server. The warnings have no impact on the Application Engine functionality.

	146228
	Error log when uninstalling a source-code-only Application Engine installation. 

When uninstalling a source-code-only Application Engine install, the countdown panel indicates that the uninstaller is removing the Process Service. The Process Service doesn't exist on a source-code-only installation and an error log is created stating that "The specified service does not exist as an installed service". The uninstallation successfully completes. (Doc DTS 147826)

	146020
	The Application Engine cannot be installed twice on the same server. 

If you want to modify the current installation (for example, by adding source code) you must uninstall the existing Application Engine before you run the installer again. To create multiple instances of the Workplace application you must copy the existing Workplace folder and then deploy a new web application with a new name using the copied folder.

	144277
	When installing the Application Engine to a non-default path that includes an exclamation point (!), the Process Task Manager does not display any icons or buttons for controlling or showing the status of the routers.

	121764
	If you are installing Application Engine on one machine, and the Application Engine installer software resides on another machine, the License Agreement screen of the AE Setup wizard will be intermittently blank. To view the screen, accept the FileNet End User Software License Agreement, click Next, and then click Back.

	119004
	If you are using the Component Integrator with the JMS Service Adapter, the JAAS credentials (user name and password) specified for the component queue for the JMS adapter must exist in the security list of the application server (WebLogic, WebSphere, etc.).  The component queue is defined in Process Configuration Console.

	118543
	To use Process Orchestration on the WebSphere platform you must use WebSphere 5.1.x and later. Process Orchestration will not work with previous versions of WebSphere.

	104081
	If the Application Engine is installed on an AIX/WebLogic 7 configuration, the first download of the Java Applet jar files takes several minutes. Subsequent downloads are significantly faster.

The following Workplace items are affected:

· Process Administrator

· Process Configuration Console

· Process Designer

· Publish Designer

· Search Designer

	95098
	When uninstalling Workplace Application Integration via Add/Remove Programs from the Control Panel, the frequency in which the program is used is inaccurate.

	86841
	On a single box installation with WebLogic Windows, downloading Application Integration causes a Workplace logon failure after rebooting. 

The workaround is to move the Application Integration path entry in the system environment variable from the beginning of the path entry to the end immediately after Downloading Application Integration for the first time.  Specific steps to accomplish this are as follows:

After downloading Application Integration:

53. From the desktop right-click on the My Computer icon. 

54. Select the Properties menu item. 

55. Click on the Advanced Tab of the System Properties dialog. 

56. Select the Environment Variables button.

57. In the System variables section, select the Path variable.

58. Select Edit.

59. The Edit System Variable dialog appears.

60. Navigate to the Variable Value field and highlight the following AppInt entry at the beginning of the path statement including the semicolon:  C:\PROGRA~1\FileNET\AppInt;

61. Type Ctrl+X to delete the entry.

62. With the Edit System Variable dialog still up, move the cursor to the end of the path statement in the Variable Value line.  Type a semi-colon and hit Ctrl+V to paste the AppInt path entry to the end, deleting the final semicolon.  The entry should look like the following: C:\PROGRA~1\FileNET\AppInt


Process Analyzer

	Defect ID
	Description

	165916
	Logons to the SSO Server of WebSphere Information Integrator Content Edition v 8.3 fail if subscription event services are not installed. For a workaround, refer to the IBM Technote (FAQ) Reference # 1225105 at http://www1.ibm.com/support/docview.wss?rs=2169&context=SS5K3U&dc=DB520&uid=swg21225105&loc=en_US&cs=UTF-8&lang=en.

	164519
	Known performance issues with VMWare ESX and GSX might make them unsuitable for production environments.  Customers must perform their own testing to ensure the system configuration is performing to their satisfaction.

	150772
	When upgrading from Process Analyzer 3.0.0 to 3.5.0, be aware that the user may see a dialog box during the upgrade indicating that the 3.5.0 version will be installed on C:\program files\FileNet\Process Analyzer Engine.  The dialog can be ignored, as the Process Analyzer installer automatically uses the Process Analyzer 3.0.0 installation directory. This dialog will be displayed if the 2.0.1 version Process Analyzer was ever installed on the machine.


Rendition Engine

	Defect ID
	Description

	NA
	After uninstalling Rendition Engine or Publishing Plug-in components configured with a local SWL database, the vista.mdf and vista_log.ldf files need to be manually deleted from C:\Program Files\Microsoft SQL Server\MSSQL\Data before attempting to re-install Rendition Engine or Publishing.




Miscellaneous

	Defect ID
	Description

	555577
	Version 3.5.x of IBM FileNet P8 does not support TCP Offload Engine (TOE) technology in network interface cards on machines running P8 core components (Content Engine, Process Engine, or Application Engine) or the LDAP directory server used by P8. (TOE-equipped network cards do the TCP/IP processing that would otherwise be performed by the CPU and I/O subsystem.) 

If you do not disable TOE on all machines running P8 core components or the LDAP directory server, you will experience intermittent “Software caused connection abort: recv failed" error messages when trying to search, view, check in, or check out documents managed by Content Engine. For instructions on disabling TOE technology refer to vendor documentation.

Microsoft TOE technology, called TCP Chimney Offload, is enabled by default on Windows Server 2003 Service Pack 2 and must be disabled on every machine that is running a P8 core component or the LDAP directory server.  For the procedure to disable TCP Chimney Offload support, refer to Article 936594 in the Microsoft Knowledge Base, at http://support.microsoft.com/kb/936594/. 

To disable TOE technology on Broadcom-supplied network cards, do one of the following two procedures:

To disable TOE on Dell computers:

63. Launch the Broadcom Advanced Control Suite 2.

64. Click the Advanced tab.

65. Select the “checksum offload” property, and then select the value None.

To disable TOE on HP Blade servers running HP NC7782 Gigabit Adapter (originally manufactured by Broadcom):

66. Go to Network Properties. 
67. Select the network interface that is  enabled.

68. Select HP Network Configuration Utility 

69. Select the adapter and click the Advanced tab.

70. Select Checksum Offloading and select the value of "None".(Doc Defect 556081)

	171221
	The FileNet Platform P8 Extensible Authentication Guide Release 3.5.1 states that the custom authentication module should return the short name in the ppwszResultString parameter.  While it is legal to return the short name, it is preferable to return the full distinguished name. Returning the short name forces the Content Engine and the Process Engine to perform an extra step to query the directory service to convert the short name to a full distinguished name.

	118288
	A new security patch for MDAC was issued in January 2004.  If you choose not to install the patch, functionality is not affected  but the system is vulnerable to hackers. 
FileNet recommends you install this patch: 
 
MS04-003: Buffer overrun in an MDAC function could allow code execution
http://support.microsoft.com/?kbid=832483
Buffer Overrun in MDAC Function Could Allow Code Execution (832483)
http://www.microsoft.com/technet/security/bulletin/MS04-003.mspx

(This link also provides a workaround if you choose not to install this patch.)

	103871
	You must have the same UTCryptoKeyFile.properties files on both boxes on a two-machine SSL redirection with a Symmetric Encryption configuration. The time for both machines should be synchronized.

	102888
	You must install Service Pack 3 on every instance of SQL Server 2000 in your FileNet P8 installation. Wherever the service pack is not installed, SQL Server 2000 will fail to communicate via TCP/IP, and will render Content Engine unusable. 
In addition to Service Pack 3, you should install Microsoft Hotfix #884554 on all instances of SQL Server 2000. This will address the occasional Content Engine failure that is linked to a deadlock condition in SQL Server. (DTS 138281)

	99253
	When eForms Print Services is uninstalled, it leaves behind registry entries.


Content Engine

	Defect ID
	Description

	209309
	Warnings in the event log - "The kerberos SSPI package generated an output token of size <n> bytes, which was too large to fit in the 1000 buffer buffer provided" - may occur during login attempts by users who are members of a large number of groups. The user will login successfully despite the warning in the event log.

If authentication initially fails in CE due to a buffer size error, CE will determine the correct buffer size and retry. The use of a default buffer size is to avoid multiple round-trips to Active Directory. The current default is sufficient for most use cases.

If the login that is retried with a larger buffer succeeds, the warning can typically be ignored. However, if you experience the warnings for a large proportion of users' logins to CE and if the load on the Domain Controllers is higher than expected, please see the IBM Information Management support page (www.ibm.com/software/data/support). (DTS 1209623)

	189878
	If you stop and restart a Microsoft clustered File Store Service while documents are pending migration to a Fixed Content Device (such as Centera), the migration queue is not rebuilt correctly and documents pending migration at the time of the restart will be left in the system\migration folder.

The problem is caused by a Windows API call, used when rebuilding the migration queue, returning the node name instead of the cluster virtual name. To fix this problem, check the Use Network Name for computer name setting in Cluster Administrator for the Content Engine File Store Service configuration, and then use Cluster Administrator to restart the service.

The migration queue will then rebuild correctly and the documents will migrate to the Fixed Content Device.

	181028
	Content Engine fails to reconnect to a clustered Centera Fixed Content Device (FCD) after a failover in which the primary Centera node has failed and the second node has taken over. To reconnect to the Centera cluster you must manually restart all the Content Engine services:

· Object Store service

· File Store service

· Content Cache service

NOTE  Make sure the IP Address of the secondary node is included in the “Connection String” property of the Centera FCD.

For more information about configuring Centera file stores, see the FileNet P8 help topic FileNet P8 Administration > Content Engine Administration > FileNet P8 Domain > View/Modify P8 domain properties > Fixed Content Devices General tab, and read “EMC Centera configuration parameters.”

	168820  
	When accessing more than approximately 50 object stores, a "Cannot create Object Store" error, or authentication error occurs while accessing an object store. In P8CE-3.5.1-000 and earlier, the Performance Counter Cache Size was hard-coded to 32kbytes (32,768 bytes), which resulted in an active object store limit of approximately 50 object stores. In P8CE-3.5.1-1012, the default size was increased to 128kbytes (131,072 bytes) supporting approximately 200 object stores. In P8CE-3.5.2-000, the default size was increased to 128kbytes (131,072 bytes) supporting approximately 200 object stores, and Performance Counter Cache Size event log warnings/errors were added. In addition, a new registry value was created to increase the default size for larger numbers of object stores.

An event log warning occurs when the cache size is getting low (< 4,096 bytes), which is about 6 object stores of space left; and an event log error occurs when you out of performance counter cache memory. The event log entries appear as:

Event Log Warning when low on performance counter cache size:

Low on performance counter shared memory.  Remaining = <XXX> bytes, BlockSize = <XXX> bytes.

 

Event Log Error when out of performance counter cache memory:

Out of performance counter cache shared memory.  Remaining = <XXX> bytes, BlockSize = <XXX> bytes.


To work around the issue when there are more than 200 object stores in a P8 domain, create and correctly set the following registry entry (DWORD InitialCacheSize): 

HKLM\Software\FileNet\ECM\Content Engine\PerformanceProvider\InitialCacheSize

When there is no registry entry set for InitialCacheSize, the default value of 128 KB (131,072 bytes) is used.  If the value is set incorrectly, you will not be able to access all the object stores.

After setting the registry value, all Content Engine services must be restarted.

Note that the registry value is in cache size “bytes”, not the number of object stores or the number of kilobytes.

The following table lists some example settings for use in the registry value:

InitialCacheSize (bytes)

Approx No. of Object Stores

32768

50

65535

100

131072

200

163840

250

196608

300

327680

500

For example:

HKLM\Software\FileNet\ECM\Content Engine\PerformanceProvider\InitialCacheSize=163840 (Doc DTS 181041)

	177480
	If the following components are not installed on your P8 3.5.0 CE server, and you perform an upgrade to Content Engine 3.5.x, Apache will not be updated:

· FileStore Service

· Content Engine WebDAV Provider

· Publishing Foundation

Workaround:

When installing the 3.5.x fix pack, first uninstall Apache 2.0.52 (the version that comes with 3.5.0). After you install the 3.5.x system, install Apache 2.0.54. Select the Custom install option, and specify that Apache should be installed in the same directory as the previous version (/program files/apache group/apache2). In this way, the previous httpd.conf file will be used automatically, and you will not need to manually reconfigure Apache.

	175969
	When running CS Export, after entering the database information and hitting save, an error is returned. When receiving this error, click the "Select Export" button and continue with the export.(Doc DTS 178665)

	169865
	When you run Federator Exporter, a text file is created in the <Federator_install_dir>\FedExporter\bin directory with a name "orbtc.*.txt" and the following content:

17:23:23.906 com.ibm.rmi.corba.PluginRegistry loadPrereqPluginsGroupThree:269 ContentFederationSchedular ORBRas[default] org.omg.CORBA.INTERNAL: CONNECTIONINTERCEPTOR_INVALID_CLASSNAME  vmcid: 0x49421000  minor code: 5B  completed: No org.omg.CORBA.INTERNAL: CONNECTIONINTERCEPTOR_INVALID_CLASSNAME  vmcid: 0x49421000  minor code: 5B  completed: No

at com.ibm.ws.orbimpl.transport.WSTransport.init(WSTransport.java:208)

at com.ibm.rmi.corba.PluginRegistry.loadPrereqPluginsGroupThree(PluginRegistry.java:240)

at com.ibm.rmi.corba.ORB.initializePrereqPlugins(ORB.java:458)

…

at java.lang.Thread.run(Thread.java:568)
, p1=<null>

This is a known issue in IBM Information Integrator Content Edition 8.3. You can delete the file, as it does not affect any functionality. DTS 169865

	169386
	An excessive number of subfolders for a single folder can affect retrieval performance. For more information, refer to the FileNet P8 Platform Recommendations for Handling Large Numbers of Folders and Objects Technical Notice on the IBM Information Management support page (www.ibm.com/software/data/support). Note that a FileNet-issued logon ID is required to access the web site.

	167763
	A bug in Enterprise Manager incorrectly flags the Connection String property data being sent to a Centera system as BASE64 encoded. This error occurs when attempting to use a DNS name in the Connection String property for the Centera fixed content device.  

The following methods provide a workaround for this problem: 

Method 1: 

71. Edit the server “hosts” file and add a line mapping the DNS name of the server to its IP address. 

72. Create a UNICODE file with only the DNS server name in it and place that file in the GCD shared directory. 

73. Set the Connection String Property to ‘file:c:\p8gcd\filename’  where ‘c:\p8gcd’ is the path to the GCD directory and ‘filename’ is the name of the file created in step 2. 

Method 2: 

Note: Use this method if there is more than one host name in the connection string.

74. Edit the server “hosts” file and add lines mapping the DNS names of the servers to their IP addresses. 

75. Set the Connection String Property to the list of server names, separating each server name by a comma.  (Doc DTS 167994)

	164085
164088
	The 3.5.1 Security Mapping Wizard does not read all the XML files generated by the Enterprise Manager export manifest. It only views the first file in the manifest, meaning that the list most likely will be incomplete. Also, it fails to generate a mapped copy of the first file listed in the manifest and the mapped copy of the manifest is missing the first line. 

As explained in the Content Engine Help topic "Concepts: exporting and importing", Enterprise Manager generates as many as 7 XML files, depending on the type of objects being exported. Each group file potentially contains many files, depending number of those objects for each group. Along with this is an Export Manifest file which points to each group file. Following an export, you will end up with some variation of the following:

· Export_Group1_1.xml

· Export_Group2_1.xml

· Export_Group2_2.xml

· Export_Group3_1.xml

· Export_Group4_1.xml

· Export_Group7_1.xml

· Export_Manifest.txt

In order to map the security accounts contained in those XML files to new accounts prior to importing them into a new object store, use the following workaround:
76. Run the Security Mapping Wizard on each of the XML files to completion so that a copy of that XML file is created with the properly mapped security accounts exist within the copied file. Do this for every exported .XML file created during the export.

77. Make a copy of the Export_Manifest.txt.

78. Edit the copy of the export manifest file so that each line now references the copy of the XML files.

79. When importing into a new object store, use the updated copy of the export manifest. (Doc DTS 164097) 

	163287
	On FileNet P8 Content Engine, PSI receives an error while adding a large amount of content to DB2/Solaris when the Solaris patch is not installed. An error appears in the event viewer during PSI Population and WebLoad testing when adding Large Content to the database (500K, 2MB). This error causes the PSI Population to abort. During WebLoad testing the user is logged off.

As a workaround, do the following:

Option 1: Download and apply Solaris tcp patch 118305-06 

Option 2: Set the tcp_co_min parameter to the MTU size of the NIC by executing the command:
 
run ndd -set /dev/tcp tcp_co_min [MTU Size] on the Solaris Server.  The default MTU size is 1500.   This applies to Solaris 8 and 9.  (Doc DTS 169306)

	162940
	In Enterprise Manager, after changing a user's Pre-Windows 2000 ID (in Microsoft Active Directory), the user gets a series of errors and then the security tab displays "?" where account names should be. In Workplace, the user cannot search for accounts and after the cache expires, the user is unable to sign in again. 
To workaround this issue, do one of the following: 

· Reboot the CE Object Store Service server. 

· Restart Apache and the CE Object Store Service. Wait 5 minutes after the username has been changed before logging into the Content Engine as that user.  (Doc DTS 163581)

	162657
	Enterprise Manager, running on Windows 2003, crashes on refresh after a new folder is copied/pasted under the root folder.  

	161745
	Applications may receive spurious socket-related exceptions if System.out and/or System.err are redirected and logging to a ConsoleAppender is attempted. The exceptions are caused by a bug in log4j in which the described behavior causes SIGPIPE signals to be generated. A workaround is to avoid using ConsoleAppender in such situations. (Doc DTS 163964)

	160468
	When using the Enterprise Manager, Image Services Mode 1 document committal will not go to the correct IS document class if you use the Create a New Object Store wizard to create a file store with a default IS document class that is different from the default that was set when you created the Fixed Content Device (using the Create a Fixed Content Device Wizard). In such a case, Mode 1 documents will be stored correctly on the Content Engine's file store, but on the IS system the content will be (incorrectly) stored according to the default IS document class set on the Fixed Content Device.

Note that you do not see this problem if you use the Create a New File Store Wizard to create the file store after the object store is created. (Doc DTS 160660)

	157956
	When running CS Export and exporting a CS document using a Doc class that has an integer custom property with a CVL assigned and the property is blank (null) on the document, CSExport gives a message saying “Error Setting custom property” and the detail message says “FileNet P8 Content Engine DMA Core Library - The value specified for property &#38;#39;SVCPIntegerItem01&#38;#39; is not one of the permitted values.”

	157698
	On a FileNet P8 3.0 Content Engine object store server where McAfee VirusScan Enterprise 8.0i is installed, the Object Store Service might crash and become disabled when an EventAction that contains VBScript or JavaScript code is fired. The following symptoms might be exhibited:

An error message similar to the following appears (your ID numbers will vary):

File = .\CDocumentResultNode.cpp, Line = 491, Rev. = $Revision: 1.103 $

Source = FileNet P8 Content Engine Administration 

Description = An automation operation threw an exception with code -2147023170. 

HR = 0x800706be

HR Description = The remote procedure call failed.

MinorCode = 0xc007000f

· The Object Store Service crashes and automatically restarts itself until it becomes disabled (the Object Store Service startup mode changes from automatic to disabled).

· The QueueItem table contains at least one row where the epoch id is 0 and the retry count is 7. This identifies the EventAction that led to the crash.

· Errors similar to the following appear repeatedly in the Event Viewer:

The system has called a custom component and that component has failed and generated an exception. This indicates a problem with the custom component. Notify the developer of this component that a failure has occurred and provide them with the information below. Component Prog ID: 
Server Application ID: {E61845DB-B905-438C-A9ED-C94929A3E840}
Server Application Instance ID:
{99FF0D83-953C-4036-A71E-44038AF9BFC1}
Server Application Name: Content Engine Object Store Service
The serious nature of this error has caused the process to terminate.

To work around this error, refer to the solutions in the Network Associates Knowledge Base article
 http://knowledgemap.nai.com/KanisaSupportSite/search.do?cmd=displayKCPopup&docType=kc&externalId=KBkb40049xml&sliceId=&dialogID=180583

or modify the EventAction to use VBScript.Encode or SignedVBScript (or JavaScript.Encode or SignedJavaScript).

	153283
	FileNet P8 Content Engine 3.5.0 lacks support for the SnapLock 7G default retention periods. Prior to a fix expected in Release 3.5.1, you can work around the problem by setting the fixed file store's Default Retention Period to "User Defined", and then selecting a value that is within the Minimum/Maximum limits of the actual SnapLock volume. (In Enterprise Manager, right-click the SnapLock fixed file store, select Properties, then click the Fixed tab.) If you choose any of the other retention period options (No Minimum, Infinite, Same As) you might not get the results you expect, and you might run into difficulties when you upgrade to FileNet P8 3.5.1. (Doc DTS 154062)

	151657
	If you install Content Federation Server for Image Services (CFS-IS) and File Store Service on the same machine, the security on the folder containing CFS-IS libraries will not be properly set. 

As a workaround, after the installation, do the following:
80. Navigate to the "client" subfolder within the folder where CFS-IS is installed.

81. Right-click the folder icon and choose Properties, and click the Security tab.

82. Set the security on the folder so that the local Everyone group has Full Control permission.

83. Click Advanced and set the checkbox to reset/replace the permission on all child objects and enable propagation of inheritable permissions.

84. In the Services node of the Computer Management snap-in, restart FileNet CFS Server for Image Services.

	151651
	The Process Services Manager does not start routers properly after an upgrade. After the upgrade to P8 3.5, Process Routers do not remain started on the Content Engine. The Event Viewer has a number of errors regarding the failure of the Process Services Manager to start a Java process for the routers. 

To work around this problem, do the following on each machine experiencing this issue:

85. On the system where this issue is occurring, open the Windows registry.

86. Navigate to "HKEY_Local_Machine\Software\FileNet\eProcess".
87. Modify the value for the key "classpath.PECE" by prepending the full path to the jar files currently in this registry key.

88. Restart the Process Services Manager service.

	151650
	After perfoming an upgrade on an Object Store Service, the Process Services Manager does not exist. When trying to bring up the Process Task Manager there is no tab to create routers.

To work around this problem, do the following on each machine experiencing this issue: 

89. Open the Windows Control Panel for the system on which the issue is occurring and select "Add/Remove Programs". 

90. Click the Change/Remove button for Content Engine. 

91. Select the "Repair" option from the installation menu that appears. 

92. After the repair installation completes, verify that the "Process Services Manager" was created. (Doc DTS 151964)

	151649
	When upgrading to FileNet P8 3.5.0, the GCD wizard (configGCD.exe) might give a blank value for the name of the Content Engine Servers group. The configGCD tool should verify information used for the previous installation. Upgrade cannot proceed if this value is blank. 

To work around this problem, cancel the wizard and do the following:

93. On the system where this issue is occurring, open the Windows registry.

94. Navigate to "HKEY_CURRENT_USER\Software\FileNet\ECM\Content Engine\GCDValues".

95. Examine the value for the "WINAccount" key. If the value is blank, set it to "Content Engine Servers" (or whatever value you used in the previous Content Engine installation).

96. Re-run the GCD wizard (located at <content engine installation location>\FileNet\Content Engine).

	151648
	When you upgrade a Content Engine, the GCD wizard normally defaults to the FNCE_machine user and Content Engine Servers Group service accounts that the Content Engine was previously installed with.  However, in some instances, this information is not available (a blank panel appears in place of the expected selection dialog box). When this happens, if you specify a password to move forward in the wizard, the wizard will try to reset the password for the default user listed instead of verifying the password. This will fail if you (as the installer) do not have the proper privileges to reset passwords on Windows Active Directory accounts.

To work around this problem, do the following on each machine in the FileNet P8 domain running Content Engine:
97. Open the Windows registry.

98. Navigate to HKEY_CURRENT_USER\Software\FileNet\ECM\Content Engine\GCDValues.

99. Locate the "Windows Service Account" key.  The value of this key is most likely of the form <username>.  Replace the value of this key with the following Windows SamAccount format: <windows domain>\<username>.

For example, if the current value of the key is "p8admin", and the full domain name of the windows domain is "testdomain.filenet.com", then the new value of the Windows Service Account key should be "testdomain\p8admin".

100. Re-run the GCD wizard (ConfigGCD.exe).

	151647
	The FileNet Enterprise Manager program does not currently accept special characters in the password for IS user accounts associated with the CFS-IS implementation. This restriction is documented in existing Enterprise Manager help, but it is not expected behavior and will be changed in an upcoming fix pack or release.

	151379
	On any machine where you have collocated Content Engine and Process Engine, perform the following workaround to manually fix the security settings of the Image Services Toolkit (ISTK) if you are using Content Federation Services Server for Image Services (CFS-IS). Otherwise, you will not be able to create a fixed content device on an IS server.

101. Select c:\fnsw\client\bin and c:\fnsw\client\shobj. 

102. Right-click and choose Properties. 

103. Click the Security tab. 

104. Add Everyone to the Name list, and grant Full Control in the Permissions list. Then click OK. 

105. Stop all Content Engine services: Content Cache Service, File Store Service, and Object Store Service. 

106. Restart Content Cache Service, File Store Service, and Object Store Service, in that order, to reload the new ISTK security settings. (Doc DTS 153622)

	147705
	Signing on to Workplace may be slow when the Workplace users are geographically remote relative to the primary Content Engine. 

For example, consider an installation with a primary Content Engine, including the master GCD (SysInit.dat file) on one continent, and a secondary Content Engine in the same FileNet P8 domain at a remote site half-way around the world. Workplace users near the primary Content Engine sign on quickly, while the users at the remote location take much longer to sign on.

The solution is to make sure that the GCD CacheLifeSpan value is larger than the time it takes to read the remote SysInit.dat file. For example, if it takes users 5 seconds to read the SysInit.dat file, and GCD CacheLifeSpan is set to 2 seconds, the file would always be read and the cache would provide no benefit. The solution would be to increase the GCD CacheLifeSpan value to something greater than the average remote sign-on time.

	147663
	Choosing to install FileNet P8 Content Federation Services Server for Image Services at the Custom Setup screen, as part of a Custom type installation of Content Engine, will cause "C:\Program Files\Filenet\Content Engine" to be omitted from the Path system environment variable on the Content Engine. As a result, the Publishing Service Controller and Style Template Manager will fail to launch. 

As a workaround, manually append "C:\Program Files\FileNet\Content Engine" to the Path system environment variable on the Content Engine after the Content Engine Setup and the GCD wizards have run to completion.


	147192
	When an Enterprise Manager (EM) user double-clicks on a document, the Enterprise Manager takes the default operating system "EDIT" action for the document type. Where no default "EDIT" action exists (as is the default for Windows 2000), the document will not open.  

· In FileNet P8 3.0.x, when the EM user double-clicks on a document object, EM issues an operating system OPEN action.  The operating system then executes the OPEN action for that file type. Both Windows 2000 and Windows 2003 have default OPEN actions for most file types.

· In FileNet P8 3.5.x, when the EM user double-clicks a document object, EM issues an operating system EDIT action. The operating system goes to the EDIT action for that file type (.txt, .doc, .xls, etc.) and executes that action. Windows 2003 has a default EDIT action for most file types; Windows 2000 does not. As a result, when the P8 3.5.x EM user double-clicks a document object on a Windows 2000 system, the document does not open in edit mode. 

The reason for this change is that the OPEN action could potentially run executable file types (such as .bat, .vbs, .exe) that were stored in the Content Engine. In most cases, this would not be desired. As a security precaution, therefore, Enterprise Manager would change over to the EDIT action.

A workaround for Windows 2000 follows:

107. Open Windows Explorer.

108. Select Tools > Folder Options and choose the ‘File Types’ tab.

109. Find the extension type of the file you want to ‘EDIT’ within EM (for example, .txt).

110. Highlight the file type and click on the Advanced button.

111. Select the New button.

112. Type in EDIT for the Action.

113. Type in the command for the ‘Application used to perform action’. For example, the .txt EDIT action would perform the following: 

114. C:\WINDOWS\system32\NOTEPAD.EXE %1

115. Click OK several times to close 

Now, when an EM user double-clicks on a document that is associated with a .txt file, it will execute the EDIT action that tells Windows to launch the file in Notepad.

	146939
	Indexing of Content Engine documents is resource-intensive, and indexing performance depends upon your specific hardware and software configuration (memory, file store size, file store location, etc.). If multiple file stores containing large numbers of documents reside on the same storage device, degraded performance may occur during operations such as indexing during initial installation, importing a large number of documents or searching for documents via FileNet P8 Workplace. Degraded performance can include timeout errors. To minimize the risk of degraded performance, be aware of the consequence of indexing new file stores simultaneously.

	146668
	By default, Enterprise Manager folders display a limit of 5000 objects (documents, custom objects, or other folders). Enterprise Manager folders include the Root folder and all its subfolders, as well as the Unfiled Documents folder. This limit was created to prevent possible out-of-memory errors in object stores with large numbers of documents. 

To increase this limit, close Enterprise Manager, and modify the registry key:

HKLM\SOFTWARE\FileNet\ECM\Content Engine\Enterprise Manager\MaxObjectsDisplayed
 
Then restart Enterprise Manager.

	146634
	There is a known problem with querying the Content Engine via Excel, using an Office database connection (.odc file). 

After a successful connection is made and the Content Engine and the Content Enginetables are listed in the Database Connection Wizard, when attempting to run a query the following error appears:

"An operation that uses the database driver could not be completed. If the driver is a Microsoft driver, make sure the driver file isn't damaged, and if it is, reinstall the driver by reinstalling Microsoft Query.  For other drivers, contact your database administrator or the driver vendor."

The actual problem is that Excel does not put the password in the connection string.

Follow these steps to avoid this error:

116. Launch Excel.

117. Select Data->Import External Data->Import Data.

118. Select +Connect to New Data Source.odc and click Open.

119. In the Data Connection Wizard select Other/Advanced and click Next.

120. Select Content Engine OLEDB Provider and click Next.

121. In the Data Source text box enter the Object Store name.

122. Select the Use Windows NT Integrated security radio button (or enter the username/password).

123. Click Test Connection and it should be successful.

124. Select the 'All' tab.

125. Set the Extended Properties value to the string 'ecm' and Persist Security Info value to True.


126. Click OK and the Database Connection Wizard will display a list of all the CE Tables (classes).

127.  Select the Document table and click Next.

128.  Accept the default filename for the .odc file and click Finish.

129.  In the Import Data dialog select Edit Query button to modify the OLE DB query. Add the user password to the OLE DB query.  It should look like:
Provider=FNCEOLEDB.1;Data Source=<object store>;User Id=<ce user>;Password=<pwd>;Persist Security Info=True;Extended Properties=ecm

130. Select OK to close Edit Query dialogue and OK on Import Data dialogue.

131.  Document record rows should display in Excel. (Doc DTS 156114)

	146224
	After upgrading Content Engine to version 3.5.0, any object store you create will have #CREATOR_OWNER as the default instance owner of the Access Role subclass of Custom Object class. You can change the default instance owner to anything you like. (Doc DTS 147508)

	145473
	A "Delayed Write Failure" error occurs on Windows 2003 (as the client)  when adding a document thru WebDAV using SunOne authentication. 
For additional information, refer to the following Microsoft KB articles: 
#823383 http://support.microsoft.com/?kbid=824383  and 
#818404 http://support.microsoft.com/default.aspx?scid=kb;en-us;818408(Docs DTS 159187)

	145153
	Windows 2003 clients get a "File is locked or in use by another user" error attempting to open an existing Word/Office 2003 document by double-clicking it inside a mapped drive (Webdav connection). The error doesn't appear if the document is opened from inside Office 2003, or by double-clicking it inside a webfolder (non-mapped drive). 
(Doc DTS 159239)

	145002
	WARNING Before shutting down the Content Engine-related services, allow all ongoing transactions to complete. Transactions are complete when the transaction log files in <drive>:\Program Files\FileNet\Content Engine\Log\ contain zero bytes.

	144547
	After you have added content to a fixed content store, there may be a brief interval before the content has completely migrated to the device. If you call the MoveContent method during this interval, you may experience an error during certain operations. In order to avoid an error, you should ensure that the newly added content has had a sufficient length of time to have completely migrated to the fixed content store. The amount of time needed is variable and depends on the speed of the fixed content device and its load.

	143807
	When running Enterprise Manager on Windows 2003, refreshing the Unfiled Documents node does not work. You have to refresh the entire object store to see the new unfiled documents.

	143522
	As installed with FileNet P8, Apache httpd is configured to mark most textual content types (text/plain, text/html, etc.) as having a character set of ISO-8859-1 when they are downloaded.  If the content in question actually has a different character set, it might be displayed incorrectly in a browser or other viewing application.  

	143392
	The Content Engine Object Store Server (FNK_CatService.exe) exhibits a memory leak when using an Oracle instance. The problem only occurs when the Content Engine Object Store Server’s Oracle client is set to use Windows integrated authentication, which is the default setting. Content Engine does not use integrated authentication to connect to an Oracle database. (The administrator specifies a username and password for Oracle when creating an object store.) 

It is recommended that the Oracle client settings for SQLNET.AUTHENTICATION_SERVICES on the Content Engine be set to NONE.  

Note For installations with a co-located Process Engine, this setting can only be changed as recommended after the Process Engine is fully installed.

	142783
	Changing User Preferences on Export Manifest node on one object store affects other object stores.

	140806
	Content that has been successfully checked in and is targeted for a fixed storage device cannot be deleted prior to migration to the device. This is done to insure that content intended for a WORM device is not prevented from reaching the device.

	140745
	When searching for users (in Enterprise Manager, Workplace, or other FileNet P8 interfaces), Novell eDirectory returns duplicate entries if the directory contains duplicate cn entries. For example, while searching for users starting with "aa" during testing, the following user was returned twice by eDirectory: 
dn: cn=aadrien,ou=sales,o=novell
cn: aadrien
cn: Aaron A. Adrien
Both cn values (aadrien & Aaron A. Adrien) start with "aa" so the search found the same user twice. FileNet is exploring a solution with Novell. In the meantime, FileNet recommends that eDirectory administrators avoid creating multiple cn values for a single user account. (Doc DTS 145890)

	140389
	If your Content Engine object store databases reside on Microsoft SQL Server, users (such as those running Workplace) might encounter general performance degradation when a large number of concurrent searches are run that return 50 or more results.  FileNet performance labs have seen the problem occur when tests run around 20 searches per a minute. This problem is due to a known SQL Server bug, as documented in KB article http://support.microsoft.com/kb/884554. This issue is resolved with SQL Server SP4 and greater.  

	139976
	When Content Federation Services (CFS) is used with Content Engine/SQL Server, a date property value between 1/1/1601 and 12/31/1752 in a document committed to the IS Doc class is stored as 1/1/1753 UTC in the Content Engine DocVersion after the document is exported to Content Engine. (Note that when this value displays in Enterprise Manager, it is adjusted for timezone.) This discrepancy results from SQL Server's limiting of datetime values to 1/1/1753 or greater; there is no workaround.

	138281
	When checking in a document, the Content Engine fails with Error 80040e14 "Transaction manager has canceled the distributed transaction" found in CE event logs. This problem is due to a known SQL Server bug. To resolve the issue, install SQL Server 2000 Service Pack 4 and Microsoft Hotfix #884554. (DTS 145885).

	135993
	You can upgrade an existing version of Content Federation Services Server for Image Services (CFS-IS) from a CD containing a newer version of the software. Before doing so, however, you must uninstall the existing version.  

To uninstall the existing version, perform the following steps: 

132. Windows Add/Remove Programs, select FileNet Content Engine and then click Change.

133. When the Content Engine Setup wizard starts, click Next.

134. At the Program Maintenance screen, click Modify and then click Next.

135. In the Custom Setup screen, highlight the FileNet P8 Content Federation Services Server (CFS) for Image Services entry in the program features list.

136. Click the icon to the left of the highlighted entry, select "This feature will not be available." from the dropdown list, and then click Next.

137. At the Ready to Modify screen, click Modify to uninstall CFS-IS.

138. When the uninstall completes, verify that Windows Add/Remove Programs no longer lists CFS-IS as currently installed. 

NOTE If you uninstall CFS-IS directly via Windows Add/Remove Programs, the Custom Setup screen in a subsequent launch of the Content Engine Setup wizard will erroneously indicate that CFS-IS is still installed.

	131863
	When you export an Object-Valued Property that contains a reference to an external object in another object store, that object (and associated objects) is pulled into the export file. Therefore when you import it, the external reference becomes an internal reference. There is no notification from the Enterprise Manager or Content Engine of this behavior. (Doc DTS 161563)

	123411
	The Enterprise Manager's normal procedures for exporting objects (right-click the Root folder and select All tasks > Add to Export Manifest (include subfolders) or right-click the object store folder select All tasks > Add to Export Manifest) will not add unfiled objects (documents and custom objects) to the Export Manifest. By design, some Workflows and their attachments are unfiled documents, and will therefore be in the Enterprise Manager's Unfiled Documents folder. To add unfiled documents to the Export Manifest, select the Unfiled Documents folder in the Enterprise Manager, and then select All tasks > Add to Export Manifest. This will add any unfiled documents to the Export Manifest's Documents folder.  

	122982
	If you are not using Advanced Security to authenticate against your Oracle database, and are not collocated with Process Engine, it is strongly recommended that you modify the SQLNET.ORA file so there are no references to authentication services. 

The line should appear as follows:

SQLNET.AUTHENTICATION_SERVICES = (NONE)

If this line refers to NTS authentication service when NTS is not configured, Oracle error "ORA-12699: Native service internal error" may result, and consequently the Object Store creation will fail.

Please refer to Oracle Support (TAR 3122992.999) for more information.

	118324
	Object store names that contain Japanese characters display incorrectly in Workplace. The administrator who creates an object store that includes Japanese characters in the object store name must stop and restart the Content Engine server to correctly display the object store name in Workplace.

	104369
	Content Engine Oracle is a case sensitive database. Therefore, property searches performed on an object store that utilizes an Oracle database will also be case sensitive.

	104129
104406

	If you create a new FileNet P8 domain as part of a Typical or a Custom installation of Content Engine, and your authentication provider is Sun Java System Directory Server or Novell eDirectory, be sure to specify a fully qualified domain name, not an IP address, in the Host field of the Configure Authentication Provider screen of the GCD wizard (see step 3bii of the Installation Guide's procedure “To create a new FileNet P8 domain”). If a fully qualified domain name is not specified, you may experience erratic system responsiveness or delays of several seconds in relation to Content Engine operations. Use the DNS server or a hosts file entry on the Content Engine server to resolve the host name of the authentication provider. When using Sun Java System Directory Server with SSL, the user should ensure that the authentication provider hostname matches the server certificate. When using Novell eDirectory with SSL, the eDirectory has a built-in certificate which utilizes the fully qualified name.

	102888
	You must install Service Pack 3 on every instance of SQL Server 2000 in your FileNet P8 installation. Wherever the service pack is not installed, SQL Server 2000 will fail to communicate via TCP/IP, and will render Content Engine unusable.

	102776
	The WFDeploy.vbs script provided with the Content Engine does not function correctly. 

This script is designed to help move Workflow definitions that use attachments from a development environment to a production environment. When a Workflow definition is moved to a production environment, the XML must be updated, such that for each attachment:

139. The object store name is the name of a new object store.

140. The version series GUID is the version series GUID for the new object store.

The GUID for the new object store can be determined as follows:

141. In the old object store, identify the document ID associated with the version series GUID.

142. In the new object store, use the document ID to locate the new version series GUID.

143. The document ID of the attachment is the same in both the old and new object stores.

	99876
	The user you create and assign to an Oracle tablespace for a new object store must not already be assigned to the tablespace for a previously-created object store. Otherwise, the previously-created object store will become permanently inaccessible.

	98276
	“Access is denied" error (Oracle bug 2498880 (Oracle Doc ID 215255.1))

On a Content Engine or FileNet Enterprise Manager (Oracle 9.2 client) machine, when you create an object store (or access objects that are using an Oracle DB), you might encounter the following error: 
Event Type: Error

Event Source: FileNET Content Engine

Event Category: Object Store Service 

Description:

PID=812, TID=816, Fnk_CatService.exe hr=0x80070005(Access is denied.) database.cpp[487] ($Revision: 1.56 $): A failure occurred calling 'IDataInitialize::GetDataSource()' on OLEDB provider.

The error appears in the Content Engine or FileNet Enterprise Manager machine event log when creating Content Engine object stores and after you enter the Oracle user_name and password.

To work around this error, you need to give the Authenticated User privilege to the Oracle Home by following the steps below. Apply the workaround on all Content Engine and FileNet Enterprise Manager (Oracle 9.2 client) machines that will access Content Engine-Oracle object stores or objects.
144. Log on to Windows as a user with Administrator privileges.

145. Launch Windows Explorer from the Start Menu and navigate to the ORACLE_HOME directory. This is the Ora92 folder located in the Oracle folder, such as c:\Oracle\Ora92.

146. Right-click the ORACLE_HOME folder and choose the Properties option from the drop down list. A Properties window appears.

147. Click the Security tab in the Properties window.

148. Click Authenticated Users item in the Name list. On Windows XP, the Name list is called Group or user names.

149. Clear the Read & Execute box in the Permissions list. On Windows XP, the Permissions list is called Permissions for Authenticated Users. This box will be under the Allow column.

150. Select the Read & Execute box. This is the box you just cleared.

151. Click Apply.

152. Click OK.

153. Reboot your computer after you make these changes.

154. Create and/or recreate a Content Engine object store or access objects that are using an Oracle database. 

	96305
	An error occurs when creating indexes and an object store name contains non-Latin characters. 

To work around this error, create an index on a file store that has a pure English path name. You can do this by verifying the following: 

· The shared folder path contains only ASCII characters.

· The file store folder name contains only ASCII characters.

Note that the object store name is independent of the file store name. Therefore, the object store name can contain non-English characters.

	89094
	When running the object store wizard and selecting MSSQL, the wizard hangs when a large number of SQL Servers are present on the domain.

	87873
	Installation of a Content Engine in a child domain does not let the user create an object store when the DataBase server exists in a parent domain.


Rendition Engine and Publishing

	Defect ID
	Description

	204315
	Using event actions in publishing leaves behind orphaned subscriptions. 

Cause: 

To trigger the "publishing complete" event action the publish request object creates a subscription object that is not automatically deleted after the source document has been published.

Details: 

If the publish template used to publish a document specifies an event action, the publish request object creates an asynchronous subscription object that triggers the event action when the publish request object is deleted at the end of the publishing process.  At this stage, as the publish request object that created the subscription has been deleted, there is no publishing code that knows when the subscription has been used and can be deleted. This causes the subscription to be orphaned.

Workaround:

To ensure that any new subscriptions are deleted you must update the event action code to include a delete command. Any existing orphaned subscriptions can be deleted from Enterprise Manager.  

1. Modify the existing event action code to delete the subscription object after it has been used. 

For example:

Public Sub OnEvent (EventObject, Subscription)

  if EventObject.IsOfClass("DeletionEvent") Then

    <Existing event action code>

    Subscription.Delete 2

    Subscription.Save 1

  End If

End Sub

2. Manually delete existing orphaned subscription objects:  

a. In Enterprise Manager, navigate to root > Object Stores > object-store > Events > Subscriptions.

b. Right-click on the Subscriptions node.

c. Select All Tasks > Clean up Orphaned Subscriptions. (Doc DTS 743339) 

	166636
	The meter range values do not automatically refresh when the maximum value is reached. Work around this issue by manually clicking the Dashboard to refresh the meter range values. (Doc DTS 166991)

	164101
	When Modifying the Vista component in the Control panel, Add/Remove programs, an error appears saying "Unable to install Liquent PDF printer. Make sure you have Adobe Distiller 6.0 installed."  This error can safely be ignored and there is no need to install the Adobe Distiller. (Doc DTS 164102)

	163329
	If you enter invalid database user credentials in the Rendition Engine installer, and complete the Rendition Engine installation, you will have to perform the following workaround:

155. From Control Panel > Add/Remove programs, select the Vista program item.

156. Click the Change/Remove button.

157. Select the Modify radio button.

158. Step back through the installer options. When you get to the Database connection screen, enter valid database user credentials.

159. Proceed through the remaining screens.

160. At the end of the procedure, ignore the error message that indicates Adobe Distiller is not installed. 

161. Continue with your installation/configuration where you left off.

	162932
	Converting a Word document with Japanese text to PDF fails with the following error: "Unable to convert to pdf SAX parser failed to parse xml source document."

	161947
	For systems upgrading to Rendition Engine 2.2:
Existing MIME types in the Input Formats property of the default or customer created Publish Style Templates will not be automatically updated during an upgrade.

To manually change the MIME types in the input formats property of any existing PDF Publish Style Templates:

162. Run the Publishing Style Template Manager.

163.  Select each existing object store and select each PDF Publish Style Template in turn

164. For each existing PDF Publish Style Template, update the MIME type by clicking Edit, located to the right of the Source Document MIME Type(s) field.

165.  Remove the MIME types from the Selected MIME type box by clicking  << to remove all, or select each individually and click < .

166.  Then either select individual MIME types from the Available MIME Types and click the > or click >> to select all and move them to the Selected MIME Types

167. Click OK and OK. 

Note that this only needs to be done for PDF Publish Style Templates with unsupported MIME types. For a list of supported MIME types, see the Gold List in the online help for Publishing.

	160876
	Attempting to publish PowerPoint documents with certain design templates causes the Liquent XML printer to crash and the document cannot be published to PDF. Some PowerPoint 2000 templates used in PowerPoint 2003 might be incompatible with Rendition Engine.
The following POT files in PowerPoint 2000 are not in 2003 (even after installing the Additional Design Templates) but if they previously existed on your system, they could be browsed to for use in PowerPoint 2003.  Not all of them are known to create the problem, but caution is urged when attempting to use them in PowerPoint 2003 if attempting to subsequently publish the document.

· Templates\Presentation Designs\Artsy.pot

· Templates\Presentation Designs\Blueprint.pot

· Templates\Presentation Designs\Bold Stripes.pot

· Templates\Presentation Designs\Dad`s Tie.pot

· Templates\Presentation Designs\Expedition.pot

· Templates\Presentation Designs\Factory.pot

· Templates\Presentation Designs\Lock And Key.pot

· Templates\Presentation Designs\Marble.pot

· Templates\Presentation Designs\Mountain.pot

· Templates\Presentation Designs\Nature.pot

· Templates\Presentation Designs\Network Blitz.pot

· Templates\Presentation Designs\Notebook.pot

· Templates\Presentation Designs\Ribbons.pot

· Templates\Presentation Designs\Ricepaper.pot

· Templates\Presentation Designs\Sandstone.pot

· Templates\Presentation Designs\Soaring.pot

· Templates\Presentation Designs\Straight Edge.pot

· Templates\Presentation Designs\Strategic.pot

· Templates\Presentation Designs\Sumi Painting.pot

· Templates\1033\Motivating A Team.pot

· Templates\1033\Selling Your Ideas.pot

	151728
	Do not use Terminal Services to install Rendition Engine software on a Windows machine. You may use Terminal Services to administer or configure Rendition Engine.

	147296
	To ensure the Liquent-based Rendition Engine properly converts MS Word and MS Excel documents containing hyperlinks, external links, image links, etc., set the Use long file names whenever possible in the Web Options presented in the Tools or Properties of those applications. For example, in Word 2000, select Tools > Options > Web Options button > Files tab > Use long file names whenever possible. Do this wherever the MS Office applications reside -- on the Rendition Engine server AND on each client machine from which source documents are added and rendering is initiated.  By default, Office 2000 has the Use long file names whenever possible option unchecked, while Office 2003 and Office XP have it checked.

	
	

	118321
	Arabic characters in documents published to PDF by Liquent Vista Component Server 2.1.2 SP2a appear corrupted when viewed with Adobe Acrobat Reader.

	103515
	The Oracle Client patch requirement for Rendition Engine is Oracle 9iR2 Patch Set 9.2.0.5.0.  Oracle Universal Installer (OUI) 10.1.0.2, a component of the patch set, must be installed first.

	
	

	96258
	Arabic characters in documents published to PDF and opened with Acrobat Reader are corrupt.

	
	

	NA
	If Oracle is your Rendition Engine database:

· Refer to the script file Oracle-Repository2.1.2.sql for publishing-related database/tablespace requirements.

· Unless publish jobs are routinely archived/deleted, the tablespace continues to grow (by default the tablespace is set to autogrow).

	
	

	NA
	Publishing does not resolve hyperlinks when converting Excel spreadsheets. This issue is set to be addressed with a future release.

	NA
	Publishing jobs fail when the Word source documents contain the AutoOpen macro or protected form fields.

	NA
	When publishing a read-only Word document (Windows read-only property), the Word plug-in fails when any of the following transformation options are selected: Suppress Headers, Suppress Footers, Preserve Word Web Links, or Add Line Numbering.

	NA
	Microsoft Project publication documents may contain more pages than you expected from the original source document. This is because the pages that are published depend on what was displayed in the Microsoft Project window when you last saved the document. To avoid additional pages, you must save the file with only the information you want to have displayed. For example, you must save the file with only the Gantt chart displayed if you do not want the calendar rendered with the document.

	NA
	When printing an Excel file containing multiple sheets, you are able to print page numbers in the header/footer in sequential order across all the sheets in the workbook. However, the published output of the same workbook results in the page numbers starting over for each sheet. The content type configuration allows you to select printing of the entire workbook, but the pagination is not preserved. 

	NA
	When Rendition Engine requests the location of  VistaTempDir, it is possible for the software to return a location that is not available. If the server machine hosting VistaTempDir is unexpectedly shutdown, the software never verifies the availability of VistaTempDir before telling the location to the Rendtion Engine.

	NA
	When using the LiquentDomain Manager to add a repository to a Vista domain, you must perform this task on the same repository (server) machine that is being added. This restriction is necessary since the Liquent Domain Manager must update the machine's registry to point to the Vista domain's database.

	NA
	WordPerfect documents that were converted from Word fail to generate HTML files. When publishing Word-to-WordPerfect documents, a hidden save dialog is generated by the WordPerfect plug-in. This dialog is not properly handled by the software and the publishing job fails.

	NA
	PublishingWord documents with embedded Excel tables results in text expanding outside the cells when published to PDF.


Content Federation Services Limitations

· Multivalued properties cannot be federated by CFS.  Do not include multivalued properties in the datamap used for federation.

· If a federated document has renditions in addition to primary content, only the primary content is viewable in Workplace, the renditions are not viewable through Workplace.

· Sweeping does not work for Content Services if the properties are modified without checking out and checking in the source documents.
· Sweeping does not work properly if the repository machine has a different time zone than the time zone of the RMI Bridge machine.  The result is that modified documents in the source repository may not get re-federated by CFS.
· DB2 Content Manager OnDemand is supported. This is a preview feature for federation only. Records Management is not supported. 
· Data maps for a repository can be selected in Fed Admin (Rule Builder page) only if the repository is selected in "Include Repositories" in the IICE Webclient.  Normally, this occurs by default. In cases where it does not, the user must do the following:
a. Login to the IICE Webclient, navigate to “Manage Workspaces”-> “Repositories”, 
b. Ensure that the repository is selected in the “Include Repositories” list.
c. The repository credentials must be set in the Fed Admin page: General Configuration -> Passwords

· If federation aborts with the following error message, make sure that the REVISION_DATE property and the UNIQUE_ID property defined in the data maps support the equal to or greater than “>=” and less than “<” operators.

ERROR - Unable to execute the query for run id=”<run_id_number>”
Process Engine

	Defect ID
	Description

	748619
	PE Component Manager polling algorythm was changed in the 3.5.2 release, causing performance problems.

Resolution: Install fix pack P8PE-3.5.3-001 or a later release. 

	556206
	Logging on to the Process Engine returns an error: Error 202,100,10 is logged even if the database password is correct.  In some cases the error is also returned to the application and causes the program to fail.  The error is caused by a missing  .fmaint file.  

Workaround: 

1.Logged on as fnsw (or alias), enter the following at the command prompt:

set_f_maint_pw <user_name>

where the <user_name> is f_maint 

2.Enter your current password. (CR = initial default/never changed)

NOTE Pressing Return will only work the first time the password is changed, when the default password is still valid. After the password is changed from the default, you must enter the current password.

3.Enter a new password for the user when prompted. The password must be between 6 and 30 characters. If the database is SQL Server, the first character cannot be numeric, per SQL Server naming conventions. 

4.Confirm the new password when prompted. (Docs Defect 557353)

	215266
	Process Engine 3.5.0b software might have read-only permission set on some files.

Workaround:  Before performing a silent installation of the 3.5.0b version of the software, verify that the following files do not have read-only permission.

Windows:  all files with the .iss extension

UNIX: PE_silent_input.txt, silent_setup.sh (Docs DTS 215267)

	216825
	When upgrading an existing PE 35x (350, 351 or 352) server to PE 353, a special procedure is required to update specific DB2 tables to volatile. 

Workaround:

168. Connect to the database as the f_sw user.

169. Execute this statement:
db2 -x -z /tmp/f_sw.sql "select 'alter table '||tabname||' volatile;' from syscat.tables where tabname like 'VWOBJ%' or tabname like 'VWQUEUE%' or tabname like 'VWROSTER%'"
This above statement generates a file named ‘/tmp/f_sw.sql’ that contains all of the statements that have been changed  -VWOBJECT*, VWQUEUE*, and VWROSTER* will have been changed to volatile.

170. While still connected to the database as f_sw, execute the following statement: 
db2 -tf /tmp/f_sw.sql  

	213386
	Process Engine 3.5.3 on HPUX cannot be uninstalled in silent mode. It can be uninstalled interactively. (Doc DTS  216664)

	151907
	Process Orchestration on Windows with Oracle Application Server is not supported. (Doc DTS  190123)

	180405
	A simulation file generated by Process Simulator fails to persist in the object store.

Workaround: The problem results if a commons-logging.jar file exists in Workplace (/Workplace/WEB-INF/lib). 

To resolve the problem, delete the commons-logging.jar file or move it to another location. (Doc DTS  192537)

	183553
	McAfee Virus Scanner 8 has a default setting to block port 25 to stop Mass Mailing worms. This blocks access to the exchange server and must be disabled or removed before the connection can be restored.
Use the following procedure to fix the problem by disabling the port blocking:

171. Open the VirusScan console.

172. Right-click Access Protection and select Properties.

173. Highlight "Prevent mass mailing worms from sending mail."

174. Click Remove.

175. Click Apply. (Doc DTS  186197)

	155754 173593
	In a High Availability environment with an Oracle rack where there are multiple nodes for the Process Engine database, various access problems can occur as the result of expected data not being available when requested. For example, an Access Violation Exception occurs when creating queues, rosters or event logs from the Process Configuration Console. In other situations, a work object might go the ISI queue instead of the expected queue.

Solution: In an Oracle rack environment with multiple nodes for the PE database, those nodes replicate each other at a user-definable interval set in the Oracle parameter, MAX_COMMIT_PROPAGATION_DELAY. If the value of this parameter is set too high, the expected data might not yet be available when it is requested. The value of MAX_COMMIT_PROPAGATION_DELAY should be set to 0. (Doc DTS  159724 and/or 160782)

	179008
	To run the vwtool and vwlog utilities on a Solaris-based Process Engine server, you must log on as the fnsw user. (Doc DTS 182347)  

	170628
	Some workflow definitions that contain an AND-split with one leg terminating before the AND-join step might encounter an error on transfer to the Process Engine. 

The error message is: 

[Err=d524071] Step: Invalid route release transferring a valid workflow.

Workaround: The issue is related to the evaluation order of the routes from the AND-split step. To resolve the problem in the workflow definition, delete the routes from the AND-split step and recreate them in a different order. It might be necessary to try this more than once to get a transferable workflow definition. (Doc DTS 173868)

	164585
	JBoss 4.0.2 is required to run Process Orchestration or Component Integrator. Due to class loading limitations in JBoss 4.0.1, to use Process Orchestrator or Component Integrator, you must install Application Engine on JBoss 4.0.2. (Doc DTS 164764)

	155754
	An Access Violation Exception occurs when creating queues, rosters or event logs from the Process Configuration Console. 

Solution: In a High Availability environment with an Oracle rack where there are multiple nodes for the Process Engine database, those nodes will replicate each other. An Oracle parameter, MAX_COMMIT_PROPAGATION_DELAY, provides a delay mechanism. 

If the value of this parameter is set too high, the expected data might not yet be available when it is requested. The value of MAX_COMMIT_PROPAGATION_DELAY should be set to 1. (Doc DTS  159724 and/or 160782)

	155361
	Process Orchestration Requires Configuration Modification. The workaround is to manually copy the commons-logging.jar to Workplace/WEB-INF/lib or Workplace\WEB-INF\lib. (Doc DTS 155566)

	151882
	Problem: When Process Engine is running on a Sun Java Application Server, Process Orchestration can encounter a security exception. 
Workaround: Add the following to server.policy:

/* needed for FileNet */

grant codeBase "<file:${com.sun.aas.instanceRoot}/applications/j2ee-modules/Workplace/WEB-INF/->" {




permission java.security.AllPermission;



}; (Doc DTS 155561)

	151379
	On any machine where you have collocated Content Engine and Process Engine, perform the following workaround to manually fix the security settings of the Image Services Toolkit (ISTK) if you are using Content Federation Services Server for Image Services (CFS-IS). Otherwise, you will not be able to create a fixed content device on an IS server.

176. Select c:\fnsw\client\bin and c:\fnsw\client\shobj.

177. Right-click and choose Properties.

178. Click the Security tab.

179. Add Everyone to the Name list, and grant Full Control in the Permissions list. Then click OK.

180. Stop all Content Engine services: Content Cache Service, File Store Service, and Object Store Service.

181. Restart Content Cache Service, File Store Service, and Object Store Service, in that order, to reload the new ISTK security settings. Doc DTS 153622)

	143556
	Following the installation of the Process Engine, FileNet recommends that you change the f_maint password. The password must be between 6 and 30 characters. If the database is MS SQL Server, the password must start with an alpha character, not numeric.

	122031
	Process Task Manager becomes corrupted when logged in as a user with a Japanese Locale. This only occurs on a Process Engine on an HP UNIX server.

To resolve this issue, do the following:

182. Install JRE 1.4.2. from the HP website.

183. Update the /fnsw/bin/vwtaskman script to point to the installed JRE. The following example highlights the change assuming you have installed the JRE in the default location.

if [ 'HP-UX' = `uname` ]

then

/opt/java1.4/bin/java -pa11 -cp VWJAVA:VWTASK:/fnsw/bin/pe.jar:/fnsw/bin/pe3pt.jar:
/fnsw/bin/peResources.jar:/fnsw/jre/lib -DTaskManager.Properties=/fnsw/bin/taskman.properties filenet.vw.apps.taskman.VWTaskApplication $* &

184. Add the following to the /fnsw/bin/taskman.properties file:

TaskManager.PPM.JRE=/fnsw/jre/bin
TaskManager.Router.JRE=/fnsw/jre/bin
TaskManager.RulesEngine.JRE=/fnsw/jre/bin

	118788
	The names "SysAdminG" and "SysConfigG" are reserved for special internal use on the Process Engine. Use of either one as a short name for a group can have unintended results for your workflow system.

When the Process Engine encounters SysAdminG or SysConfigG in the context of a group, it automatically checks the Process Service properties (set via the Process Task Manager) for the LDAP group mapped to the Process Engine Administrators Group or the Process Engine Configuration Group, respectively, and uses the mapped group for further processing.

This affects the following:

· Any API that passes the LDAP short name as an input parameter

· Workflow roster, queue, and event log security 

· Workflow participants

For example, consider this example (using the Active Directory).

The following groups are defined in the Directory Service:

· cn=SysAdminG,dc=filenet,dc=com

This group has a member named JohnSmith


· cn=SysConfigG,dc=filenet,dc=com

This group has a member named MaryJohnson


· cn=PESysAdminG,dc=filenet,dc=com

This group has a member named JaneDoe


· cn=PESysConfigG,dc=filenet,dc=com

This group has a member named SarahJones


The Process Task Manager maps the following:

· Process Engine Administrators Group (internal name SysAdminG): cn=PESysAdminG,dc=filenet,dc=com

· Process Engine Configuration Group (internal name SysConfigG):
cn=PESysConfigG,dc=filenet,dc=com

The results:

· Workflow steps assigned to SysAdminG (JohnSmith) will instead be routed to members of the PESysAdminG group (JaneDoe).

· A queue that is restricted in access to members of SysConfigG (MaryJohnson) will instead allow access to members of the group PESysConfigG (SarahJones).

Executing the method IsMemberOf("SysAdminG") for JohnSmith will return FALSE instead of TRUE. Executing the method IsMemberOf ("SysAdminG") for JaneDoe will return TRUE instead of FALSE. (TIP To see if JohnSmith is a member of group cn=SysAdminG,dc=filenet,dc=com, provide the full dn to the API.)

	103610
	Hummingbird's Exceed onDemand product does not work with Process Engine on AIX. FileNet Engineering has successfully used Hummingbird's Exceed and WRQ's Reflection X products.

	95060
	The Scheduler tab for the Process Analyzer node uses a non-globalized time format. The Time separator is hard coded and the time is only selectable in 12 hour time with an a.m./p.m. selector.


Process Designer

	Defect ID
	Description

	204022
	Stored procedures executed using the dbexecute system instruction only accept OUTPUT parameters (or no parameters) on MSSQL. INPUT parameters are not supported.

	200847
	The getDescription() of VWParameter class inconsistently returns null, even though there is a description. In the Help for Process Designer, the topic "Workflow Properties dialog - data fields" should have the following note after the instructions for entering the description of the data field:

NOTE Text you enter for the description will display when you select the data field as a parameter for a step in the workflow. You can change the description of each parameter at each step. The description that displays for a step parameter is the description that exists when you select that data field as a parameter for the step. If you subsequently change the description for a data field in the Workflow Properties dialog box, the description does not change at each step where the data field is used as a parameter. (To update the description at the step, you must remove the parameter and re-add it.)

	161698
	When defining a Partner Link, if the computer where the WSDL is located requires a network logon, the logon screen cannot be closed. Use the Windows Task Manager to stop the Internet Explorer browser. This behavior occurs with JRE 1.5.0_04; it does not occur with JRE 1.4.2_06. (Doc DTS 161810)


Process Engine Web Services

	Defect ID
	Description

	187384
	When defining web services schemas, a schema file stored on the Process Engine server must not reference another file stored on the server. (DTS 187384)

	169686
	An Invoke system function in a FileNet workflow is not designed to pass credentials to a web server that requires authentication for access. The web service must be deployed on a web server that allows anonymous access.

	147422
	In the Linux/JBoss 4.0.0 environment, Web Services functions (Invoke, Receive, and Reply) receive soapExceptions.

	104116
	When the Component Manager is running as a custom service in WebSphere, it throws java.lang.ClassCastException as a fault when executing an Invoke system function.


Application Engine

	Defect ID
	Description

	197405
	When you install Application Engine 3.5.0 fix packs for WebLogic, do not choose the "pre-compiled JSPs” option when you deploy the associated .war file. (Doc DTS197405 – see also 103726)

	190437
	After applying FileNet Fix Pack P8AE 3.5.1-004, users are unable to create/modify doc entry templates.

	185299
	Open port 32771 to make the Process Task Manager on Solaris open more quickly and prevent an error.
The PPM and routers default to port 32771. When Solaris starts up, it takes the first several ports, called anon ports, to use for its communication daemons. By default, the maximum tcp_smallest_anon_port is 32768. To use this port on Solaris-based systems, you must first enable the port by setting the smallest anon port to 32772. By doing so, the ports used by Solaris communication daemons will be 32772 or greater, leaving 32771 available for the Process Engine.
Alternatively, you can use any other port that is available for the RMI-based processes. The Solaris platform provides several different tools such as the netstat command to determine if a port is in use.
To determine the current tcp_smallest_anon_port setting, enter the following at the command prompt:
ndd -get /dev/tcp tcp_smallest_anon_port 
If the port is less than 32772, you must enable port 32771.

To enable port 32771 on Solaris, use a text editor to edit the /etc/rc2.d/S69inet file.

Enter the following line:
ndd -set /dev/tcp tcp_smallest_anon_port 32772 
Reboot the Application Engine server.

	183554
	McAfee Virus Scanner 8 has a default setting to block port 25 to stop Mass Mailing worms.  This blocks access to the exchange server and must be disabled or removed before the connection can be restored.

	164706
	When the Security Policy on the Active Directory (AD) server is configured with an “Account lockout threshold” of three, two successful logons to Workplace AppInt via Word cause the user account to be locked out in AD.  The account lockout does not prevent the user from logging on to Workplace AppInt, but the domain account is locked and must be unlocked by the Administrator. (Doc DTS 166088)

	155399
	To make the Component Integrator support Oracle Application Server JMS queues you must configure your setup according to the following procedures. (Doc DTS 155567) 
NOTE The following procedures contain folder data for both UNIX and Windows. If there is no difference in folder structure, a forward slash (/) will be used to denote the next folder, for both UNIX and Windows.

185. Log on to the Oracle server.

UNIX – Log on as an Oracle Administrative User.

Windows – Log on as a user with administrative rights.

186. Create a JMS Queue connection factory and JMS Queue. On the Oracle server, create a JMS Queue Connection Factory and a JMS queue for the Workplace OC4J instance. Note the following data:

· JMS Queue connection factory name: <JMS queue factory name>
· JMS Queue connection factory location: <JMS queue factory location>
· Workplace OC4J instance name: <Workplace>
· JMS Queue name: <JMS queue name>
· JMS Queue location: <JMS queue location>
187. Create a principal user to access the JMS queue.  

a. Give the Oracle principal user the same name, <Oracle user>, and password, <Oracle password>, as the JAAS user used to start the Process Engine component queue. 

b. Add the user to the jazn.com/administrators group.

188. Create a <JMS configuration> directory with a META-INF subdirectory.
Create a directory to hold the jndi.properties file and the application-client.xml file. You will add this directory to the Component Manager classpath at a later step.

189. Add the application-client.xml file

Create the following file:

<JMS configuration>/META-INF/application-client.xml

The application-client.xml file should have the following minimal content:

<?xml version="1.0"?>

<!DOCTYPE application-client PUBLIC "-//Sun Microsystems, Inc.//DTD J2EE Application Client 1.2//EN" "http://java.sun.com/j2ee/dtds/application-client_1_3.dtd">

<application-client>

<resource-ref>

<res-ref-name>jms/<JMS queue factory name></res-ref-name>

<res-type>javax.jms.QueueConnectionFactory</res-type>

<res-auth>Container</res-auth>

</resource-ref>

<resource-ref>

<res-ref-name>jms/<JMS queue name></res-ref-name>

<res-type>javax.jms.Queue</res-type>

<res-auth>Container</res-auth>

</resource-ref>

</application-client>

190. Create the jndi.properties.

Create the following file:

<JMS configuration>/jndi.properties

The jndi.properties file should have the following minimal content:

java.naming.factory.initial=com.evermind.server.ApplicationClientInitialContextFactory

java.naming.provider.url=opmn:ormi://localhost:<Request port>:<Workplace>
java.naming.security.principal=<Oracle user>
java.naming.security.credentials=<Oracle password>
Where 

<Workplace> is the name of the OC4J instance where the queue is created.

<Request port> is the request port number, which can be found in:

<OAS_HOME>/opmn/conf/opmn.xml
Example: A fragment of this file is shown below with the request port entry highlighted:

<opmn xmlns="http://www.oracle.com/ias-instance">

<notification-server>

<port local="6100" remote="6200" request="6003"/>

<log-file path="$ORACLE_HOME\opmn\logs\ons.log" level="4" rotation-size="1500000"/>
191. Restart the Workplace OC4J instance.

192. Log in to Workplace as a user with access to the Admin tab. 

193. From Workplace, configure the JMS component queue using the Process Configuration Console. 

Define the queue factory and queue in the JMS Queue's adaptor properties as follows:

java:comp/env/jms/<JMS queue factory name>

java:comp/env/jms/<JMS queue name>
194. Configure the Component Manager.

From AE Task Manager, enter the following in the Advanced tab of Component Manager:

For JNDI Initial Context Factory, enter:

com.evermind.server.ApplicationClientInitialContextFactory

For JRE parameters, enter: 

      opmn:ormi://localhost:<Request port>:<Workplace>


NOTE These are the same values used in jndi.properties for java.naming.factory.initial and java.naming.provider.url above.

195. Add required libraries to Component Manager.

From AE Task Manager, add the following jar files in the "Required Libraries" tab of the Component Manager:

<OAS_HOME>/j2ee/home/oc4j.jar

<OAS_HOME>/j2ee/home/oc4jclient.jar

<OAS_HOME>/j2ee/home/lib/jms.jar

<OAS_HOME>/j2ee/home/lib/jndi.jar
<JMS configuration>

Where: 

<OAS_HOME>

is the installed directory for Oracle Application Server.

NOTE  (Custom applications only) Include the custom application .jar file for the custom application.  

	152229
	Application Engine cannot be deployed to the Oracle Application Server version 10.1.2 on HPUX. This configuration is not currently supported. (Doc DTS 155859)

	150610
	Using the ISRA Servlet for the retrieval of IS documents in an Oracle Application Server Farm is supported only if you use a common UT cryptokey file across all application instances. (Doc DTS 155851)

	145992
	When installing Application Engine to a non-default path  that includes an exclamation point (!), the Process Task Manager does not display any icons or buttons for controlling or showing the status of the routers.

	145011
	FileNet strongly recommends against renaming an existing object store. Doing so can break bookmarks, entry templates, and other functions in the Application Engine application. (Doc DTS 159672)  

	122031
	Process Task Manager becomes corrupted when logged in as a user with a Japanese Locale. This only occurs on an Application Engine on an HP UNIX server. 

To resolve this issue, do the following:

196. Install JRE 1.4.2. from the HP website.

197. Modify routercmd.sh (located in the Workplace directory). The following example highlights the change assuming you have installed the JRE in the default location.

/opt/java1.4/bin/java -cp "${router_home}/pe.jar:${router_home}/peResources.jar:${router_home}/mailapi.jar:${xerces_home}/xml-apis.jar:${xerces_home}/xercesImpl.jar:${router_home}/axis.jar:${router_home}/wsdl4j.jar:${router_home}/commons-discovery.jar:${router_home}/commons-logging.jar:${router_home}/jaxrpc.jar:${router_home}/saaj.jar:${router_home}/uddi4j.jar"  -DTaskManager.Properties=${install_home}/FileNet/Router/taskman.properties filenet.vw.apps.taskman.VWTaskApplication $*

	118268
	On a Windows Application Engine installation, if FileNet software is installed in a directory that contains a space in its name (for example: the "Program Files" directory), the Console output for the Component Manager does not work.

Workaround:

Add the following line in the taskman.properties file on the Application Engine server to enable the console output: 

· TaskManager.DisableDynamicClassLoading=true

· The location of the file is <App_Engine_install_path>\FileNet\Router\.

After modifying the file, if the Component Manager is running, restart it.

	103726
	When you install Application Engine 3.5.0 fix packs for IBM WebSphere, do not choose the "pre-compiled JSPs” option when you deploy the associated .war file.

	102502
	If the Application Engine has been configured with Image Services as an external service, but ISRA has not been configured, end users will receive a server error message when attempting to open a document in the IS libary from Workplace. "Error 500--Internal Server Error" is displayed. Resolve the issue by configuring ISRA.

	97864
	In WebLogic environments, using Process Orchestration UDDI related features can prevent a user from logging on to the WebLogic UDDI explorer.  The solution is to add -Dweblogic.webservice.i18n.charset=UTF-8 to the java command arguments of WebLogic.

	94040
	Rendition Services cannot publish documents to XMethods, a private UDDI registry.


Workplace

	Defect ID
	Description

	744396
	In Workplace, if you have documents that contain extended characters such as umlauts, the original file names become corrupted when selecting multiple files to download into a .zip file. This is a known issue Sun JRE. (Doc Defect  747230)

	387552
	In Workplace, if you are using Internet Explorer 7.0, you may get a dialog box "The webpage you are viewing is trying to close the window? Do you want to close this window?" when you are attempting to close an Internet Explorer window.  This is a new security feature for Internet Explorer 7.0 and there isn't a way to disable this dialog.  Click OK and continue working. (Doc Defect  742691)

	212515
	An error occurs when an Excel document containing PivotTables is opened directly from Workplace. This problem is caused by a Microsoft known issue. The Microsoft case number is SRX070823600677 and the Knowledge Base reference is 831929. Work around this error by downloading the document and saving it locally. (Doc DTS 215976

	211320
	When running Workplace on Windows Vista and File Tracker is enabled, an error message appears when adding a document and selecting the Delete Local File option. In addition, the document is not added to an object store and the local file of the document is not deleted. 
Workaround: 

198. In IE, go to Tools > Internet Options.

199. Click the Security tab.

200. Click Trusted Sites and add the Application Engine(s) to the list of trusted sites.(Doc DTS 211683) 

	211151
	JRE 1.6 on a client machine causes an error message to appear when using the Image Viewer.  Image Viewer functionality is not affected after dismissing the error message. (Doc DTS 211155)

	201537
	Process Tracker displays only the default subject even when a different value is assigned to the F_Subject field after completion at the Launch step. (Doc DTS 201958)

	197474
	Using Workplace you cannot add documents larger than 2 Gb to Content Engine object stores.(Doc DTS 198949)

	186345
	If you are adding a document using an entry template and it is configured to show all steps, the Set Properties and Set Security steps are missing if you modify the entry template by opening it and then clicking Finish.

The workaround to be able to view all four steps is to modify the entry template, but click Next for all subsequent steps without making any changes. (Doc DTS 186346)

	184357
	Process Engine related Applets launched from Workplace and opened via Firefox cannot connect to the Process Engine. (Doc DTS 185919) 

	173878
	MS Word 2003 may prevent the FileNet P8 menus for Workplace Application Integration from appearing. The workaround is to do the following:

201. Open MS Word.

202. From the Help menu, select About, and then click Disabled Items. An App Int dll appears.

203. Click Enable, and then close MS Word. Re-open MS Word and the FileNet P8 menus appear.

	163752
	If you add the ID property to Search Preferences and then run a search that returns many results, the results are NOT sorted by GUID. (Doc DTS 177437)

	174578
	The Annotation security dialog box is not properly displayed when a user tries to add a new user to an annotation. This occurs in a full session SSL environment. (Doc DTS 174580)

	174518
	When using command ID 2120 (Select object from Tree View Control) in the Workplace Integration Servlet, documents that are In Process or a major version with subsequent minor versions should display in the tree view but do not. (Doc DTS 174581)  

	174490
	When the optional Records Manager add-on is installed, a Records Manager administrator will see the Admin Tools and Site Preferences links even though the user does not have appropriate access rights. When the preferences file is saved in a file plan object store (from the Site Preferences > Bootstrap > Preference object store setting), then an RM Admin user can see the Admin tab and the Site Preferences link even though the RM Admin user is not part of the Application Administrator role. Clicking on the Site Preferences link will display an error message and the user cannot edit the preference settings. (Doc DTS 174609)

	173649
	In Image Viewer, an inherited user is not listed in the Annotations security dialog box when a direct user adds a new annotation. To view the inherited user, close Image Viewer, and then re-open the document. (Doc DTS 174068)

	173439
	If the P8AE-3.5.1-002 fix pack is installed and you are using the Image Viewer, an "access denied" error message appears when a user with View Content adds a new annotation. The error message should be rewritten to describe the user does not have sufficient permission to perform the operation. (Doc DTS 174127)

	173164
	When Microsoft Word is used as the email editor in Outlook, unexpected results occur when closing an email. (Doc DTS 174267)

	172887
	The Site Preferences topic "Actions preferences" indicates that the tool tips for an action can be used to distinguish between actions registered with the same name. There currently are two "Download" actions listed, and the tool tips are the same for both actions. (Doc DTS 174125)

	172410
	When setting a value for an object type property, where the value is a folder or custom object, Browse in Workplace does not filter the specified class. If users select a value from a class other than the specified class for the object type property, an error occurs. To fix the problem, Workplace should only show the custom objects or folders of the specified class. (Doc DTS 172784)

	170547
	MS Word takes 3-5 seconds to close after performing a close command. This occurs after integrating MS Word with Workplace via Workplace Application Integration. (Doc DTS 171708)

	163799
	For WebLogic 8.1 SP4 on Redhat Linux AS 3.0 Update 3, a nested ‘TokenStreamException’ error occurs after you click the Author link in Workplace. 

To fix this problem, do the following on your WebLogic server:

204. On your WebLogic server, open weblogic.xml for editing.

205. Add the following below the <jsp-descriptor> line:

<jsp-param>
      
<param-name>
           
encoding
         </param-name>
         <param-value>
      
         ISO8859_1
         </param-value>
</jsp-param>

206. Save weblogic.xml.

207. Restart WebLogic. (Doc DTS 164477)

	163663
	A java.lang.IllegalStateException error occurs when you access an object store's Get Info page, and then click My Workplace. The workaround is to select My Workplace again to refresh.

In Enterprise Manager, after changing a user's Pre-Windows 2000 ID (in Microsoft Active Directory), the user gets a series of errors and then the security tab displays "?" where account names should be displayed. In Workplace, the user cannot search for accounts and, after the cache expires, the user is unable to sign in again. The cause of the problem is a Microsoft bug that was fixed in Windows 2000 SP4 but appears to be a regression in Windows 2003 SP1 (http://support.microsoft.com/default.aspx?scid=kb;en-us;329420). 

Description: In EM, After changing a user's pre-windows 2000 ID (MS AD), the user gets a series of errors and then the security tab displays with a “?” where account names should display.

From Workplace, the user cannot search for accounts and after the cache expires, the user is unable to sign in again.

The cause of the problem is a Microsoft bug. It was fixed in Windows 2000 SP4 but appears to be a regression in Windows 2003 SP1.

The workaround is to reboot the cat client machine, which in most cases will be the Apache/CE server.  (Doc DTS 164289)

	163476
	In My Workplace, if you remove a public queue or if a user no longer has access to it you get a stack trace while editing the Public Inbox. It occurs when you click the Public Inbox link inside the Edit portlet. (Doc DTS 163563)

	161019
	To open Visio documents, you must edit content_redir.properties file. 
Solution: add the following line to content_redir.properties file:
 application/vnd.visio=/getContent?{QUERY_STRING}&mode=download(Doc DTS 162956)

	160942
	In the Workplace documentation (Workplace > Work with User Preferences > Search Settings > Document Search Criteria), the last sentence of Step 6 should be corrected as follows: The properties available depend upon the Object Store selected in the Search In setting. (DTS 160941)

	160682
	Annotations are not being persisted correctly using ISRA 3.1 Patch 22 and Workplace.

To work around this issue, include the following parameter in the Daeja applet parameters section: <param NAME="addEscapeCharactersToXML" value="true">(Doc DTS 160680)

	158212
	If you use the FileNet Enterprise Manager to export a Form Data Entry Template from one Object store and import the template into another object store, the template will use the original object store name and you cannot edit the object store name in the Entry Template wizard.

	156523
	When the Records Manager add-on is installed, Workplace may display a blank page intermittently in Windows 2000 Advanced Server SP4 with WebLogic 7.0, SP4. When you perform actions such as defining a record entry template, adding a document, declaring a record, or other actions, a blank browser page may be displayed at random. (Doc DTS 158045)  

	155308
	The Publish Wizard fails to publish a document that contains & or < characters in the title. If you set the name of the document in the Publish Wizard and include either the & or < character in the Title for the published document, the document is not published. However, if the Title field is left blank in the wizard and the selected document contains these characters, the document will be published properly. (Doc DTS 149299)  

	155078
	Having duplicate choice list values for choice items in different groups of a choice list causes display problems in Workplace's MySearch. For example, if you create a choice list with multiple groups (Boat Color, Car Color, Plane Color) and have duplicate choice list values within different groups, (all three groups have choices whose values are Red, Blue, Yellow), you will find that only the item (Red), and not the group->item combination (Boat Color>Red), is listed in the pull-down in MySearch. This problem also affects searches: all selections below the duplicated choice list value will be one off when you try and search, producing inaccurate results (the first of the duplicate items in the list will return all objects with that final value). 

The fix pack listed at the end of this paragraph fixes the Workplace display problem: the dropdown will display the group>item combination, but the value is still just red or a duplicate of the other value; also the search will return correct values as expected. The Choice List chapter of Content Engine Help has been updated explains the issue and recommends that you ensure uniqueness of item values within the same Choice List. This issue will be fix in an upcoming fix pack.  (Doc DTS 155307)

	155034
	You cannot start the Component Integrator on Sun AE, Sun Java System Application Server with JRE 1.4.2_08 and 1.5_02.

Workaround: Copy cacerts to /var/temp for Unix AE or \windows\temp for Windows AE.

Before starting the Component Integrator, copy:

<AE_install_path>/FileNet/Router/JRE/lib/security/cacerts
to:
/var/temp (UNIX)
C:\WinNT\temp (Windows 2000)
C:\Windows\temp (Windows 2003)     (Doc DTS 155563)

	153877
	There is a problem with the Quick Search portlet results document title link for minor documents that have a released major version. Clicking the document title in the search results opens the released version of the document in a new window instead of opening the minor version.

Workaround:

208. Click Get info next to the document title to open the Information page.

209. Select Versions view.

210. Click the document title for the current minor version to open the document in a new window. (Doc DTS 154085)

	153441
	There is a known longevity issue with Sun One Java Application Server. This issue is believed to be related to the version of the Sun JRE included with Sun One Java Application Server version 10.1.2. A support case is being pursued with Sun Microsystems.

There is also a known scalability issue with Sun One Java Application Server version 10.1.2. FileNet Workplace scales about 40% lower on the Windows Sun One Java Application Server Platform Edition compared to other J2EE application servers.  A support case is being pursued with Sun Microsystems to investigating potential tuning opportunities. (Doc DTS 155441)

	152933
	There is a problem with using a UNC path for assigning an attachment to a Task with Netscape 7.2. The document cannot be opened by clicking on the name link in the Task. Refer to the Netscape documentation for security and the Netscape ‘security.checkloaduri’ settings.

	152796
	Applets from Workplace do not open when using the Apache 1.3.33 or Sun Java Web Server proxy plug-ins. (Doc DTS 155862)

	152633
	When running Workplace under full SSL, adding a document from the Browse page in Workplace results in a "page not found" error after selection of the document to add (from the local machine). If you select the local document to add from the default location the document will add successfully.

	147743
	The Site Preferences Refresh page is missing the Apply button. 

Workaround: After clicking the appropriate Refresh button, click General in the left pane to go to the General Preferences page. Click Apply, and then click Exit.

	147394
	You cannot delete items in the Tracker queue from Workplace.

Workaround: Use the Process Tracker application to delete the tracker item.

	146727
	If your site is configured with multiple Application Engines using the same Site Preferences file, changes to the Site Preferences on one system may take as long as 20 minutes to propagate to the remaining Application Engines. Site Preference files are automatically refreshed every 20 minutes.

	146503
	When selecting a profile during an add procedure, online help doesn't appear after clicking the help link, closing the help page, and then re-opening the help page again. The workaround is to close the Select Profile page. Re-open the Select Profile page, and then click the help link.

	146476
	Sign-in to Workplace fails using special character users with SSL sign-in redirection and eDirectory as an Authentication server.

When FileNet P8 3.5.0 Workplace uses SSL sign-in redirection and Novell eDirectory as the authentication provider, attempts to log on to Workplace with a user name containing special characters such as & (ampersand) and € (Euro character) will fail with an error message indicating that the username is invalid.

	145444
	When the Admin link is set to “hidden” for Everyone under Primary Views, accounts granted access to the PWAdministrators and PWConfiguration access roles can still see and use the Admin link

	143763
	For the Send Mail action, extended characters are not supported in the Subject field, and some extended characters will not display correctly in the email body. Support for extended characters depends on the mail server.

	143428
	Although the Content Engine and Enterprise Manager support a single property template being assigned as a property to more than one document class and then that custom property being assigned different choice lists, Search Designer and My Search in Workplace do not support that functionality. Users will be given the first choice list the program finds which may not be the correct one in Search Designer and My Search in Workplace. The preferred workaround is to assign only one choice list to a single property template. 

A secondary workaround is to edit the Content.xml and UIContent.xml files of the stored template so that the template contains the correct choice list GUID.

To edit these files:

211. Verify that the document class referenced by the stored template contains the property template to which you want to apply the choice list.  

212. Check out both Content.xml and UIContent.xml together from FileNet Enterprise Manager.  

213. Update the "choiceId" field in both Content.xml and UIContent.xml with the choice list GUID that you want to apply to the property template.

214. Check in both Content.xml and UIContent.xml together from FileNet Enterprise Manager using the MIME type "application/x-filenet-searchtemplate".

215. Close and re-start your Workplace session to update the stored templates.

CAUTION: Incorrectly updating the Content.xml or UIContent.xml may cause the stored template to stop functioning.  

This workaround only assigns one choice per property template, and cannot be used to reconcile choice lists assigned through multiple document classes. (Doc DTS 195925)

	118788
	The names "SysAdminG" and "SysConfigG" are reserved for special internal use on the Process Engine. Use of either one as a short name for a group can have unintended results for your workflow system.

When the Process Engine encounters SysAdminG or SysConfigG in the context of a group, it automatically checks the Process Service properties (set via the Process Task Manager) for the LDAP group mapped to the Process Engine Administrators Group or the Process Engine Configuration Group, respectively, and uses the mapped group for further processing.

This affects the following:

· Any API that passes the LDAP short name as an input parameter

· Workflow roster, queue, and event log security 

· Workflow participants

Consider this example (using the Active Directory).

The following groups are defined in the Directory Service:



cn=SysAdminG,dc=filenet,dc=com




This group has a member named JohnSmith



cn=SysConfigG,dc=filenet,dc=com




This group has a member named MaryJohnson



cn=PESysAdminG,dc=filenet,dc=com




This group has a member named JaneDoe



cn=PESysConfigG,dc=filenet,dc=com




This group has a member named SarahJones

The Process Task Manager maps the following:



Process Engine Administrators Group (internal name SysAdminG): cn=PESysAdminG,dc=filenet,dc=com



Process Engine Configuration Group (internal name SysConfigG): cn=PESysConfigG,dc=filenet,dc=com

The results:

· Workflow steps assigned to SysAdminG (JohnSmith) will instead be routed to members of the PESysAdminG group (JaneDoe).

· A queue that is restricted in access to members of SysConfigG (MaryJohnson) will instead allow access to members of the group PESysConfigG (SarahJones)

Executing the method IsMemberOf("SysAdminG") for JohnSmith will return FALSE instead of TRUE. Executing the method IsMemberOf ("SysAdminG") for JaneDoe will return TRUE instead of FALSE. (TIP To see if JohnSmith is a member of group cn=SysAdminG,dc=filenet,dc=com, provide the full dn to the API.)

	101496
	If you configure My Workplace to use the Inbox, My Workflows, or Public Inbox portlets, and the Process Router is not currently running or it is improperly configured, users see display errors when opening the My Workplace page.

Workaround: The administrator should check the Process Router configuration. The end user (personal pages) or the administrator (group pages) can redefine the My Workplace page to remove the portlets until the Process Router is properly configured and running.

	95476
	Workplace includes the IntegrationServlet to give custom applications access to reusable Workplace JSP pages. Command 2010 of the IntegrationServlet invokes the Select Object page. In the "My Search" view of the page, the "Filter by Class" option is not displayed when the page is loaded, even if the "hideMySearchFilterClass" parameter in command 2010 is set to false.  The search is correctly filtered for the specified class.

	73745
	In an SSL environment, while using Java applets, such as the Process Designer or Search Designer, you may experience an SSLHandshakeException because the appropriate certificate does not exist on the client computer.

Workaround: Use the following procedure to download the certificate and import it into the Java Plug-in keystore.

216. Download the certificate:

a. In an SSL environment, using Microsoft Internet Explorer (not Netscape), open Workplace.

b. At the Security Alert dialog, click View Certificate. On the Details page, click Copy to File, and then follow the Certificate Export Wizard using default settings to export the certificate to a file, such as c:\temp\cypher.cer.

217. Import the certificate into the Plug-in keystore:

a. Locate the Plug-in trust keystore file. For example, ...\jre\lib\security\cacerts (no extension).

b. Run keytool.exe from the JRE \bin directory by entering the following at the command line:
c:\Program Files\Java\j2re1.4.2\lib\security> ..\..\bin\keytool -import -file "c:\temp\cypher.cer" -alias cyphercer -keystore cacerts -storepass changeit

NOTE You must specify the storepass—the keystore password. The default is changeit.
At this point you should be able to run the Java applets without SSLHandshakeException. 

If you use the Plug-in Console, you might see DownloadException with a calling stack when you run the Java applets, even though the program continues to run normally. The workaround for this is to open the Java Plug-in in the Control Panel, and disable cache.

	73197
	In a running workflow, when a step that specifies a rule is completed, if the Rules Engine is not available to process the rule, the work item might not advance correctly to the next step after the Rules Engine becomes available.  

Workaround: Re-process the work item from the User queue after Rules Engine is available.

	NA
	If you are downloading a workflow definition file (*.pep), Internet Explorer supplies an incorrect file type and extension. IE appends .xml to the filename, which is incorrect. Change the file's extension to .pep - for example, ApprovalWorkflow.pep.


Content Federation Services (for CS and NTFS)
	Defect ID
	Description

	
	

	
	

	556078
	Federated TIFF image documents are not displayed in the Workplace Image Viewer. A Save dialog box is displayed instead.

During federation, the TIFF image was stored in the Content Engine with the mime type image/tif instead of image/tiff.

Workaround: Edit the content_redir.propeties and icon.properties files on the Application Engine to add the images/tif mime type. See the topic “content_redir.properties file” in the P8 Help: Application Engine Administration > Key configuration files and logs > content_redir.properties file for more information on editing the file. 

218. Add the following entries to the content_redir.properties file:
image/tiff=/WcmJavaViewer.jsp?{QUERY_STRING} 

image/tif=/WcmJavaViewer.jsp?{QUERY_STRING} 

219. Add the following entries to the icons.properties file:

image/tiff=images/mime/Tif 

image/tif=images/mime/Tif

	555984     
	For Documentum, CFS supports federation of document items only. Workflow items are not federated.

	393041
	If you disable a failed rule and then attempt to export a new rule, the following error message is displayed: COEC0551E: The session pool was not closed prior to garbage collection.

Workaround: Keep the session timeouts long enough for the query so that neither the Java beans nor the session pool times out. (Docs Defect  757015)

	389260
	The Federation Administrator application and the IICE Web Client searches use different values for boolean values than IDM Find. Content Services does not support boolean property values and uses 1 for Yes and 0 for No. 

Workaround: Do not use "true", "false", "yes", or "no" in your search criteria for the Rule Builder page. Use 1 or 0 instead.

	386685
	An archived Content Services document is displayed instead of an error message.

Work around: After you archive a document in CS, log off from IDM Desktop before you attempt to view the document in Content Engine. (Docs Defect  393293)

	386592
	You can not refederate the mime type or the filename properties. All other properties can be re-federated.

If a federated document has the incorrect mime type, do the following: 

1. Use Enterprise Manager to change the FCD's DeletePassThrough value to 0.

2.Restart Content Engine Services.

3. Delete the federated documents with incorrect mime types from Content Engine. 

4. Refederate the documents. 

5. Change the FCD's DeletePassThrough to its original value. (Docs Defect  393293)

	382437
	In the Rule Builder page of the Federator Administration application, a query that contains no property criteria and no full-text criteria returns 0 results and throws the exception "No property or full text criteria in query" when you click Get Count. This is the known issue of IICE 8.3 Web Component.

Workaround: Do not click Get Count when you create a query that contains no property criteria and no full-text criteria. These types of rules are saved when you click Apply. When the rule is run, the correct number of documents will be federated.

	379198
	When using the WebSphere Information Integrator Content Edition Version 8.3 session pool in WebSphere Application Server 6.0.1, and following a successful run of CFS Exporter, the following exception may be returned:

com.ibm.ws.naming.java.javaURLContextFactory

SEVERE: javaAccessorNotSet 

This issue is known by IBM (technote reference #1229781). The cause is an anomaly from running in a WebSphere 6.x environment. This error has no impact on the functionality of the session pool and can be safely ignored. (Docs Defect  382287) 

	211255
	A java.lang.NullPointerException error is returned when logging on via WSAPI to IICE 8.3 FP2 that is deployed on WebLogic 9.2. (Docs DTS 211266)

	209717
	The Rule Builder page returns an exception on WebLogic consoles. To work around this issue, deploy the FedAdmin web application in a war file. (Docs DTS 209845)

	208987
	If a folder item meets the search criteria of a CFS Rule, the folder item will be federated and will be visible through P8 applications such as Workplace. To prevent folder items from being federated, ensure that folder items do not use the same item type as content items.. (Docs DTS 208990)

	208449
	For repositories where soft-delete is supported, CFS does not immediately delete the source documents permanently. Please refer to the source repository administrator’s guide for deleting the documents permanently.

	208448
	For repositories where soft-deleted documents may be returned in search results, CFS will federate these soft-deleted documents if they meet the search criteria of a rule.  The native content for these documents will be viewable in P8 as long as the content is retrievable from the repository.  When the soft-deleted documents are permanently removed from the repository, the native content of the documents will not be viewable..

	207415
	The “Max results” text field in the Rule Builder page does not work for OnDemand.  By default, OnDemand will retrieve a maximum of 200 results.  If a query results in more than 200 results, edit the arswww.ini file by changing the MaxHits parameter value to 0.  Setting the value to 0 means that it will retrieve all the query results.  The arswww.ini file is located in the same directory where the Web enablement kit is installed.

	207332
	Records Manager is not supported with OnDemand. Although it is possible to declare the federated OnDemand documents as records from Workplace, the security settings in the source documents that reside on the OnDemand server do not get updated because OnDemand does not support updating security settings.

	207331
	Intermittently the Importer hangs and prevents content being federated. When this occurs, restart the Content Engine services to workaround the issue.

	207330
	Date time values are not imported correctly by CFS if there is an incompatibility in the integer variant type. For example, if the Exporter is running on a Unix system and the Importer is running a Windows 2000 system, the Exporter generates DateTime as a 64-bit integer, but the Importer expects integers to be 32-bit. If the Content Engine is running on a Windows 2000 system, then integers are only 32-bit. To avoid this issue, run the Content Engine and CFS servers on operating systems that use compatible data types.

	203766
	The following security-related issues are known to exist in CFS-CS:

· After you lock down a federated document, the Change Security checkbox is never checked in IICE web client, regardless of the privileges the user has. This is because updating security is not supported by the IBM DB2 Content Manager connector. 

· Granting a CM8 user the ClientUserAllPrivs privilege set essentially makes that user a super user. There is no way to override this privilege set, and if a user has it the entire CM8 permission evaluation is skipped. The result can be that lockdown will not work properly.

	201755
	If you set the CFS federation process to run daily during a certain time interval and the federation does not complete during that time, the process will continue beyond the end of the specified time interval. (Docs DTS 201728) 

	201117
	Although documents that are configured with security at the item-type level in CM8 may be federated and declared in Workplace, any security changes will not apply back to the source document. It is not advisable to make security changes to the federated copy of any documents with item-type level security in CM8. (Docs DTS 201127)

	200286
	When the status of a Federator database rule is set to Exporting, the user is unable to reschedule the rule. This can cause problems because occasionally when the exporting process fails, the rule status remains set to Exporting. 

Workaround:

220. Go to the Federator database (i.e., SQL Server Enterprise Manager, Oracle Enterprise Manager, or DB2 Control Center).

221. View the contents of the fd_run table.

222. In the status column, look for the value Exporting..

223. Change this value to Scheduled then commit your changes. (Docs DTS 202982)

	183597
	The CD media was re-released for CFS for Non-FN Repositories 3.5.1 and CFS for FN Content Services 3.5.1.  The new release is labeled 3.5.1a (following standard FileNet convention). The 3.5.1a release removes the dependency on the Extended II CE connectors by providing a II IICE Interim Fix 0011.  

If you have previously installed the original release (3.5.1), then you need to upgrade to 3.5.1a.  Alternatively, you may uninstall 3.5.1 and re-install 3.5.1a following the new set of installation instructions which have been updated on the IBM Information Management support page (www.ibm.com/software/data/support).

These are the instructions to upgrade a 3.5.1 installation to 3.5.1a.  These instructions are mainly for testing and demo systems.  

224. Upgrade the Content Engine to at least 3.5.2-001 

225. Delete previously create and configured connectors (use the II CE Admin tool)

226. Stop the II CE server, any RMI Proxy services, and undeploy the VeniceBridge.ear from the application server.

227. Remove all previously installed extended connectors from II CE.  These are the vbr_addon_ntfilesystem.jar and the vbr_addon_content_services.jar.  

228. Install II CE Interim Fix 0011 on the II CE server and anywhere else you installed RMI Proxy services (e.g. the Content Services server and/or the server running the Index Service).

229. Rebuild the VeniceBridge.ear file and redeploy on the application server.

230. Recreate and reconfigure the connectors you deleted in step 2. Note that the Extended connectors no longer appear; this is normal.

	176290
	If the secondary database has no fd_tables, but the configuration of the database connection in Federator Admin is correct, a rule is created for the second data map and the status is Not Accessible.

	176286
	An older user password for a second database connection configuration is cached until the second II CE server is restarted. 

	175654
	Internet Explorer 6.x has issues when attempting to view or download federated content through the IBM HTTP Server with an IBM WebSphere Application Server. To avoid these issues, try the following workarounds:

· Use a different supported browser.

· Access the WAS Application Server directly, bypassing the HTTP server.

	175072
	In the Federator Admin UI, changing the data map of a rule causes the destination document class to reset.

	175070
	In the Federator Admin UI, users cannot delete or modify a rule that is in an Aborted state.

Workaround:

Return the rule to a Scheduled state before deleting or modifying it.

	174987
	Users cannot return to the Rule Builder page after starting an extended query that will retrieve a large results set.

	174725
	If the FCD's ServiceUserName is not a member of the Administrators group in the CS server but has Owner rights to a CS document, security lockdown will fail when declaring this document as a record. 

	174708
	When users attempt to access a federated CS document that does not exist or has no content (such as an archived or external CS document), Workplace returns users back to the Properties page and does not display an error.

	174707
	Workplace does not display an error message when you attempt to view a federated document whose content does not exist. For example, an archived CS document, an External CS document or a document that no longer exists because the source document was deleted after federation. Enterprise Manager displays an error message, but Workplace opens the info page of the federated document. (Docs Defect: 393622)

	174689
	Documents are still federated into old folder even after the target folder is changed before federating. 

	174184
	The IICE SessionPool Inactive Login timeout parameter is not saved.

	174066
	Memory leak in FNK_CatService when using declare.vbs

	173707
	An error message is not returned when the Federator Admin fails to add a database.

	172859

	A batch file execution error occurs with Windows 2000 SP4.

NOTE Windows 2000 has a 2K limit for environment variables. The variable "VBR_CLASSPATH" that is set in the "run_exporter.bat" script exceeds this limit causing the error.

Workaround:

Microsoft provides a workaround for this kind of problem: 
http://support.microsoft.com/default.aspx?scid=kb;en-us;830473

Another workaround is to use the drive substitution:

231. Modify <WEBSPHERE_II CE_HOME>/bin/config.bat with the following information:

a. subst w: %WAS_HOME%
set WAS_HOME=w:

subst v: %VBR_HOME%
set VBR_HOME=v:

232. SET MQ_HOME="C:\Program Files\IBM\WebSphere MQ\Java"
subst m: %MQ_HOME%
set MQ_HOME=m:

233. Also modify the <FEDEXPORTER_HOME>/bin/run_exporter.bat with
SET EXPORTER_HOME="C:\Program Files\FileNet\CFS\FedExporter"
subst u: %EXPORTER_HOME%
set EXPORTER_HOME=u:

	172435
	Exporter throws an inaccurate error when it cannot get logging information from the database. 

	171845
	In the Federator Admin Rule Builder page, the Target Document Class list contains the following inappropriate items:

· Folder

· Preferences Folder

· Form Proxy Folder

NOTE This is a known issue of IBM Web Component. See IBM PMR #09204,756.

	171683
	With IICE 8.3 on WebLogic 8.1.4, Fed Exporter returns an exception when logging on to an SSOServer.

Workaround:

234. Copy the vbr_subscriptionservices.jar to the <IICE-HOME>/ejb/.

235. Run the <IICE-HOME>/bin/rebuild_ear.bat.

236. Redeploy VeniceBridge.ear from <IICE-HOME>/.

	170282
	Rule queries containing only document class criterion throw an exception.

Workaround: 

When running a query against a resource repository, the query must contain a property or full-text criterion.

	169887
	The Rule Management page in the Federator Admin application displays HTML source code. This might happen if the connection to the Federator database if broken. Use the application server logs to verify the error that is occurring.

	169031
	Some CS properties appear twice in the IICE 8.3 data map designer.

	168260
	When two rules select the same set of documents but use different data maps, the values that are federated via the first data map are overwritten with properties contained in the second data map. 

Workaround:

This is a processing-time issue. The problem occurs when the importer begins processing before the exporter finishes processing. Adjust timing accordingly.

	168251
	Currently, admins are unable to recover lost passwords. 

Steps for recovering password:

Use the command line tool to reset the password for administrator. 

237. Execute the following command from <IICE_HOME>/bin directory:

a. run_sample.bat com.venetica.vbr.relate.refperm.AdminTool deleteUser "user" where -user would be an administrator or another user id as administrator.

238. Run_sample.bat com.venetica.vbr.relate.refperm.AdminTool createUser "user" "pwd".

239. Run_sample.bat com.venetica.vbr.relate.refperm.AdminTool addUserToGroup "user" Administrators.

a. You can find this single sign-on and permissions administration tool in the Information Center:

b. Open the information tool if you have installed locally or access this link http://publib.boulder.ibm.com/infocenter/wsiihelp/v8r3/index.jsp) 
IBM WebSphere Information Integrator Content Edition information >
Security > Enabling single sign-on > Using the single sign-on and permission administration tool. 

	168160
	CFS-NTFS does not update the current delete confirmation message to cover CFS-IICE cases.

	167894
	Users are unable to view federated CS external documents from the FileNet P8 application. Although documents from an external CS system can be federated to a FileNet P8 system, they contain no content. Therefore, when a user attempts to open the external document from a FileNet P8 application, there is nothing to view. 

	167672
	CFS federated document owner is NONE.

Note Functions as designed.

	167534
	The source repository document class drop-down list is not available after selecting a data map in the Federator Admin UI.

Workaround:

Login to the repositories. The drop-list is available only after users login to the repositories. That is, the item class information cannot be retrieved without logging into the repository first. This is why users can see the drop-down list after an initial search.

	165930
	In the Federator Administration interface, the Rule Builder’s Query Rule section is not immediately available. Clicking the General Configuration page and then returning to the Rule Builder’s Query Rule section should resolve the availability issue. (doc FNDTS00203925)

	165184
	Data map drop-down lists of CS properties for a CS connector includes multi-value properties. 

Notes:

· This is an IICE 8.3 known issue. 

· CFS 3.5.1 does not support queries against multi-value properties. 

Workaround: Do not include multi-value properties in the data map. 

	151661
	If you manually try to start the service FileNet CFS Server for Image Services (in the Services node of the Computer Management snap-in), the service starts, but then immediately stops. The Event Viewer will contain an entry indicating that CFS-IS has not been configured, meaning that one or both of the following conditions have not been satisfied:

· No fixed content devices have been created/assigned to fixed file stores.

· No mappings have been made between IS libraries and object stores.

If both these conditions have been satisfied, do the following to see if you have a problem with the CFS-IS installation:

240. Open the Windows registry on the machine.

241. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\FileNet\ECM\Content Engine\Service Registry.

242. If there are no keys or values at the registry location in step 2, run the configGCD.exe tool, located in the Content Engine installation directory. After running the tool, restart the FileNet CFS Server for Image Services service, and you are done.

243. If there are keys or values at the registry location in step 2, re-check the local hosts file, the fixed file store configuration, and the property mappings between IS libraries and object stores. Refer to the Troubleshooting section of FileNet P8 Confederation Services for Image Services Guidelines CE Release 3.5 IS Release 4.0 SP3 at the IBM Information Management support page (www.ibm.com/software/data/support). (Docs DTS 151995)

	NA
	CFS does not maintain relationships between the components of compound documents.  CFS will federate any documents that meet the search criteria irrespective of any relationships the documents might have to other documents.


File Tracker

	Defect ID
	Description

	174373
	File tracking information does not transfer to Application Integration when a file is checked out from Workplace without downloading the file. If you do the following, then Application Integration will not recognize the file as a tracked file:

244. Check out a file in Workplace and do not select Download from the confirmation page.

245. Later use the Download action to download the fie, and select Open from the download dialog box.

246. When the file opens it the application, the File Tracker actions (such as Get Info and Check in) do not recognize the file as a tracked file.

Workaround:

247. Checkout the file from Workplace and select Download in the confirmation page. Save the file to your desired location.

248. Open the file in the MS Office or Outlook application. The file is tracked properly. (Doc DTS 174386)  

	174102
	If eForms Designer has already been installed on the client computer, do not use the default install directory of <drive>:\Progam Files\FileNet\FileTracker to install FIle Tracker. Set the File Tracker install location to <drive>:\Program Files\FileNet\AppInt.

	173637
	If File Tracking is enabled in Site Preferences, and the client machine has Active X enabled for IE, but the client machine does not have the File Tracker application installed, the first time in a session that a user attempts to checkout a document, the Download button is not displayed in the Checkout confirmation page.

Workaround:

249. Cancel the checkout.

250. Checkout the document again. 

The Checkout page should display the Download button. 

	173633
	(Doc DTS 173867) When File Tracking is enabled, entry templates that hide the Set Properties or Set Security pages fail to add a document or check in the document, but the local copy of the document is deleted if specified. An "Invalid Parameter List" error message is displayed at the end of the add wizard.

	173620
	When File Tracking is enabled, entry templates that hide the Set Properties or Set Security pages fail to add a document. An "Invalid Parameter List" error message is displayed at the end of the add wizard. (Doc DTS 173929)

	173619
	Dialog is incorrect on first usage of Auto Detection on Add Via Template.

When the client does not have WP FileTracking installed, but FileTracking is enabled from the Site Preferences, performing add document via an Entry Template dialog will not respond the first time on each logon, until the AE is detected thru other actions that FT is not available. (doc FNDTS00173933)

	172626
	If the File Tracking is enabled while users have multiple-content files checked out, then the users will be able to check in the multiple-content file and retain all the saved content items. Otherwise, when File Tracking is enabled, users cannot check in multiple-content documents. (Doc DTS 172627)  


Image Viewer

	Defect ID
	Description

	169184
	(Doc DTS 174074) Image Viewer does not work in Workplace when WebSphere 6.0 is the application server and the operating system is a Macintosh.

	157669
	(Doc DTS 157675) The Image Viewer will sporadically 'hang' while it is attempting to load.  This problem only occurs on machines that are using an Image Viewer with the Thawte (re-signed jars) certificate, and running jre 142_03 or lower.  
Solution: Upgrade the jre (uninstall, re-install newer version) to jre 142_05 or higher.

	146194
	For documents stored in Image Services and accessed through Workplace, you can add a Line, Oval, or Rectangle annotation.  However, you cannot modify these annotation types after the initial save. No error message is displayed to warn you that the changes will be lost once you close the Image Viewer session. 

	145682
145686
	If you eject a surface from a library that contains a COLD document (or COLD background template), that COLD document will not be viewable through the Workplace Image Viewer.  In addition, if a drive is disabled that is on the surface in a library slot, the COLD document will not be viewable. 

	145423
	You cannot create, view, or modify annotations in Image Viewer when the Application Engine is configured for full SSL support. 

	144993
	 (Doc DTS 151376) In a full SSL environment, you cannot add, edit, or set the security for annotations in the Image Viewer. 

	144948
	The Image Viewer may not be able to open and display very large images (>10 MB). 

	143064
	When using the Image Services Resource Adapter (ISRA), documents that are stored in Image Services and are accessed through the Image Viewer, the Annotation Security dialog box may cause the screen to flicker when a user selects the Both, User, or Group radio button. 

	136828
	If a COLD document that includes a background template is imported to the Content Engine from Image Services, but the COLD template is not imported, then the COLD document is displayed in Image Viewer without the background template. No warning message is displayed about the missing template. The. Make sure that all COLD templates are imported when importing documents from IS to the Content Engine. 

	135640
	The Image Viewer supports GIF images, but animated GIFs are not supported. 

	118798
	For Windows systems only. To enter an Alt key sequence into a text annotation in the Image Viewer, first press Alt+0 and then release both keys. In the dialog box for entering special characters, type the desired Alt key sequence, such as Alt-0128. 

	118186
	Euro characters appear as a dash when downloading a file in Workplace 

	118183
	IS integration – the double quotation character (“) gets dropped on annotations security 

	104189
	The Include Redirect Tag property's default value is Yes, even though the documentation says it is No. 

	103804
	The Enhance mode button tooltip does not include the keyboard shortcut. The keyboard shortcut key is "e". 

	103803
	In the Image Viewer, the shortcut key for New Window (W) does not work. The tooltip displays the shortcut key, but pressing W or w does not function as desired. 

	102194
	The Highlight Rectangle annotation displays incorrect fill color in edit mode. When you select an existing Highlight Rectangle annotation, the fill color temporarily changes as the mouse moves over the annotation customization toolbar. The fill color returns to the previously selected color when you move the mouse out of the toolbar or click outside of the annotation. 

	102192
	A sticky note annotation requires some text. If you draw a Sticky Note annotation and leave the text in the Sticky Note dialog box empty,  the annotation disappears when you click OK. To create a blank Sticky Note, type in a space before clicking OK. 

	102140
	Characters are corrupted in the first screen after clicking on the Print button for the first time. The screen asks if you want to print with or without color. 

	96331
	If a user only has permissions to view an image, any annotations that they try to create will not be saved.  However, the user does not receive notification that the annotations will not be saved. 


ISRA Integration

	Defect ID
	Description

	744160
	Annotations cannot be saved when reopening  an image. (Doc Defect 744579)

	146357
146162
	Digital Signature annotations are not supported in this release.

	146194
	Straight Line, Oval and Square annotations that are added to documents using an Image Services application, such as the ISRA Sample Application, can be viewed in the FileNet P8 Image Viewer. However, any modifications made to these annotations are not saved and no error is displayed.


Process Designer

	Defect ID
	Description

	176003
	Search Designer, Publish Designer, and Process Designer do not open if you are using FireFox Browser version 1.5.0.5. An error message appears is you are using Windows 2000 Pro Client or XP. The following clients do not cause any errors when you open either of the designers: 

· Windows client using IE 6.0.

· Macintosh client with Safari 2.0.3 and using Firefox 1.5.0.5. (Doc DTS 187413)

	140376
	The description of an inherited submap does not display in the Workflow Properties dialog box, even if a description was entered for that submap in the base workflow.

	122765
	When using Windows XP SP2 / Internet Explorer 6 SP2, and JRE, launching a workflow from Process Designer results in an 'Error on page' message on the Launch Processor page.

Use one of the following as a workaround for this problem:

· Launch the workflow definition from Workplace instead of from Process Designer.
· In the workflow definition, specify the Java Launch processor for the Launch step.
· Press the Refresh button.


Search Designer 

	Defect ID
	Description

	191297
	The Read Only property displayed on a search template displays only the search value and does not display any choice values.

	195626
	When two different doc classes are selected for a search template, and then one is deleted, the Search Designer does not display the deleted doc class. However, when the search template is executed, the deleted doc class appears. Clicking Search results in an error message. (Doc DTS 195851)

	196853
	On the Search page, a URL encoding problem emerges under the following conditions:

· In a query, you use the double ampersand (&&) symbol for the AND logical operator.

· At the bottom of the results list, you click a page link or "Next" link. 

This sequence of actions leads to a parsing error on the results section of the Search page.

To avoid this problem, do not use the double ampersand symbol in a query. Instead, use "AND", for example, "form AND workplace". (Doc DTS 197297) 

	162895 
	Stored searches created in 3.5.0 or prior that have choicelist values, where the value and  label are different, such as red=1; blue=2, etc, must be upgraded by opening the stored search in 3.5.1 Search Designer. This will fix a problem where the label (instead of the value) was saved in the search definition and the search would fail to return any results.

Stored searches created in 3.5.0 with values in properties for which the label and value are different produce an error when opened in 3.5.1. The error is misleading because this search does NOT need to be upgraded. It is a valid 3.5.0 search, as it was created and functioned correctly in 3.5.0; something else is keeping it from opening. Error is shown below:

Error Message: This search must be upgraded to run in the P8 3.0 environment

Exception Class:  com.filenet.wcm.toolkit.util.WcmException (Doc DTS 162935)

	162895
	(Doc DTS 162935) Stored searches created in 3.5.0 or prior that have choicelist values, where the value and label are different, such as red=1; blue=2, etc, must be upgraded by opening the stored search in 3.5.1 Search Designer. This will fix a problem where the label (instead of the value) was saved in the search definition and the search would fail to return any results.

Stored searches created in 3.5.0 with values in properties for which the label and value are different produce an error when opened in 3.5.1. The error is misleading because this search does NOT need to be upgraded. It is a valid 3.5.0 search, as it was created and functioned correctly in 3.5.0; something else is keeping it from opening. Error is shown below:

Error Message: This search must be upgraded to run in the P8 3.0 environment
Exception Class: com.filenet.wcm.toolkit.util.WcmException 

	160553
	(Doc DTS 162753) Because of enhancements and changes to Search Designer, it is likely users will get Java Out of Memory errors in the console when performing various operations. If Search Designer appears to lock up, set the Console to Show and verify if Out of Memory errors are occurring. If they are, users need to increase the memory size in the Java Plug-in Control Panel. 

To increase the memory size:

251. Open the Java Plugin Control Panel.

252. Click the Advanced tab.

253. In the Java Runtime Parameters box, enter -Xms 256m -Xmx256m

Note The recommended parameter appears to be the minimum for Search Designer to function correctly. Users can make the second parameter higher (the max parameter) if they have more available memory on their client systems.  

	120327
	The Search Designer does not prevent the common search criteria and the content search criteria from coexisting in the search definition. It should prevent the coexistence of the common search criteria and content search criteria. 

When you create a stored search or search template in Search Designer, the following happens:

· Property search criteria displayed in the Common view (common search criteria) and the content search criteria may coexist in a search.

· The search criteria will not be displayed correctly in Workplace and search results are invalid.

	104178

104264
	Including both specific object criteria and common object criteria in a stored search can result in an erroneous “Incomplete Criteria” message when you try to save the search. The problem does not occur when you create stored search templates. 

Workaround: Use the common view for all search criteria. Another alternative to this issue is to define the search criteria for the multiple object type in a search template instead of a stored search.

	103689
	If a search includes common (stop) words, the search does not fail. Instead, the documents that include the common words are returned within the search results. 

	99178
	Search Designer does not display Object Stores with Arabic characters in a correct or consistent manner. The majority of these problems (bulleted below) are in the Common dialog, but the first is specific to Search Designer. The Publish Designer also displays these problems. The following problems occur when using the common dialog box while doing the following tasks: open, save, add, check in and check out. 

· In Search Designer > Available Object Store >> character order is not correct

· In Search Designer > After selecting subfolder >> subfolder name is in between parts of OS store name

· In Search Designer > after initial folder to save in is displayed >> displayed correctly

· In Search Designer > but when actually doing the save confirmation >> the path is not correct


FileNet P8 Portlets

	Defect ID
	Description

	170966
	When configuring portlets in MyWorkplace, there may be some initial display issues. They manifest as missing icons and graphics on the MyWorkplace page. In addition, there is the inability to access objects from the links in the configured portlets during the first browser session accessing the page or after configuring the page from Site Preferences. The problem will disappear as new files and configuration data is updated across all components.

	167986
	The Browse portlet incorrectly displays magazine view in Multilingual systems.

Workaround:

254. Log in to Workplace as an administrator on the Application Engine that the Portlet uses.

255. Select Site Preferences > Object stores page.

256. Select the object store that you wish to display in Multilingual mode for the browse portlet.

257. Click Apply.

258. Sign out of Workplace.

259. Log in to the Portal. 

The Browse Portlet should correctly display in magazine view.

	167850
	The tokenTimeoutInterval setting in the portalbootstrap.properties file does not work as expected. This value determines if the user token is still valid, based on the time set on the portal server and the time set on the Application Engine server. If the time difference between the 2 machines is within the range in minutes specified by tokenTimeoutInterval, then a user should be able to log in to the portal. When tokenTimeoutInterval is set to the default of 300 (minutes), log in succeeds only if the portal server and Application Engine server times are set within 5 minutes of each other.

	166949
	(Doc DTS 167593) FileNet P8 Portlets versions 3.5.0 and 3.5.1 do not support WebSphere 5.1.0.2. FileNet P8 Portlets works with WebSphere 5.1 only. If you need to install and use FileNet P8 Portlets, do not to apply any WebSphere patches.

	166638
	(Doc DTS 167556) If the browser locale is set to non-English, the Workplace Sign In page displayed in the Portlet is missing the Save Credentials checkbox.

	166171
	 Doc DTS 167561) The Quick Search portlet results do not honor the object store filtering feature. Object stores that have been configured to deny access to the user via access roles are displayed in the Quick Search Portlet.

	156092
	The Browse portlet performs poorly on HPUX with WebLogic P8 Portal 3.5 if the portlets are configured with a Workplace URL that is on the same machine as the FileNet P8 Portlets, and if SSL has been configured in a firewall environment.

Workaround: Redirect the Workplace connection to a second server running Workplace. (Doc DTS 156277)

	154353
	If FileNet P8 Portlets is collocated on the same machine as FileNet P8 Workplace, and Internet Explorer will be used to access the portlets, redirection between Workplace and FileNet P8 Portlets might not work correctly due to a limitation in the Internet Explorer client software. For more information, see <http://support.microsoft.com/default.aspx?scid=kb;en-us;843518>.
Solution: When specifying the URL of the Application Engine server, use the IP address instead of hostname. If the hostname was specified during installation, the URL can be updated in the portalbootstrap.properties file. This applies to both 3.0 and 3.5 portlets.

	153725
	After installing the 3.5 FileNet P8 portlets, the P8BPMBroker.properties file incorrectly contains the router.path which has 'DIR2' in the folder path. The P8BPMBroker.properties file has the following entry: 
router.path=DIR2//FileNet//Workplace//WEB-INF 

The result of this bug is that the Process Engine's Process Orchestration feature will not be available. To workaround this issue, manually edit the P8BPMWSBroker.properties with the correct path to the router directory. For example:

router.path=/opt/FileNet/Router  (Doc FNDTS00153983) 

	153651
	3.5 Portal Silent Install Script - unclear notes on the Portlet Install Directory Section

The section for the new Portlet Install Dir could be more clear. Below is what it says currently:
========================================
#    -P installLocation="C:\Program Files\My Product"

#

-P installLocation="C:\Program Files"

#######################################################################

#

# Choose Portlet Install Directory Type

#

# The install location of the product can be:  

#     - Independent Install Directory for later deployment

#     - Application root Install Directory

# If your applcation is an "Independent Install Directory for later deployment"

# modify your install location above to end with "\FileNet\p8portlets"

# EX:    -P installLocation="C:\Program Files\FileNet\p8portlets"

#

#######################################################################
#

========================================
Suggested changes follow:

========================================
#######################################################################

#

# Choose Portlet Install Directory Type

#

# The install location of the product can be:  

#     - Independent Install Directory for later deployment

#     - Application root Install Directory

#

# For example, if your application is an "Independent Install Directory for later deployment"

# modify your "P8 FileNet Portlets Install Location" above to end with "\FileNet\p8portlets"

#

#
-P installLocation="C:\Program Files\FileNet\p8portlets"

#

# For example, if your applcation is an "Application root Install Directory"

# modify your "P8 FileNet Portlets Install Location" above to the folder that you want as your

# root install directory

#

#
-P installLocation="C:\web_app\application\P8Portlets"

#

#

#######################################################################
#

(Doc FNDTS00153988)

	152078
	The FileNet P8 Portlets do not support the features of the optional WCM add-on. (Doc DTS 152083)


Workplace Application Integration

	Defect ID
	Description

	188454
	After installing Application Integration, the FileNet P8 menu options might not appear in MS Word 2003. Work around this issue by manually enabling the menu options to appear in Word by doing the following:

260. Open Word.

261. From the Help menu, click About Microsoft Office Word.

262. Click Disabled Items. An Application Integration dll appears in the Disabled Items list.

263. Click Enable, and then close Word.

264. Re-open Word and the FileNet P8 menu options appear. (Doc DTS 173878)

	161145
	(Doc DTS 161693 Visio 2003 documents (VSD files) cannot be opened from Workplace. 
 Solution: Add the following line to the content_redir.properties file on the Application Engine, and then restart the Application Engine.

    application/x-visio=/getContent?{QUERY_STRING}&mode=download       )

	154233
	The version of Application Integration released with 3.5.0 fix pack 1 is the same version released with 3.5.0. Therefore, no Application Integration upgrade will take place if you follow the Workplace > Author > Download Office Integration link (since doing so downloads the original 3.5.0 installer for Application Integration). (doc FNDTS00154235)

	150333
	(Doc DTS 155873) You must be running at least Internet Explorer 6 SP1 in order to log in to Application Integration on a Sun Java System Application Server 8.1 system.  

	149829
	(Doc DTS 154281) Oracle patch 3412804 is required for 2-box SSL redirection to work on a Windows platform and for Application Integration in order to log in. 

	147230
	In AppInt, when opening a task that has a document attached to it, you cannot open the document. 

	103823
	If “Content Advisor ratings” is enabled in Internet Explorer, you must select Users can see sites that have no rating under User options to enable users to access Workplace and run Application Integration. You access this rating in Internet Explorer from Tools>Internet Options> Content. To access the option, click Enable under Content Advisor, and then click the General tab. Under User options, select Users can see sites that have no rating.

	102726
	PowerPoint documents are not opened correctly in Internet Explorer. The file appears corrupt. In addition, hyperlinks to PowerPoint documents inserted from Office applications exhibit this same problem. 

	98856
	A MIME type must be registered in order for Workplace Application Integration to recognize it. 

	96449
	Accessing an inserted hyperlink that leads to a non-associated document results in an error.

	95670
	If you select a chart inside a Microsoft Excel document, the FileNet P8 menu options are not available. 

	95098
	When uninstalling Workplace Application Integration via Add/Remove Programs from the Control Panel, the frequency in which the program is used is inaccurate. 

	94261
	No error appears if you attempt to insert a property into a cell that has an existing value in Microsoft Excel. 


Localization

	Defect ID
	Description

	183658
	Content Engine uses Unicode on all database platforms to allow support of any language, including multiple languages on a single object store.  For case conversion, the Unicode standard maps the letter “i” to “I” and vice versa.  However, the Turkish language has two additional letters, “İ” and “ı”.  The linguistically correct case behavior for these four letters is that the dotted letters pair together, as do the un-dotted two.  This is an exception to other languages using the Latin-based alphabet.

Because Oracle and DB2 do not support case-insensitive searches natively, their respective lowercase functions are used to simulate that behavior when specified for an object store.  Following the Unicode standard, they therefore will not do case conversions that are correct for the Turkish language.  For more information, see: 

http://www.unicode.org/faq/casemap_charprop.html#4
Because these lowercase functions do not perform the linguistically correct translation, the result set may not include some objects that contain these four characters in the searched field(s). (Doc DTS 197870)

	153377
	When the client browser is configured to a French locale, the Calendar control displays an error when Full date and Full time formats are chosen. 
Solution: Use shorter date and time formats. (Doc DTS 155159)

	99178
	Search Designer does not display Object Stores with Arabic characters in a correct or consistent manner. The majority of these problems (bulleted below) are in the Common dialog, but the first is specific to Search Designer. The Publish Designer also displays these problems. The following problems occur when using the common dialog box while doing the following tasks: open, save, add, check in and check out. 

· In Search Designer > Available Object Store >> character order is not correct

· In Search Designer > After selecting subfolder >> subfolder name is in between parts of OS store name

· In Search Designer > after initial folder to save in is displayed >> displayed correctly In Search Designer > but when actually doing the save confirmation >> the path is not correct

	118324
	Object store names that contain Japanese characters display incorrectly in Workplace. The administrator who creates an object store that includes Japanese characters in the object store name must stop and restart the Content Engine server to correctly display the object store name in Workplace. 

	101276
	When set to French input mode, the single quote incorrectly displays incorrectly as a question mark. 

	103456
	When configuring choice lists, names and choice items entered with Czechoslovakian characters display incorrectly. 


Internationalization

Limitations

This section lists the current limitations and issues with the current Non-English installations. Some of the limitations are also tracked in the table below.

WebLogic

WebLogic 8.1 is not currently supported on a Turkish operating system.

English and EnglishX locale considerations

It is important to choose the correct locale—English or EnglishX—for your situation. Each locale has different performance and stemming query characteristics.

English locale indexing is twice as fast as EnglishX locale indexing. Some variance on the InZone modifier is attributed to the way the two locales use a stemming table. Stemming identifies the root form of words, so that all forms of the word can be searched. This extends to words with irregular tenses, such as the word "eat" that is stemmed to include "ate." 

English locale uses a static stemming table. EnglishX locale dynamically creates a stemming table based on the words. As a result, the EnglishX locale does a linguistic analysis and may recognize a different set of words as similar. Both locales may have different sets of similar words.

If you are using Verity's categorization product along with your indexing, it is recommended you select the EnglishX locale. EnglishX locale may be more complete in its linguistic analysis. Refer to the Verity documentation for more information on categorization.

NOTE Your locale and style folder must match. For example, if you select English as your locale, your style folder cannot be EnglishX; it must also be English.
Known Issues – Internationalization

	Defect ID
	Description

	142826
	Multiple lines of  ??? (question marks) are displayed when opening a file from Process Designer when the browser and OS language settings are different.

	142201
	Running Application Integration with an AE setup for multilingual support requires the client machine regional setting and the installed browser locale/language setting match.

	140217
	FileNet does not support translation of root folders defined in wcmlocalization.xml.

	121184
	Reports.xml files support only one locale at a time.

	20263
	Files can only be saved in Unicode encodings in the WebDAV repository. However, the WebDAV repository cannot store files with names in different codepages and WebDAV does not support Unicode characters in file names.

To work around this, change your system locale to a corresponding language.


Process Analyzer

	Defect ID
	Description

	180920
	(Doc DTS 181558) The Process Configuration Console documentation incorrectly states that you must enable all event logging categories for Process Analyzer. Process Analyzer does not require the following categories: System messages, Trace instruction, Milestones, Exception, and User-defined messages.

	10814
	Doc DTS 23186) Process Analyzer configured with a case-sensitive character set does not recognize case-sensitive queue names and/or case-sensitive data sources. For example, if a workflow definition refers to both wq2 and WQ2, the Process Analyzer outputs the data for both queues as belonging to wq2. As a workaround, use unique names rather than case to distinguish queues within an isolated region.

	102710
	The following reports are supported in Excel XP and Excel 2003, but are not supported in Excel 2000.

· Avg Age of Current Workflows.xls

· Avg Time Spent in Current Step.xls

· Avg Time Spent To Complete The Work Items At Step.xls

· Avg Time Spent To Complete The Work Items Of The Workflows.xls

· Avg Time Spent To Complete Workflows During Time Period.xls

· Avg Time User Spent To Complete The Work Items.xls

· Avg Wait Time For Work Items During Time Period.xls

	
	FileNet Process Analyzer, release 3.5.0, cannot be installed on a server with Microsoft SQL Server 2000 SP4 already installed on it.  This problem has been resolved in the Process Analyzer 3.5.0a release.  If your server already has SQL Server 2000 SP4 installed, install Process Analyzer from the 3.5.0a media. (DTS 163896)


eForms

eForms for P8 Workplace
	Defect ID
	Description

	555121
	Calling the setCurrentCell method on a form returns an exception if the specified table cell is empty and the row containing that cell and the subsequent rows in the table are also empty. If this exception is not caught in the JSP, a JavaScript error occurs.

	208734
	When the user enters incorrect account information in the sign in dialog box, the error dialog box is not presented in Firefox 2.0 on Macintosh OS 10.4. The error message should say "Unable to complete this operation because the account information provided is not correct." This error also occurs on P8eF-3.5.1-00 5 with FireFox 1.5 or 1.07. (Docs DTS 208809)

	208853
	If the pop-up blocker in Internet Explorer 7 is enabled, it prevents the user from saving a form because it blocks the Entry Template Wizard from opening. A warning message appears in the browser that says "Pop-up blocked. To see this pop-up or additional options click here..." If the user clicks the message and selects "Always Allow Pop-ups from This Site...", the form is refreshed and all data entered is lost. (Docs DTS 208902)

	208839
	With Netscape 7.2, when a region frame in a document policy is refreshing, the form disappears and a white area is displayed where the form was. (Docs DTS 208900)

	208099
	If a required cell has a choice list, the "You must enter a value there" message pops up when the user clicks the cell to display the choice list. This message should appear only if the user tries to exit the cell without selecting a choice.

In Windows Vista with Internet Explorer 7.0, the message appears after the user selects a choice and deletes the selected choice from the field. The user must then select a choice again. (Docs DTS 209102) 

	208836
	With Netscape 7.2, when the user opens a form with the regions Notice, Banner, Left, Right, and Bottom displayed, a scrollbar is shown in the form frame. (Docs DTS 208901)

	207996
	If the first cell on the form is a required field but the cell has no value (even though the error handling allows actions with invalid data), toolbar command shortcuts such as "Ctrl+Alt + x" do not work.

Workaround: click the button icon or button link. (Docs DTS 208909)

	207994
	A confirmation page is expected after a user clicks the Save button to save the form data at a workflow step, but it does not appear. (Docs DTS 208906) 

	207980
	In a table, an If-Then calculation based on a dynamic choice list displays erratic behavior when the choice is null. The value displayed changes unexpectedly when rows are deleted or when the choice selected in a different row changes. This does not occur if the choice list is static. (Docs DTS 208905)

	203950
	In HTML eForms, font color, style (italic or normal), weight (bold or normal), underline, border width, and border color cannot be displayed for on-form buttons. The default button style is displayed instead. (Docs DTS 208029)

	202253
	Date calculation does not work correctly for certain dates in March.

	200487
	Using Macintosh with Firefox 1.5, if you open a data document that includes a signed signature cell and then you double-click the signature to verify or delete it, the dialog box sometimes appears blank. With FireFox 1.0.7, the dialog box does not open. To avoid this problem, use a single click.

	200283
	With Macintosh 10.4x and Safari 2.0.4, if you move the mouse pointer over a table or click a table cell that includes a calendar control, the calendar appears. However, when you move the cursor directly over the calendar or click it, the calendar disappears.

	196965
	Solaris 9 with Sun Java Application Server 8.1 systems only -- After you install the P8eF-3.5.1-004 fix pack update and redeploy Workplace, the following error displays when you start the application server:
[#|2006-12-13T10:57:31.882-0800|SEVERE|sun-appserver-pe8.1_02|javax.enterprise.system.container.web|_ThreadID=10;
|WEB0600: WebModule [/Workplace] failed to deploy and has been disabled: [java.lang.IllegalArgumentException: add
Child: Child name 'FormServlet' is not unique].|#]

Workaround:

Remove all of the duplicate FormServlet entries from the WEB-INF/web.xml file (they are shown below) and restart the application server.

<servlet>

            <servlet-name>searchChoiceList</servlet-name>

            <servlet-class>com.filenet.wcm.toolkit.server.servlet.SearchChoiceListServlet</servlet-class>

        </servlet>

    <servlet>

        <servlet-name>FormServlet</servlet-name>

        <servlet-class>com.filenet.ecm.forms.core.FormServlet</servlet-class>

    </servlet>

    <servlet>

         <servlet-name>SigningServlet</servlet-name>

          <servlet-class>com.filenet.ecm.forms.core.SigningServlet</servlet-class>

      </servlet>

    <servlet>

        <servlet-name>FormServlet</servlet-name>

        <servlet-class>com.filenet.ecm.forms.core.FormServlet</servlet-class>

    </servlet>

    <servlet>

         <servlet-name>SigningServlet</servlet-name>

          <servlet-class>com.filenet.ecm.forms.core.SigningServlet</servlet-class>

      </servlet>

<servlet-mapping>

            <servlet-name>searchChoiceList</servlet-name>

            <url-pattern>/searchChoiceList</url-pattern>

        </servlet-mapping>

   <servlet-mapping>

        <servlet-name>FormServlet</servlet-name>

        <url-pattern>/FormServlet/*</url-pattern>

    </servlet-mapping>

   <servlet-mapping>

          <servlet-name>SigningServlet</servlet-name>

          <url-pattern>/SigningServlet/*</url-pattern>

      </servlet-mapping>

   <servlet-mapping>

        <servlet-name>FormServlet</servlet-name>

        <url-pattern>/FormServlet/*</url-pattern>

    </servlet-mapping>

   <servlet-mapping>

          <servlet-name>SigningServlet</servlet-name>

          <url-pattern>/SigningServlet/*</url-pattern>

      </servlet-mapping>

	190947
	Task 8 of the FileNet eForms for FileNet P8 Workplace 3.5.0 Installation Guide is missing a description of the BeforeUnloadMessage property.

	189007
	eForms integration: Rounding function causes a JavaScript error when the number to round is a negative whole number.

A cell with the calculation Round(Number1, Number2) causes a JavaScript error when Number1 is a negative whole, non-zero number. If Number1 has any fractional part, no error occurs.

	187457
	JDBC lookups and submits are not working on WebSphere/Solaris.

When configuring a JDBC lookup for an eForm on WebSphere, the JDBC connection to the database sometimes fails with no error returned.  

Workaround: Press the enter key before tabbing out of the cell.  

	183896
	When using Netscape 7.1, if you input multiple lines of text into a text cell and then tab out, all the lines of text are combined into one line.

	183902
	The 3.5.1-001 install log file contains a Java exception that is not displayed during installation.

	182862
	A table calculation fills only the first row if there is a dependency on another column.

	182874
	Calculations do not fire when new rows are added to a table.

	182940
	If the Row function is used in a complex calculation that returns a string, all rows get the same value.

	182930
	Row function does not re-fire when new rows are added and if it is embedded in a complex calculation.

	181947
	For any application server that uses a .war file: when eForms fix pack 3.5.1-001 is applied, custom settings will not be retained if the steps in the installation guide are followed.  

Workarounds:

· Perform this workaround after every eForms 3.5 fix pack:

265. Copy customizations into the Workplace (or some other location).

266. Install and deploy eForms as you normally do.

267. Move the customizations back into the deployed space. 

· Perform this workaround to eliminate any issues with future eForms fix packs losing customizations:

268. Place the customizations directly into the WAR file either before or after installation of eForms. 

	177434
	The last checkbox value in a scrolling table is not committed if you click another cell instead of tabbing out. 

	176468
	Firefox treats incompatible style sheet properties as JavaScript errors.

	175903
	Combining onBlur and onFocus events causes form to lock up in FireFox on Mac.

	175790
	Closing a form via a script in the sidebar causes NN 7.1 and FireFox to crash.

	175492
	The timeSpan() function does not account for Daylight Savings Time. This appears to be the result of a Windows update that introduced an operating system defect.

	174359
	The TOC in the eForms user help has an unnecessary blank bullet under "Work with eForms."

	171671
	The embedded form is missing when the page is reloaded using FireFox or Safari. 

	171598
	Firefox 1.0.7: The Shift-Tab keystroke combination might cause a tab out of the form frame. 

	171051
	The Today button in the Calendar does not work if a date has not been set.

	169818
	RowCount returns an incorrect value when a calculation value is assigned to one column and nothing is assigned to the other column.

	169732
	Cannot tab out of a scrolling table if a column in the table has a Row calculation. 

	169718
	Table with a MakeColumn calculation returns invalid characters in the last three rows. 

	169522
	Page Function does not display the page number correctly in the general workflow step. 

	169321
	A picture cell in a table does not operate properly after pictures are inserted and the table requires scrolling. 

	169287
	The way in which a page opens for a workflow policy is inconsistent. 

	166355
	Selected check boxes render as unselected in PDF. 

	165805
	(Doc DTS 166393The Row function is not returning all the values (row numbers) in a table column. 

	165567
	(Doc DTS 166508)When a form is configured with an HTTP auto-increment and a vbCrLf (Visual Basic Carriage Return Line Feed) is returned from the ASP page, the characters "\r\n" are added to the returned value. 

	163671
	(Doc DTS 166390)If the Choose function is used in a table and the expected return values are from a column, the column values are expanded and a singe value is returned according to the index. 

	161170
	When using the Firefox browser, lookup cell does not return to previous value when canceling out of multiple results. 

	161141
	When using the Mozilla Firefox browser, the Close button does not work when a form is opened from a link. 

	160945
160948
160949
160953
161141
161150
161162
161170
161249
163788
164321
164383
	Firefox: Page tabs disappear when clicked.

When using the Mozilla Firefox browser, the Page Tabs disappear when clicked.

 (Doc DTS 166386) 

	157947
	The date format does not work if the day or month component of the date value is not capitalized. 

	157943
	Generating a pdf from a form that has several picture file types on it (for example, .emf, .wmf, .bpm, .gif, and .jpeg) causes a Java runtime message to appear. 

	157928
	If you select a choice list item, then immediately click a checkbox and change to a different page of the form, the selected choice value is lost. 

	157620
	(Doc DTS 154937)  If an ITX Form Template contains a rotated image, the image appears rotated twice in a PDF version of the form. 

	157592
	When any column in a table is set to display only, clicking the Insert or Delete buttons in the table’s toolbar puts up an alert “That cell has been signed.  You cannot change its value without removing the signature first.” 

	157591
	If you tab into a picture cell that has been signed, you cannot tab any further on the form. 

	157501
	The PrintedPage and OverflowPage functions return a value of “1” when the form is launched. 

	157345
	The UserName calculation fires only the first time a form is opened. If a different user logs into Workplace and opens the form, the original user’s name displays in the cell that is configured with the UserName calculation. 

	156929
	If you have a calculated choice list on a page other than the start or current page, the form locks up and an “error on page” warning displays in the status bar at the bottom of the form. 

	156919
	When multiple checkboxes are selected in a table column, only the first checkbox in the column displays on a PDF version of the form. 

	153614
	The “Files for Like Browser” feature does not work as expected for HTTP data submits. 

	153119
	When the user clicks the Sign button in a signature cell, a selection dialog box incorrectly displays with more than one certificate when there is only one valid digital signature certificate available. 

	151228
	The Min function does not work correctly if the first row of a table column is empty. 

	146990
	When you edit the eForms silent install file, specify a location for the log file, and then run the silent install, the log file is placed in the wrong location. 

	145447  
	If a form is configured with multiple auto-increments, only one auto-increment will perform as expected. 

	145094  
	When the user clicks an on-form hyperlink button that is configured with an empty value in the URL field, another instance of the same P8 Workplace browse window displays. 

	144594
	On Netscape 6.0 or higher, the tool tips do not appear beside the toolbar buttons. 

	144540  
	If the user enters a value in a JDBC configured lookup field, presses Tab or Enter to trigger the lookup, tabs back to the lookup field, and then deletes the value, the lookup action is invoked and incorrectly returns all the records in the database. 

	144374  
	When the eForms uninstaller is run on Solaris, it leaves behind the eforms_remove_from_war.sh file. 

	144206  
	Incorrect values for Logarithm functions are displayed on a form when generated as a PDF. 

	143762  
	The Printing function incorrectly returns the value "False" instead of "True" when the form is printing. 

	143460  
	If the server fails unexpectedly while an eForm is open, the form data document cannot be saved. When the server is running again and the user tries to re-open the form, it appears to be checked out. 

	142202
	When the user clicks ‘X’ on the browser window to close the eForms step processor, the browser closes but the work item for the step remains locked. 

	137480
	An HTTP lookup error occurs with charset information and the content type text/plain.

	101805  
	On Netscape Navigator 7.1, tool tips do not display correctly for icons displayed above a workflow policy form. 

	100338  
	In Internet Explorer 5.5, complete title names of web page dialog boxes do not display. 

	100313
	The text value of picture-formatted cells does not include the image content tag. 


 “Jaws” Screen Reader

	Defect ID
	Description

	99753
	The screen reader application "Jaws" cannot read cell titles aligned to the left of the cell data area.

	97927
	The screen reader application "Jaws" incorrectly reads extra characters in the first column of a table.

	97903

99745
	The screen reader application "Jaws" incorrectly reads tables and fields out of tab order sequence.

	97775
	The screen reader application "Jaws" incorrectly reads unused table rows.


Localization 

	Defect ID
	Description

	151939  
	The browse button on the Insert Picture dialog is not pulled into a resource file for translation. Update December 6, 2005: It has been determined that this is not a problem but functions as designed.

	152648
	When the file name of an image contains non-ASCII characters and is uploaded to a picture cell, the file name becomes corrupted when it is displayed in the File Download dialog box. 

	152915
	For the French (Canada) locale, the currency symbol incorrectly displays before the number.  

	144921
	On an operating system with Japanese regional settings, the dates contained in the form template cells named F_Deadline and F_Reminder incorrectly appear in a US-English date mask. 

	145786
	Some form toolbar icon labels are not displayed in the correct language after the following event sequence takes place:

269. The browser language is set to a non-English locale. 

270. You create a form policy, save it, and then log out. 

271. The browser language is reset to English.

Some labels still display with the previous locale instead of using the recent language setting.

	145805
	In the Select object window of the document and workflow policies, the Document Title label does not display correctly. 

	145973
	An error message appears in English on a non-English locale when a form template is added to the wrong document class.  

	146779
	When an AE multilingual language pack is installed on the AE server with a Japanese locale, and the browser language is reset to French, the Display Settings link that appears when you create a document policy incorrectly displays in French instead of Japanese. 


eForms Designer

	Defect ID
	Description

	187005
	Template images other than JPEG, GIF or PNG are not rendered to PDF.

	188560
	ODBC to Oracle: the schema name has to be manually specified. 

	157670
	When configuring distribution to a deployment center that requires authorization, a “Waiting for network operation” message box appears on top of the login dialog box.

	149469
	When a form is configured with an ODBC or JDBC submit, and the form user submits data that includes an apostrophe, the submit fails. Valid SQL syntax cannot include a single apostrophe. 

To work around this problem, do the following when configuring an ODBC or JDBC data submit in eForms Designer:

272. In the Data Submission dialog box, click Custom to display the controls for configuring a custom data submit.

273. Enter the text that instructs the data source to accept the data submission. For each cell on the form that is included in the submit and for which the user could include an apostrophe in the data, include the following calculation that replaces a single apostrophe with a double apostrophe:

'<<Left (Concat ((Concat (MakeColumn (Tokenize (SubmitCell,"'")),"''"))),Length (Concat ((Concat (MakeColumn (Tokenize (SubmitCell,"'")),"''")))) - 2)>>'


The above example replaces the single apostrophe for a cell called SubmitCell. In the following example of a submit statement, the calculation is included for Cell3.

insert into EmpInfo (EmployeeNum, Name, Department)    values ('<<Cell1>>', '<<Cell2>>', '<<Left (Concat ((Concat (MakeColumn (Tokenize (Cell3,"'")),"''"))),Length (Concat ((Concat (MakeColumn (Tokenize (Cell3,"'")),"''")))) -2)>>');


	148580
	When the data color drop-down list is clicked in the Cell dialog, the color selected in the color palette always defaults to white, even after changing the cell color and closing the dialog.

	148455
	In eForms Designer for Macintosh, more than one file can be selected in the Open dialog box.

	146453
	If an XML entity character (e.g., &, <) exists in the Template Information fields “Description” and “Title,” the File > FileNet P8 > Add command will not work.

	145878
	Deployment of Desktop templates from eForms Designer to Workplace is not prevented by the application as expected.

	145526  
	Form data filled out in test mode will not print successfully when the client machine is set to an Arabic locale.

	141080
	On form templates designed for non-Roman locales, the form author can only enter characters specific to that locale or characters from the low-ASCII portion of the Roman character table.

	120968
	eForms Designer for Macintosh does not support date, time, or number formats in an Arabic locale.

	120924
	eForms Designer for Macintosh does not support Arabic input method.

	024554
	When using a switch statement in Javascript, the script fails if the case uses a three digit number.

	
	The simplified Chinese locale is supported only in Windows XP for eForms Designer 5.0.0.


Business Activity Monitor

	Defect ID
	Description

	167973
	When searching FileNet P8 Documentation for BAM-related information, you must search the entire site. When BAM topics are found, the Help Category displays "<unknown>".  If you limit your search by selecting "Process Engine and Add-Ons, BAM-related topics are not found.

	166864
	For new events that you create in FileNet Application Workbench, you must modify the default behavior so that each event query will clear the current values and use the new values obtained with the query. See the topic "Enable Clear State" in the online Help for Business Activity Monitor in the FileNet P8 Documentation.

	NA
	Some of the installation instructions contained in "Installing and Configuring FileNet Business Activity Monitor" on the BAM documentation CD are incorrect or incomplete. To get the latest version of the installation guide, access "Installing and Configuring FileNet Business Activity Monitor" on the IBM Information Management support page (www.ibm.com/software/data/support).


Content COM API

	Defect ID
	Description

	146985
	When using the COM API to create a FileStore object and a FileStoragePolicy object that have the same storage location (FileStore.LocationString = FileStoragePolicy.StorageLocation), you should ensure that they both have the same name (FileStoragePolicy.DisplayName = FileStore.Name). Otherwise, the FileStoragePolicy object will not appear as an option when you create a document using the Enterprise Manger's Create New Document Wizard.  Note that when you create a file store using Enterprise Manager, it automatically creates a file storage policy object with the same name.

	144984
	If you are using Microsoft Active Directory as your authentication provider and if a user or group is a member of a large number of groups, User.MemberofGroups and Group.MemberofGroups property responses can take an excessive amount of time to complete. If you experience performance degradation in this environment, contact your service representative.

	138703
	The Content Engine COM API does not support applications built with Microsoft .NET; use Content Engine Web Services instead.

	136125
	When creating the query string for an ad hoc search, there are some special considerations when using the IN predicate in your SQL SELECT statement, particularly when searching for multi-valued properties. 

The syntax for the IN predicate is: 
<in_test> ::= <scalar_exp> IN ( ( '(' <SQL query> ')' )  | <property_exp> )

The two acceptable uses of IN, as defined above, are:

 <expression> IN (SQL query)
When using a subquery (a SELECT statement inside another statement) on the right-hand side of the IN predicate, the subquery must have exactly one property selected, and that property must have the same datatype as the right-hand side expression.
 
<expression> IN <multi-valued property name>

In this case, the datatype of the expression and the multi-valued property on the right-hand side must match.

The query syntax does not support a list of constants on the right-hand side of the IN predicate.* Therefore, you cannot use the IN predicate as an alternative for OR; doing so will produce an error. As an example, you cannot replace a query such as... WHERE variable = 'ABC' OR variable = 'EFG';

with the following query:

... WHERE variable IN ('ABC', 'EFG');

For a multi-valued property search, where, for example, the variable multivalueprop has a valid property set value of {'red','blue','green','pink'}, a valid subquery would be structured as follows:

     SELECT DocumentTitle FROM Document WHERE 'red' IN multivalueprop;

Note that the scalar value of 'red' appears on the left-hand side of the IN predicate.

This limitation will be resolved in a future release.

	121108
	Content Java API properties of type Object are not searchable.

	95946
	The Realm.FindGroups method does not filter out domain local groups that are not in the same domain where CE has been installed.


Content Java API

	Defect ID
	Description

	212817
	The existing description of the SecurityTemplate.setApplyStateId method incorrectly indicates that a BadReferenceException is thrown if you specify a non-unique value for the applyStateId parameter. The exception thrown in this situation is, in fact, a UniquenessConstraintException.

	196103
	Premature termination of Content Java API logging activity when using FileNet Site Manager.

The listener.jar, which is part of FileNet Site Manager but installed with the Application Engine, sets the logging level of the log4j root logger to ERROR. This setting overrides a site's configured setting for the root logger's logging level. If the site configuration does not enable loggers at a more detailed level, relying only on the root logger configuration, logging activity stops prematurely. 

Workarounds:

- Use lower-level logging directives (for example, "log4j.logger.com.filenet.wcm.api=DEBUG").

- If your site is not using FileNet Site Manager, remove listener.jar from the classpath.

	186984
	For all classes derived from java.lang.Object, the behavior of getPropertiesXML has changed. In previous releases, if properties were not specified in the argument (for example, getPropertiesXML(null)), the returned XML differed depending on which object it was called from: CustomObject, Document, Folder, or Link. For example, Link.getPropertiesXML(null) returned properties, but also included empty permissions tags (<permissions></permissions>) in the returned string. Document.getPropertiesXML(null) returned properties but no empty permissions tags. When called on Document and Link objects, the method returned empty permissions tags if properties (but not permissions) were requested. 

The behavior of getPropertiesXML is now consistent. If Permissions are not requested (for example, getPropertiesXML(null) is called), then the returned XML does not contain empty permissions tags.

	179287
	Elements of a collection returned by the getContainees method are not sorted. To sort the returned collection, use the orderByProperty method.

	178701
	In previous releases, a round-trip was made to the Content Engine server if a request was made for a property that was not in property cache. The behavior has changed when requesting Id, ObjectType, InstanceType, ObjectStore, and ClassDescription properties. Now these properties are often locally synthesized. This change in behavior is not documented in the Content Java API javadocs nor in the Content Java API Developer’s Guide or “Upgrade Custom Applications” section of the FileNet P8 Installation and Upgrade Guide for Release 3.5.x. For more information, see the What’s New section of this FileNet P8 3.5.x Release Notes document.

	155450
	An incompatibility between soap.jar versions causes exceptions.The version of soap.jar that is shipped with and used by some application server products, such as Oracle Application Server and IBM WebSphere, is not compatible with the FileNet P8 version of soap.jar. J2EE applications that incorporate Enterprise Java Beans (EJBs) that make calls to the Content Java API may throw "class not found" exceptions when relying on the soap.jar installed with the application server product.

	152688
	Invalid string lengths in XML schema when calling Search.executeXML()
In a DB2 or MSSQL environment, the response from a call to Search.executeXML is returning an invalid length of dt:maxLength=‘4294967295’ for String datatypes. As an example, the following query string returns incorrect length values for Creator and DocumentTitle (the expected lengths are 80 for Creator and 255 for DocumentTitle): <?xml version="1.0" ?> 
<request>
  <objectstores mergeoption="none">
    <objectstore id="Northwest" /> 
  </objectstores>

  <querystatement>SELECT Creator, DocumentTitle, PriorityCode FROM  
   Document WITH INCLUDESUBCLASSES WHERE Document.This INFOLDER '/Test' 
   ORDER BY PriorityCode</querystatement> 
  <options maxrecords="0" cursorlocation="server" /> 
</request> 

The above query returns an XML string, part of which is shown below, that illustrates the invalid length: 

<s:datatype dt:type="string" dt:maxLength="4294967295" rs:long="true" />

The cause of the invalid value is an incompatibility between the Microsoft ADO layer and the OLEDB provider used by the Content Java API. The problem occurs when the XML query contains cursorlocation=“client”. Even though an option exists to set cursorlocation to either “server” or “client” in the XML query, it is always set to “client” for a Content Java API query. ADO does not call ICOLUMNSInfo::GetColumnInfo for a client cursor, so cannot determine a valid string length and, as a result, returns the invalid length. Note that the invalid length would also be returned in the generated XML schema when calling ADORecordSet.Save in the Content Engine COM API. However, for COM API users, using cursorlocation=“server” is a workaround.

For Content Java API users, a workaround is to call Search.getPropertyDescriptions, supplying arguments to retrieve the desired property. Search the returned list, then get the MaximumLengthString property on the property description. (Doc DTS 167430)

	136125  
	When creating the query string for an ad hoc search, there are some special considerations when using the IN predicate in your SQL SELECT statement, particularly when searching for multi-valued properties. The syntax for the IN predicate is: 
<in_test> ::= <scalar_exp> IN ( ( '(' <SQL query> ')' )  | <property_exp> )

The two acceptable uses of IN, as defined above, are:

 <expression> IN (SQL query)

When using a subquery (a SELECT statement inside another statement) on the right-hand side of the IN predicate, the subquery must have exactly one property selected, and that property must have the same datatype as the right-hand side expression.
 
<expression> IN <multi-valued property name>

In this case, the datatype of the expression and the multi-valued property on the right-hand side must match.

The query syntax does not support a list of constants on the right-hand side of the IN predicate.* Therefore, you cannot use the IN predicate as an alternative for OR; doing so will produce an error. As an example, you cannot replace a query such as... WHERE variable = 'ABC' OR variable = 'EFG';

with the following query:
... WHERE variable IN ('ABC', 'EFG');
For a multi-valued property search, where, for example, the variable multivalueprop has a valid property set value of {'red','blue','green','pink'}, a valid subquery would be structured as follows:

     SELECT DocumentTitle FROM Document WHERE 'red' IN multivalueprop;
Note that the scalar value of 'red' appears on the left-hand side of the IN predicate. 

* This limitation will be resolved in a future release.

	120557
	(Doc DTS 121108) Content Java API properties of type Object are not searchable.

	103442
	Neither Domain.getProperties() nor Domain.getProperties(String[]) calls return the AuthenticationProviderString and GCDProviderString properties. These properties are no longer retrievable from the Domain object.

	103137
	The following known issue applies if your application is accessing a Content Engine object store that uses Oracle as the database engine. Attempting to file an object twice in the same folder will throw a UniquenessConstraintException if you call the file(destinationFolder, resolveUniqueness) method on a ContainableObject object that does not have a Name property specified, even if the resolveUniqueness parameter has the value true. This can occur if the object implementing the ContainableObject interface is derived from the CustomObject class, which does not specify a Name property by default.

	NA
	On a call to Folder.addSubFolder, if the properties collection passed to the method contains a value for the FolderName property, that value is overridden by the value of the subfolder name passed to the method as an explicit parameter.

	NA
	Novell eDirectory does not support descending order sorting.


Content Java API Compatibility Layer

	Defect ID
	Description

	746321
	A new method signature, getContentElement(contentElement, deferredOpen) has been added to the Annotation, Document, and VersionSeries interfaces but is not fully documented in the 3.5.x Compatibility Layer javadoc. 

The new signature behaves similarly to the existing getContentElement signatures, but with the addition of a boolean-valued deferredOpen parameter. When deferredOpen is false, the method behaves identically to getContentElement(contentElement); that is, the specified content transfer elements are immediately retrieved and returned in a TransportInputStream object. If the value is true, the API defers content retrieval to some later time, such as when a subsequent call to TransportInputStream.read() is made, and returns an empty TransportInputStream object. During the period of the delay, the returned TransportInputStream object contains no content, but its properties (such as filename, MIME type, and content size of the content element, if known) accurately reflect the content to be retrieved. You can use the property accessor methods on this “deferred” stream in the same manner as used on the immediately retrieved stream.(Doc DTS 195630)


Content Web Services API

	Defect ID
	Description

	147722
	While using SSL, the .NET client may randomly encounter the following error. "System.Net.WebException: The underlying connection was closed: An unexpected error occurred on a send."

Solution: 

Add the following code to your WSDL generated class (FNCEWS35Service.cs). The GetWebRequest method should be added to each binding class that you are implementing (for example, FNCEWS35DimeBinding, FNCEWS35SoapBinding):

using System.Net;
using System.Reflection;

protected override System.Net.WebRequest GetWebRequest(Uri uri)
{
PropertyInfo requestPropertyInfo = null; 

WebRequest request = base.GetWebRequest(uri); 

if (requestPropertyInfo==null) 

requestPropertyInfo = request.GetType().GetProperty("Request"); 

// Retrieve underlying web request 
HttpWebRequest webRequest = (HttpWebRequest)requestPropertyInfo.GetValue(request, null); 

// Setting KeepAlive 
webRequest.KeepAlive = false; 

return request; 
}

	147328
	MIME attachments are not supported in IBM WebSphere (and Microsoft .NET). Do not set a web reference in your web services client to the FIleNet MIME WSDL (FNCEWS35MIME.wsdl).

	144379
	For WebSphere clients only: when a SOAP error occurs, WebSphere attempts to cast the error to an ErrorStackType element instead of the FaultStackType element, which results in a deserialization error.

	103984
	By default, Microsoft Web Services Enhancements (WSE) 2.0 limits the maximum size for incoming SOAP messages to 4096 KB (4 MB) and throws an exception if you exceed the maximum size. This can be a problem particularly when retrieving document content. You can specify a different maximum size by setting the value of the <maxRequestLength> element in your machine.config file or in an application's App.config file. For more information, see the <maxRequestLength> Element (http://msdn.microsoft.com/library/en-us/wse/html/gxaconMaxRequestLengthElement.asp) topic in the WSE documentation.


Process Web Services API

	Defect ID
	Description

	150012
	Ensure that the Systinet WASP server is using the Java server version; otherwise, performance will be impacted. (Docs Defect 163333)


Process Java API

	Defect ID
	Description

	751031
	In releases prior to P8 3.5, when no security was defined for a queue, VWQueueDefinition.getReadSecurity and VWQueueDefinition.getWriteSecurity returned the empty set ("[ ]"). This behavior has been changed. These getReadSecurity and getWriteSecurity methods now return "null". (Docs defect 751962)

	118171
	If you are using the JMS Service Adapter of the Component Integrator on a WebSphere application server, the Process Task Manager on the Application Engine must be configured to use the JVM of the application server. This requires modifying both the routercmd file and the taskman.properties file to point to the WebSphere JVM. Currently, the documentation does not specify that the taskman.properties file must be modified as well. The taskman.properties entries that must be modified are the TaskManager.Router.JRE and TaskManager.ComponentManager.JRE entries. These entries must point to the WebSphere JVM.

	103952
	The following two methods are for internal use only: getActiveRouters and getDefaultRouter.


Workplace Application Integration API Toolkit

	Defect ID
	Description

	146387
	IsCheckedOutCmd::Initialize returns true when the IObjectStoreItemPtr parameter is not configured with a reservation ID object. As a result, if a document is checked out and the IsCheckedOut command is initialized with the current, released or superseded version of the object, then IsCheckedOutRsp::IsCheckedOut returns true, rather than false.


FileNet P8 Documentation

	Defect ID
	Description

	180352
	CFS-NTFS Users who have read/write permissions on a parent directory before a sweep and lockdown can no longer modify the subfolders and files in the parent directory but they can delete them.

To prevent deletion of these files, modify the permissions on the parent folder. This way, users cannot delete the files inside of the parent directory unless they have delete rights on the document.

	163873
	(Doc DTS 163876) The links to the following documents are broken in the "About Documentation" topic of the Help Directory. However, you can access these documents on the IBM Information Management support page (www.ibm.com/software/data/support) by navigating to Product Documentation > 3.5.1x Documentation under either Business Process Manager (BPM) or Content Manager (CM).

* FileNet P8 3.5.1 Release Notes
* FileNet P8 3.5.1 System Overview
* FileNet P8 Platform 3.5.1 Security Questionnaire
* FileNet P8 3.5.1 Deployment Guide
* FileNet P8 3.5.1 Content Federation Services for Image Services Guidelines

	157830
	(Doc DTS 157834) The indexer for the P8 Documentation Server may log a "Parse Aborted" message while indexing some HTML or PDF files. This message is informational only; it does not indicate an indexing failure for the associated file.

	154317
	The Search functionality built into the FileNet P8 Platform help is based on an embedded query engine, and its highlighting feature is itself an add-on to that embedded product.  The following highlighting issues exist, which FileNet cannot ensure will be addressed in future releases or fix packs of the embedded highlighter product.  Please note that these highlighting problems do not affect the integrity or completeness of the actual result sets returned for your searches. 

· Periodically, a single-word or phrase that should appear highlighted in text is not. This typically occurs because:

· The search term is bolded, italicized, or otherwise formatted by means of HTML tagging, for example <b></b> around a bolded term or <i></i> around an italicized term.
· The search term is followed by a punctuation mark, such as a period or comma.
· The search phrase is broken onto two lines.
To work around these problems whenever you open result pages, simply place your cursor in the text frame and use your browser's Find feature to locate the terms or phrases in the help page that may not be highlighted as expected.
· Searches containing both a single word and a phrase containing that word may return pages that when opened do not have all instances highlighted. This typically occurs because you entered the single word before the phrase in the Search for field.

To work around this problem, whenever you want to search on a single word and also a phrase containing that word, be sure to enter the phrase first in your Search for field, as in:

Search for  "Content Engine" AND content

· When highlighting is enabled, some characters are displayed incorrectly in result pages.  For example, single quotes may display as question marks (for example, 'content' gets displayed in the page as ?content?)

The only way to work around this problem is to avoid checking the Highlight search terms option in the Search page. If you or your general users do a lot of searching in API-related topics, where special characters are more prevalent, we would suggest you disable (or remove) the Highlight search terms option and use your browser's Find feature instead to locate the individual instances of the search term(s) in the text frame of each result page. 

NOTE  You can manage the default behavior and presence of the Highlighting search terms option in the Search page, as follows:

· To make the Highlighting search terms option in the Search page appear unchecked by default, modify the two search JSP files search_all.jsp and search_wp.jsp in the installed ecm_help\search directory by deleting the CHECKED parameter from the input element
<td class="searchText"><span class="highlight">Highlight search terms</span>

      <input type="CHECKBOX" CHECKED name="HL"/>

</td>
To remove the Highlight search terms option altogether from the Search page, modify the ecm_help\search\search.properties configuration file by setting the do_hilite entry to false, as in:

do_hilite=false

	153361
	Under certain conditions, multiple items might be highlighted in the online help's TOC. Pass your cursor over the TOC to remove the invalid highlights.

	147322
	(Doc DTS 151841) When the FileNet P8 Documentation is undeployed on Windows 2000 Advanced Server SP4 using the WebSphere 6.0 Administration Console, the application directory cannot be deleted because some of the files exceed the MAX_PATH (256) characters. 
In some Windows installations where NTFS is used for the file system (Not FAT or FAT32), there is a known issue with deleting files (and folders) that are longer than 256 characters. For example, if you use a default WebSphere installation location, you may encounter an error where the FileNet P8 documentation files cannot be properly deleted due to the number of characters in the file/folder names. See the Microsoft Knowledge Base article http://support.microsoft.com/?kbid=320081 for additional information about deleting files (and folders) in this environment. 
Workaround: 
274. Uninstall the P8 documentation site using the WebSphere console.

275. Try to delete the remaining files that do not get deleted by the console.

276. Receive an access denied error.

277. Using the link above, follow the steps in MS Knowledge Base (KB) article 320081.
278. Reinstall the P8 documentation.


Developer Help

	Defect ID
	Description

	146346
	Some P8 Help Table Of Contents topic do not synchronize when certain topics are accessed. The context sensitive help topics are not suppose to synch with Table of Contents (TOC). These context sensitive topics are mostly in Developer help and not require a TOC entry or a synch. Context Sensitive topics are supposed to be opened from the "application". (Doc DTS 146351)

	188586
	Duplicate Object Suppression
During object retrieval of objects that have object-valued properties, it is possible to reach the same object more than once if a property filter forces a recursion. (For example, retrieving a folder and forcing deep recursion through the Parent and SubFolders properties.) This can lead to runaway recursion and excessive memory usage on the server. To prevent this, the server uses a mechanism to suppress recursion into duplicate objects. This duplicate object suppression mechanism overrides the true recursion level and operates as if the maximum recursion level has already been reached for the duplicate object, therefore terminating recursion at a duplicate object. When duplicate objects are detected, an object reference is placed into the response instead of the object value. Duplicate object suppression has the following effects on returned objects:

· If the duplicate object is reached as the value of a singleton property, that property value is returned as an ObjectReference object (instead of an ObjectValue object). 

· If the duplicate object is reached through a collection, it appears as empty (no Properties collection is present). 

The scope of duplicate object detection encompasses each individual top-level component of a response (for example, an individual ObjectResponse within a GetObjectsResponse). Therefore, if an object appears beneath one top-level response element, and then appears beneath a different top-level response element, the second occurrence of the object is not treated as a duplicate. 

Occasionally, an object value is returned for an object that occurs at a high recursion level while other copies of the same object occurring at a lower recursion level are suppressed. Because fewer properties will typically be returned for objects at higher recursion levels, the client may have a copy of the object that has a much smaller subset of properties than was desired. This can result in either additional network round trips to retrieve the missing properties, or errors if the client application does not realize that it is missing properties. When an object reference is returned instead of an object value, it may not be clear to the client application whether this is because of a normal property filter evaluation or duplicate object suppression.

	177872
	Help for Process Administration: Add the following text to online Help topic "Configure with firewalls" under On the Application Engine or web server: 

Since the Application Engine is part of an isolated zone (termed the DMZ), the AE cannot reach the Process Engine directly, it must go to the firewall server first and then go to the PE. To accomplish this, place an entry in the hosts file of the web server that associates the firewall server’s IP address with the fully qualified name of the PE. (Doc DTS 190740)

	180191  
	The System Manager API is not publicly exposed; the FileNet P8 Platform documentation is not accurate in this regard.

	172645
	The Integrating with Workplace > Command Reference section of the Workplace Integration and Customization help should include the folderId parameter for the Select Object (Command 2010) and Select Multiple Objects (Command 2100) commands. 

Use this parameter to specify a folder. If you use this parameter, you must also specify the objectStoreName parameter. (Doc DTS 173422)

	172246
	"Appendix A: Java Servlet Reference" in the Workplace Application Integration help incorrectly documents the following namespace in numerous examples:

http://filenet.com/namespaces/wcm/appint/integration/1.0

All instances of these should read:

http://filenet.com/namespaces/wcm/apps/1.0

	149003
	In the Content Engine Web Services help, the links for the C# and VB CEWS CSS .NET sample code point to the 3.0 versions instead of the 3.5 versions. 

Navigate to the 3.5.0x Developer Samples section of the IBM Information Management support page (www.ibm.com/software/data/support) to find the latest sample code.

	148591
	WCM-related Permission constants are no longer used. 

WCM-related constants RIGHT_ARCHIVE and RIGHT_DEPLOY in the Permission interface are no longer used. However, the constants remain exposed in this release and descriptions of the constants remain in the Content Java API reference help. The constants will be deprecated from the Permission interface in a future fix pack, and references to the constants will be removed from the help text at that time. The constants themselves will be removed from the interface in a future release.

	147342
	The JiGlue files located in the Developer Files directory (on the FileNet P8 Documentation CD in ecm_help\developer_help\process_java_api\Developer Files) are outdated. Use the JiGlue files supplied with the Open Client distribution instead.

	147342
	The documentation topic “Configuring the Process Development Environment” does not include pe3pt.jar in the list of JAR files used for Process Engine development. This JAR file contains third-party classes used by the Process Engine, and is located on the Application Engine host in filenet_installation_directory\Workplace\download.  The topic also lists pw.jar as needed for Process Engine development. This is no longer true. The contents of pw.jar have been merged into the pe.jar and pe3pt.jar files, and pw.jar is no longer used.

	NA
	In the FileNet P8 Developer's Roadmap -> SQL Syntax Descriptions -> "SQL Statement Grammar" topic, the documented grammar for CONTAINS and FREETEXT, as shown below, is incorrect:

 <content_test> ::= ( CONTAINS | FREETEXT ) '(' <property_exp>',' <string_literal> ')' 

The correct grammar is:

 <content_test> ::= ( CONTAINS | FREETEXT ) '(' <property_spec>',' <string_literal> ')'

	NA
	In the "Integrating with Workplace" topic of the Workplace Integration and Customization Guide, the following command 2100 parameters are incorrectly documented.

· The showSelectReleased and class parameters are shown to require label encoding. They do not require label encoding.

·  The selectedObjects parameter is specified as required. It is not a required parameter.

	NA
	The FileNet P8 Developer's Roadmap contains references to Solution Templates and the Case Management API. The Solution Templates and Case Management API are not supported in this release, and those references will be removed from the document in the future.


Help for Workplace Application Integration API Toolkit 

	Defect ID
	Description

	  146339
	The following information is missing from the description of the QuickCheckin command 

After the QuickCheckin command has been executed by calling IAppIntCmd::Invoke, a Checkin response component is returned. Client applications may interact with the Response component via the standard IAppIntRsp and custom ICheckinRsp interfaces. Note that a link to the ICheckinRsp interface is missing from the Table of Contents.

	146336
	The following information is missing from the description of the ShowProperties command 

After the ShowProperties command has been executed by calling IAppIntCmd::Invoke, a pointer to the selected object store item is returned in the ShowProperties response component. This interface enables the client application to obtain information about the object store properties which were shown to the user. Client applications may interact with the response component via the standard IAppIntRsp and custom IShowPropertiesRsp interfaces. Note that a link to the IShowPropertiesRsp interface is missing from the Table of Contents.


Workplace

	Defect ID
	Description

	211470
	In the procedure "To install the IBM FileNet Workplace XT software", a panel description is missing from the setup wizard panel table. This panel, "Configure User Token Security," displays after the "Specify Download Location" panel, and before "User Selections." Description is as follows:

Configure User Token Security

279. If needed, select the check box to create maximum strength keys.By default, this option is not selected and Setup creates limited strength (128-bit) keys. If you select this option, the installer creates 448-bit keys. 

280. Enter the number of keys to use. A large number of keys is more secure.

281. Make a note of the user token crypto key path. The UTCryptoKeyFile.properties file contains the user token cryptography key used by FileNet P8 applications to launch into each other without the need for additional login.

The default User Token Crypto Key file path is:

·   
UNIX - <install_path>/FileNet/Authentication/

· 
Windows - <install_path>\FileNet\Authentication\

282. Click Next.

CAUTION For multiple applications to pass user tokens to each other, each participating application must use the same encryption key file. Copy the UTCryptoKeyFile.properties file installed with Workplace XT to all servers that are hosting a token-sharing application.

	210033
	When running Workplace File Tracker in Windows Vista, an error message appears and you cannot use the Delete local file option. To work around this issue, it is recommended you add the Application Engine(s) on which Workplace is running to the Trusted Sites list in Internet Explorer. You can access this list in Internet Explorer by doing the following:

283. In Internet Explorer, go to Tools > Internet Options.

284. Click the Security tab.

285. Click Trusted Sites and add the Application Engine(s) to the list of trusted sites. (Docs DTS 217655)

	198175
	The following additional information for viewing multi-content files in Image Viewer that include images should have been included in the recent help for Workplace:

If all content elements are images, the multi-content files can be viewed in their entirety in Image Viewer. However, be aware of the following behavior when working with multi-content files that include a mixture of elements that are images and not images:

· If the first element is an image and subsequent elements are not images, a file list will not be displayed and Image Viewer will not render the subsequent elements correctly.

· If the first element is not an image, a file list will be displayed.

	177303
	These Release Notes (in the What's New section) now have lists of features obtained by installing Application Engine Fix Packs from the Fix Pack P8AE 3.5.1-007 readme. As a result, the new SendMail site preference, the subject of the DTS, is now mentioned in that readme. (Docs Defect 198496)

	153654
	The Publishing documentation erroneously suggests proper document rendering is derived from a document's MIME types. However, document file extensions are the key to proper rendering.

	146719
	The following information appears in the Help for Workplace Application Integration API Toolkit documentation, rather than the Help for Workplace Application Integration. 

In P8 3.5.0, FileNet P8 Application Integration provides support for customizing the File, Insert, and Help popup menus of Microsoft® Outlook, Word, Excel, and PowerPoint. FileNet utilizes COM Add-Ins to extend these applications by adding custom Add-In menus. These custom menus can be modified by developers through the use of XML files provided by FileNet, which contain information used by Application Integration to configure the menu contents for the Microsoft applications. For more information on customizing these menus, see the topic “Customizing the File, Insert, and Help Add-In Menus” in the Help for Workplace Application Integration API Toolkit documentation.

	141926
	In some areas of the “My Checkouts” help topic, a question mark “?” appears in place of an em dash.

	133122
	The Workplace topic "Keep alive interval" (FileNet P8 Documentation > Workplace > Admin Tools > Site Preferences > General Preferences > General Settings – Application) should contain more information about the application server's session timeout setting. The entire rewritten topic follows:

Keep alive interval

The Keep alive interval preference determines the interval between HTTP keep-alive signals sent from Java applets or a form workflow to the Application Server. Process Tracker, the designer applications, and form workflows (available only if FileNet P8 eForms is installed and enabled) are Java applets. While you are working in an applet, a signal is sent at regular intervals to the server to maintain your session connection so that you do not need to sign in to Workplace again.

To change the interval, type the number of minutes (from 1 - 60) in the Keep alive interval box. The default is 5 minutes. 

The keep-alive interval should be less than the Application Server session-timeout interval so that the applet remains alive and connected. For example, if you set the interval for 10 minutes, every 10 minutes the applet will send a keep-alive signal to keep its JSP session alive. The applet will remain alive and connected until the user terminates the applet.

The session timeout value for Workplace is set in the session-config element of its Servlet descriptor (web.xml) file:

<session-config>
  <session-timeout>minutes</session-timeout>
<session-config>

The application server reads this value when the Workplace web application is launched. The default value depends on the application server, but is generally between 30 and 60 minutes. Note that some application servers may use a special value as a default that instructs the application to use a different timeout value set in a different configuration file. 

On busy sites, you can tune your application by adjusting the timeout of sessions. While you want to allow a browser client to finish a session, you do not want to tie up the server if the user has abandoned the session.
Some other reasons that you might change the <session-timeout> default value are:

· Users in secure environments might need shorter session timeout periods to ensure security, in case they leave their machine and forget to log off the console. 

· Users might need longer session timeout periods if they respond slower than typical users for accessibility reasons. 

· Users in secure environments might not want the administrative console timeout value to conflict with Lightweight Third-Party Authentication (LTPA) cookie timeouts.

See your Application Server documentation for more information on the JSP session timeout interval.

	744541
	When inserting an object store item as a hyperlink in an Outlook item, the fully-qualified URL for the hyperlink is displayed. The Insert procedures help topic incorrectly states that the Document Name assigned to a document being inserted, is displayed in the URL. (Docs Defect 746855)


 eForms Designer

	Defect ID
	Description

	185718
	The eForms Designer Help contains information about supporting the Autoshrink feature for Desktop eForms only. It does not contain information about supporting FileNet P8 eForms, which was introduced in eFD-5.0.0-004.


FileNet P8 Portlets 3.5.1 Readme and Installation Guide
	Defect ID
	Description

	167821
	Step 8 of the "Before you install" section of the Portlet Readme has a minor inaccuracy. Currently it says: "Make sure that the Application Engine has already been configured for bootstrap preferences." 

It should say:  "Someone must have already signed into Workplace on the Application Engine and set the initial Workplace bootstrap preferences."

Similarly:

The FileNet P8 Portlets Installation and Upgrade Guide for WebLogic, Release 3.5.1 (December 2005), step 6 of the Prerequisites should say: "6. Someone must have already signed into Workplace on the Application Engine and set the initial Workplace bootstrap preferences."

The FileNet P8 Portlets Installation and Upgrade Guide for WebSphere, Release 3.5.1 (December 2005), step 7 of the Prerequisites should say: "7. Someone must have already signed into Workplace on the Application Engine and set the initial Workplace bootstrap preferences."

	160783
	In the Configure Workplace Customizations section of the FileNet P8 Portlets Installation and Upgrade Guides for WebLogic and WebSphere, the filename mentioned as customobject.properties, is incorrect and should be customobjecticons.properties. 


Installation/Upgrade Guide

	Defect ID
	Description

	745010
	The existing 3.5.x RE install / upgrade guide has a section on Removing the RE installation.  This includes uninstalling the product, removing the print driver, and running the VistaClean utility.  However, the current instructions only cover uninstalling the P8 Rendition Engine 3.5.1 product from Add/ Remove programs list.  There are occasions where the Add/ Remove program list will have a related product named 'Vista' which will also need to be uninstalled.  Vista is the Liquent Render Perfect installed product name.  Without removing this piece, it would not be a clean uninstall of the product.

	214176
	The 3.5.x FileNet P8 Platform Installation and Upgrade states that Process Engine software can be installed by leaving the Oracle Index tablespace blank, forcing use of the data tablespace for indexes. This is incorrect.

As a workaround:

Provide a name to the Process Engine setup program when prompted for an index tablespace name. (Docs DTS 215309)

	199326
	In the current CFS-CS Install Guide section called Install CFS Federator, the table row documenting the install panel "IBM WebSphere Information Integrator Content Edition Configuration" has an incomplete example in step c. The example should say: 

For example, let


vbr.configuration.server.lookup.urls= rmi://localhost:1250/ConfigurationServer


Session pool name in IICE Admin Tool = SessionPool


Then the session pool URL is rmi://localhost:1250/SessionPool"

	179776
	In several places in the CFS-NTFS Install Guide, there are references to the FileNet P8 Content Federation Services for Content Services / NTFS Installation Guide for IBM II CE for instructions on installing and configuring extended connectors. IICE 8.3 interim fix 0011 obsoletes the need for these extended connectors. The IBM II CE guide has been updated to remove the procedures having to do with extended connectors, and also to include instructions for applying IICE 8.3 interim fix 0011. Follow the instructions in the IBM II CE guide to obtain the appropriate IBM II CE patch, and disregard any references in the CFS-NTFS Install Guide to the extended connectors.

	178226
	The CFS-CS Installation Guide does not document silent install instructions. Use the following procedure for a silent install.

Silently Install FileNet CFS-CS

Out of the box, FileNet P8 3.5.x supports a new (not an upgrade) silent installation of CFS-CS on all FileNet P8-supported platforms.

Prepare to launch the CFS Federator silent install the same as you would a user-interactive (UI) install. The procedures in this section assume that you have already followed the steps in “Install and deploy IBM WebSphere II CE 8.3” on and “Create the Federator database and user” in the CFS-CS Installation Guide.

Prior to launching a silent CFS Federator install, modify the silent-install response file, as described in the next section.

Install CFS Federator silently

286. Log on to the CFS server with the following permissions:

· Windows: user who is a member of the local Administrators group.

· UNIX: user with write access to the /bin directory and read, write, and execute access to the directory where you plan to install CFS Federator.

287. Insert the FN CFS Fed Admin and Exporter 3.5.x CD in the CD drive of the CFS server.

288. Copy the file federator_silent_input.txt from the AE installation CD to a local directory.

289. Open federator_silent_input.txt in the local directory with any text editor, edit it according to the instructions in the file itself, and save your edits.

290.  (Windows only) Open a DOS command-prompt window.

291. Change your current directory to the CFS Federator installation CD directory, and execute the following command:


Windows:



E:\Winfederator_setup.exe -options "<response_file_path>\Federator_silent_input.txt" -silent



where E: is the drive assigned to the CD, and <response_file_path> is the directory path to federator_silent_input.txt:


UNIX:



<directory of CD media>/<platform>setup.bin -options “<response_file_path>/federator_silent_input_UNIX.txt” -silent


with these substitutions:



the directory path to the installation CD in place of <directory of CD media>



the directory path to federator_silent_input_UNIX.txt in place of <response_file_path>



one of the following strings in place of <platform>, depending on your UNIX operating system.




AIX




SOLARIS

NOTE Although the command above spans more than one line, type it without carriage returns.

Check the file federator_install_log_3.5.0.txt located at <CFS_install_path>/FileNet to see if any errors occurred during the installation.

Complete the additional tasks as described in the section “Configure Federator database” in the CFS-CS Install Guide.

	175082
	The CFS-CS Installation Guide should contain the following note in the procedure "Deploy Federator Admin (WebSphere):

NOTE When IICE v8.3 is installed on WebSphere 6.0 and the VeniceBridge.ear application is deployed manually, the vbr_access_services.jar needs to be copied from the directory  <WAS_Home>/profiles/<Node_Name>/installedApps/<Cell_Name>/VeniceBridge.ear to the <IICE_Home>/lib directory.

	167745
	The readme for the FileNet P8 3.5.1 Service Pack is missing information on the Application Engine Installer. After the "Choose an application server" screen is displayed, a new screen is displayed. The "Stopping Windows Task Manager Service" screen is displayed for 60 seconds. You cannot dismiss this screen.

	165493
	[165508] The installation instructions currently contain an incorrect code sample for Sun Java application server configuration.
The instructions on how to update the Sun Java application server server.policy file are incorrect, causing a server startup error. The last entry in the code sample is missing a semicolon after the java.security.AllPermission entry. The correct code sample is as follows: 
grant codeBase "file:${com.sun.aas.instanceRoot}/applications/j2ee-modules/Workplace/WEB-INF/-" {
permission java.security.AllPermission;
 }

	153446
	The System Manager Dashboard documentation omitted information for uninstalling the product. Use the following procedures to uninstall. 
Note You must have sufficient privileges to perform an uninstall. 

Windows uninstallation procedure: 
1. Click Start > Settings > Control Panel > Add/Remove Programs. 
2. In Add/Remove Programs, click Change or Remove Programs. 
3. In the list of Currently Installed Programs, select FileNet System Manager Dashboard. 
4. Click Remove. Refer to your Microsoft documentation for more information. 

UNIX uninstallation procedure: 
1. Navigate to <install_location>/_unist. 
2. Run uninstaller.bin. 
Note If you need to specify the JVM location, run the following instead:

uninstaller.bin -is:javahome <jre_location> 

For example, if your JRE is located at /opt/java1.4.1/jre, run the following command: 

uninstaller.bin -is:javahome /opt/java1.4.1/jre  

	NA
	Windows Server 2003 Service Pack 1 may now be installed on any machine running FileNet P8 components. For more information, see the topic "Configure a FileNet P8 environment for Windows Server 2003 SP1" in the FileNet P8 Platform Installation and Upgrade Guide. Download the current version of this document from the the IBM Information Management support page (www.ibm.com/software/data/support).


Shutdown and Startup

	Defect ID
	Description

	173257
	(Doc DTS 174480) When WebSphere 5.1.1.3 with IICE 8.3 on a Solaris server is installed, the LD_LIBRARY_PATH environment variable in the file "config.sh" file is incorrect (see below). This causes server startup errors. The workaround for this to correct the variable and source the "config.sh" file from within the server startup script "startServer.sh".

Original Setting:
LD_LIBRARY_PATH=$VBR_HOME/datastore:$VBR_HOME/htmlconverter:/usr/X11R6/lib:$LD_LIBRARY_PATH
export LD_LIBRARY_PATH

Modified Setting:
LD_LIBRARY_PATH=$VBR_HOME/datastore:$VBR_HOME/htmlconverter:/usr/X/lib:$LD_LIBRARY_PATH
export LD_LIBRARY_PATH

	148868
	Application Engine requires that the Application Name property be indexed on the object store that contains site preferences to improve login performance. This step is missing from the installation and upgrade instructions. To properly index access roles and improve login performance on Application Engine, you must create an index for Application Name on the object store that contains the Workplace site preferences. Do this after you have installed Application Engine and configured the bootstrap preferences.
292. On the Content Engine, launch the FileNet Enterprise Manager.
293. In the left pane, expand the Object Stores folder.
294. Expand the object store node where your preferences are stored (specified on the bootstrap preferences page).
295. Expand Other Classes and then Custom Object.
296.  Right-click Access Role and select Properties.
297. Select the Property Definitions tab.
298. Select Application Name and click Edit.
299. On the General tab of the Application Name Properties, if the Indexed field shows 'not indexed', click Set/Remove.
300. Select Set and then Single Indexed.
301. Click OK to set the index. 
302. Click OK to Apply the change and close the Application Name Properties window. 
303. Click OK to close the Access Role Class Properties window.

	148285
	An additional step is required when enabling the Process Engine Component Integrator if the Application Engine uses maximum strength symmetric encryption. 

If the Application Engine is configured to use maximum strength symmetric encryption the JRE used to run the Process Task Manager that contains the Component Manager (which uses JDK 1.4.x) must be updated with Unlimited Strength Jurisdiction Policy Files.

To install unlimited strength .jar files:

304. Obtain the unlimited strength .jar files.

· Sun JDK 1.4 - Obtain the Sun unlimited strength policy files from the Sun product web site (http://java.sun.com/products/jce).

· IBM JDK 1.4 - Obtain the IBM unlimited jurisdiction policy files from the IBM web site (http://www.ibm.com/developerworks/java/jdk/security).

305. Install the files into the following folder by replacing files with the same names.

<AE_install_path>\FileNet\Router\JRE\lib\security

	146962
	An additional step is required when joining an upgraded Content Engine server to a FileNet P8 domain. 

Do the following as the last step in joining an upgraded Content Engine server to a FileNet P8 domain, immediately before step 2 of the procedure "To join a FileNet P8 domain" in the FileNet P8 3.5.0 Installation and Upgrade Guide topic "Upgrade Content Engine":

Manually copy the Windows registry key HKEY_CURRENT_USER\SOFTWARE\FileNet\ECM\Content Engine\VWServicesBak to the key HKEY_LOCAL_MACHINE\system\CurrentControlSet\Services\VWServices.


Process Engine

	Defect ID
	Description

	754451
	The following PE topics reference the FileNet CSS web site. They should instead reference the IBM Information Management support page at http://www.ibm.com/software/data/support (or http://www-1.ibm.com/support/docview.wss?rs=0&dc=DA400&q1=P8&uid=swg27010422&loc=en_US&cs=utf-8&cc=us&lang=en to go directly to the P8 Platform documents).

· FileNet P8 Hardware and Software Requirements

· Security Questionnaire (web)

· Shutdown and Startup Procedures for the FileNet P8 Platform Components

· Deployment Guide (web)
· Troubleshooting (web)

	
	





	745011

	The following information is missing from step 4 of the topic 'DbExecute system function' in the online Help for Process Designer:

Any database stored procedure that will be called by a System step must have all of its parameters declared as follows:

 * out - SQL Server

 * in out - Oracle

 * inout - DB2

When the parameters are set, the stored procedure can update their value. The stored procedure will return the (possibly updated) values of all parameters to the caller. The updated values will be reflected in values stored in the data fields that were passed in as parameters to the stored procedure. 

	213979
	Process Engine on HP-UX and AIX platforms cannot be uninstalled as documented.  The FileNet P8 Platform Installation and Upgrade Guide for the 3.5.x release directs the user to execute the  /tmp/setup_dir/uninstall script.  This script is not executable.  The user should instead execute the /fnsw/etc/uninstall script. (Doc DTS 214212)

	204018
	In the online Help for Process Designer, the 'About setting a time limit for processing' topic contains an incorrect description of how processing resumes after the expiration workflow map completes. That description should be replaced with a link to the topic 'About return from a called workflow map' which provides detailed information.

	
	

	
	


Content Engine

	Defect ID
	Description

	686831
	(Active Directory only) If you have groups created at the domain local level, users registered with a Windows domain controller that is not directly configured for authentication in Content Engine will receive "access denied" errors. This is the expected behavior of Windows Active Directory.

Consider a multi-domain FileNet P8 installation containing two Windows domains, NW and SW, where Content Engine points to the NW domain controller for authentication. There is a domain local group in the NW domain that contains users from the SW domain. Users logged in at a client station registered with the SW domain controller will receive an "access denied" error when logging on to an object store. However, the same user on a machine registered to the NW domain controller will be able to logon. 

To resolve this situation, create a universal group in either domain controller that contains the domain local groups, and add this universal group to the Security tab of the object store's property sheet.

	212313
	Alternative to running the consistency checker immediately after moving a file store

The Move File Store wizard automatically runs the consistency checker after moving a file store. Depending on the size of the file store, the consistency checker can take hours or days to complete.

As an alternative to running the consistency checker immediately after moving a file store, you can perform the following steps to get the system back in production within a reasonable timeframe. These steps supplement the instructions in the “Restore data on another server” topic in the FileNet P8 Documentation. These steps do not detect any inconsistencies that existed prior to the move. You can subsequently run the consistency checker at your convenience to provide a complete validation of the documents in the object store and corresponding content elements in the file store.

Before the move

Using the appropriate database tool, find and note the number of rows in the docversion and annotation tables on the source system using the following SQL commands:
    select count(*) from <tablespace>.docversion
    select count(*) from <tablespace>.annotation
During the move

306. Back up the database and the file stores at the same time to minimize the chances of inconsistencies. 

307. Check the backup logs to verify that no errors occurred during the backup of the database or the file content. Before continuing, resolve any errors encountered in conjunction with the vendor of the backup software.

308. Restore the database and file content intact to the new server(s).

309. Again, check the logs to verify that no errors occurred during the restore of the database or the file content. Before continuing, resolve any errors encountered in conjunction with the vendor of the backup software.

After the move

310. Check that the files exist on the new storage device using vendor-specific tools. There are many ways you could do this; for example, for a file system-based file store, you could write a script to compare the directory structures and number of files in each directory on the source and destination servers.

311. Again using the appropriate database tool, find and note the number of rows in the docversion and annotation tables on the destination system using the following SQL commands: 
    select count(*) from <tablespace>.docversion
    select count(*) from <tablespace>.annotation
Compare the results with those you noted above on the source system.

312. Compare the security on the parent (shared folder), the file store root folder (FS_<filestore>) and at least one of the subfolders of both the source and destination systems to ensure that access rights were retained in the backup and restore. Verify access to the share on the parent folder of the destination system. Compare access rights on the Area.sf file in the FS_<filestore> folder and at least one of the files in the file store with access rights on the same files in the source system to ensure that file permissions have been retained.

313. Once you are satisfied that the data was restored successfully, test the basic functionality of the file store. At a minimum, perform the following actions:

· Add a new document to the file store.
· View a document that existed in the file store prior to the move. 
· Check out and check in a document that existed in the file store prior to the move. 

	196233
	The P8 help Search might return some false-positive results when searching on phrase in quotes. The matches might not have the text together as a phrase in the file. This is an internal issue with Lucene 1.4.2.

	199903
	Several Content Engine backup topics incorrectly say that you cannot use XCOPY for backing up or moving a file store. The documentation should say: "If you use XCOPY, use the /E, /K, and /O options to copy empty directories and to preserve file attributes, file ownership, and security (ACL) information. Do not use Windows Explorer." (Docs DTS199595)

	181156
	The documentation for the Content Consistency Checker indicates that it checks for "unreferenced files". In fact, the Content Consistency Checker only checks whether files which are referenced in the database exist in the filestore. It does not go the other way to ensure files in the filestore are referenced in the database.

	180567
	Currently, FileNet P8 Platform documentation does not explain how to change the IP address of a machine hosting a Content Engine server, even though it is possible to make this change. This omission will be corrected in a future documentation update.

	149132
	Instead of the example of the Centera pooling map.xml file  on the help topic page Content Engine Administration > FileNet P8 domain > View/modify P8 domain properties > Fixed Content Devices General tab, you should refer to the example on the help topic page Content Engine Administration > Content Stores > Fixed file stores > About EMC Centera.


An advanced technique is to write the XML to a UNICODE file (make sure you prefix the XML with ‘sitemap’), and then set the Centera connection string to the file name (with ‘file:’ prefix). For example, if you copy the map file named "map.xml" to ‘C:\temp’, you would set the Centera ConnectionString to ‘file:C:\temp\map.xml’.

	147825
	Instructions for creating a new style file collection are incorrect. 

The topic "Specify CBR Language" (FileNet P8 Administration > Content Engine Administration > Content-based retrieval > How to... > Specify CBR Language) has a path error in the second step of the procedure to create a new style file collection. The second step should say: "Copy the contents of the FileNet\Content Engine\Verity\common\style directory to the new folder."

	146675
	The following information on creating and using custom events is missing. 

In order to create a custom event in Enterprise Manager, a user must create a subclass of the CustomEvent class, which is the base class for all user-defined custom events. Once you have created a custom event and refreshed the object store, you can select it from the available events list box when you create a subscription on a class or object.


Content Federation Services (for CS and NTFS) CFS 

	Defect ID
	Description

	556098
	The FileNet P8 Content Federation Services for Content Services / NTFS Installation Guide for IBM IICE, Release 3.5.x, Task 5a: Deploy WebSphere IICE (WebLogic), on page 12, paragraph 2d states "Skip step 8, as subscription event services are not installed." This paragraph should state that even though subscription services are not required, the vbr_subscription.jar file must be copied over from the IICE_HOME/opt folder to the IICE_HOME/lib folder.

	556402
	The IBM FileNet P8 Content Federation Services Installation and Upgrade Guide does not provide information about configuring the CE Connector for Include System Properties. 
Workaround: When you configure the CE Connector, set the property name Include System Properties to False. (Docs Defect 757229)

	556024
	The CFS Installation Guide did not make it clear that II CE subscription event services must be configured in order for logins via SSO to work properly. 

You must copy vbr_subscription.jar to <CFS_install_path>/FileNet/CFS/FedAdmin/WEB-INF/lib/ for Federator Administration application to work, even though FileNet CFS software does not use subscription services, due to interdependencies among the II CE JAR files.

Perform the additional configuration requirements for your application server, as follows

WebSphere 

You must configure Subscription Event Services in order for users to login using SSO by performing the following procedure:

To create IICE shared libraries

1. Log on to the WebSphere Administration Console on the application server where IICE is deployed.

2. Navigate to Environment > Shared Libraries.

3. Click New.

4. Enter the following shared library name: iiceSubscription

5. Provide a class path to the datastore. For example: C:\Progra~1\IBM\WebSphereIICE\opt\vbr_subscription.jar.

6. Apply and save changes to the Master Configuration file.

7. Navigate to Applications > Enterprise Applications

8. Select IICE application.

9. Click on Libraries under Additional Properties

10. Click Add.

11. Select iiceSubscription library name from drop-down list.

12. Click OK.

13. Apply and save changes to the Master Configuration file.

14. Restart WebSphere application server.

WebLogic

You must install and configure Subscription Event Services in order for users to login using SSO.

The file vbr_subscription.jar must be in the <IICE_HOME>/ejb directory when the EAR is being created. This can be done manually after install or during install by selecting the option to install Subscription Event Services.

You must also configure WebLogic for subscription services. 

· WebLogic 8.x: See the topic " Configuring subscription event services for WebLogic application server, Version 8.1" located at http://publib.boulder.ibm.com/infocenter/wsiihelp/v8r3/topic/com.ibm.websphere.ii.product.ce.doc/configuring/iiyviigseswblgc.htm. 

· WebLogic 9.1: Instructions for configuring subscription services are in the IBM WebSphere Information Integrator Content Edition Version 8.3 Fix Pack 2 Readme. (Docs Defect 556041)

	390964
	In the Caching section of Chapter 5, the CFS-IS Guidelines document for CE 3.5 states that Image Services software can be installed on the Content Engine. However, P8 does not support this configuration. 

The P8 Platform Hardware & Software Guide states that P8 cannot be collocated with any IM Components, including Image Services software.

	176274
	The CFS-CS Install Guide does not include startup and shutdown procedures. The procedures are as follows:

Starting Up and Shutting Down CFS-CS

This topic explains the sequence you should follow when starting up or shutting down CFS-CS. If you are not using CFS-NTFS with your CFS-CS installation, skip Step 6.

CFS-CS Startup Sequence

314. Start all P8 engines according to the procedures in the P8 Platform online help.

315. Start the Federator Database. This may be located in the same RDBMS used by the Content Engine, in which case it is likely already running.

316. Start the IICE Server.

317. Start the RMI Bridge or Bridges.

318. Start the CFS Importer Service.

319. Start any Capture processes (applies only if you are also using CFS-NTFS).

CFS-CS Shutdown Sequence

The shutdown sequence is the startup sequence, above, in reverse order.

Please add the following to the Documentation Known Issues section for CFS-NTFS (in the 3.5.x Release Notes)

The CFS-NTFS Install Guide does not include startup and shutdown procedures. The procedures are as follows:

Starting Up and Shutting Down CFS-NTFS

This topic explains the sequence you should follow when starting up or shutting down CFS-CS. If you are not using CFS-CS with your CFS-NTFS installation, skip Step 2 and Step 5.

CFS-NTFS Startup Sequence

320. Start all P8 engines according to the procedures in the P8 Platform online help.

321. Start the Federator Database. This may be located in the same RDBMS used by the Content Engine, in which case it is likely already running. (Applies only if you are also using CFS-CS.)

322. Start the IICE Server.

323. Start the RMI Bridge or Bridges.

324. Start the CFS Importer Service. (Applies only if you are also using CFS-CS.)

325. Start any Capture processes.

CFS-NTFS Shutdown Sequence

The shutdown sequence is the startup sequence, above, in reverse order.


Security 

	Defect ID
	Description

	196884
	As of 3.5.2, Novell eDirectory's Country (C) container type is supported by Content Engine, but not by Process Engine. As a result:

· Content Engine supports Country (C), Organization (O), Organizational Unit (OU), Domain (DC).
· Process Engine supports only Organization (O) and Domain (DC).

	147496
	The table of contents entry for "Enterprise-wide Administration > Security > Reference > Required minimum access rights" loads the wrong topic (it loads the Suggested Reading topic). 

In order to load the “Required minimum access rights” topic, you can issue a documentation search (by clicking Search in the FileNet P8 documentation blue bar) for "Required minimum access rights" (using the quotes).

Note that there is a stand-alone PDF rendition of Security Help available on the IBM Information Management support page (www.ibm.com/software/data/support). This rendition includes a table of contents that accurately loads the "Required minimum access rights" topic.


CE API  

	Defect ID
	Description

	759589
	The query syntax has been extended to allow the use of FULLTEXTROWLIMIT in the OPTIONS clause. The new syntax description for query then would be:

<query> ::= <SQL query> [ OPTIONS '(' <option> { ',' <option>  } ')' ]

<option> ::= ( BATCHSIZE | TIMELIMIT | FULLTEXTROWLIMIT ) <integer>





       

The FULLTEXTROWLIMIT value will limit the number of rows returned from the full text indexing software. The result set of a full-text query will never contain more than the number of results indicated by the <integer> argument. The default setting is 1000.

A DWORD registry value can be used to override this default: HKLM\SOFTWARE\FileNET\ECM\Content Engine\Content Search\Verity Max Docs.

When you specify a FULLTEXTROWLIMIT value in an OPTIONS clause, the FULLTEXTROWLIMIT value will override both the default setting and the registry setting, for that query only.

If the FULLTEXTROWLIMIT value is specified and is zero, the maximum number of rows returned is unlimited.


Miscellaneous

	Defect ID
	Description

	390558
	Task 20 of the Records Manager Installation Guide is incorrect. On page 96: "To subscribe to the LastRetrievalOfRecord event" heading states to use the File event. It should say to use the Create event.

	366773
	The "Update the book indexes" topic in the "Localizing and Customizing FileNet P8 Help" technical notice is obsolete since the help system no longer provides an index.

	
	

	181427
	The Process Reference documentation incorrectly states that exposing the F_EnqueueTime system field on the event log is not required for Process Analyzer functionality. It is required for Process Analyzer.

	164584
	For instructions on installing the latest Content Engine Service Pack in a Microsoft or VERITAS cluster, see the FileNet P8 High Availability Technical Notice, which is located on the IBM Information Management support page (www.ibm.com/software/data/support)

	NA
	In the Help for Enterprise-wide Administration > FileNet System Manager documentation, the section “Activating the System Manager Listener” should read as follows:

In order for the System Manager to be able to obtain data from a server, there must be an active Listener. Most FileNet products which support the System Manager functionality (Content Engine, ISRA, etc) enable the Listener (make it active) by default. However, on an Image Services or Process Engine server, the following steps must be performed to activate the Listener:

326. Navigate to /fnsw/lib/perf/. 

327. Open the file perf_mon.script. 

328. In the file, locate the statement: 

poll /fnsw/local/sd/1/perflog

and insert "set Listener true" directly above it: 
329. Save the changes and close the file. 

330. Restart the server.


Resolved Known Issues

Resolved in P8CE-3.5.2-008

	Defect ID
	Description

	208453
	When viewing the native content of CFS federated documents in Workplace, if the document has large native content, the operation timed out depending on how large the file size is.


Resolved in P8CE-3.5.2

	Defect ID
	Description

	171413
	When Content Engine is configured for Active Directory authentication, the CE 3.5.1 Service Pack installer does not properly install the software that sets up the necessary service principal names to allow .NET clients of Content Engine Web Service to authenticate using a .NET Web Service Enhancement KerberosToken2 (in place of the normal UsernameToken). This error is resolved with the installation of CE 3.5.2 Service Pack.  (Doc DTS 171502)  

	163778
	The Installation Guide, in the Appendix titled "Configure a FileNet P8 environment for Windows Server 2003 SP1" incorrectly stated that XA transactions are not required. They are in fact required for installations using DB2 as their database. This requirement was correctly described in the 3.5.2b version of the Installation Guide, dated August 2006, and subsequently.


Resolved in P8CE-3.5.1-001

	Defect ID
	Description

	168145
	Intermittent internal server errors (HResult [0x8004021f]) can occur when setting annotation or document content on an object store for which the underlying database is Oracle. A timing issue exists that can be resolved by setting a registry entry that will automatically retry the operation. For more information, refer to "Enabling retries on set content failures" in the Content Java API Developer's Guide or the Annotation and Document interfaces reference help for the setContent method.


Resolved in P8PE-3.5.3

	Defect ID
	Description

	195164
	Problem: When updating an eForms Workflow policy to use an updated version of a workflow map, an "Invalid Parameters" error occurs.

Cause: The FileNet-provided Malfunction workflow map contains an unnamed start step; eForms Workflow policy requires that all steps be named.

Solution/Workaround: The vwbase.cdl file that defines the base workflow definition has been updated to provide names on all steps in default workflow definitions. Existing workflow definitions (created using Process Designer 3.5.x) can be updated using the following steps:

331. Obtain the updated vwbase.cdl file from the IBM Information Management support page (www.ibm.com/software/data/support) and install it on the Process server in the following location: 
· (Win) c:\FNSW_LOC\SD, 

· (UNIX) /fnsw/local/sd. 

If your vwbase.cdl file has been customized, merge the changes into your existing file.

332. Use vwtfer to transfer the merged vwbase.cdl to the isolated region using the following command in the directory containing vwbase.cdl:

vwtfer -o vwbase.cdl -r <region_num> 

333. Open each affected workflow in Process Designer and retransfer it to inherit the changes. 

All subsequently created workflow definitions will inherit the correct Malfunction map and Terminate map.

To update a workflow definition with an overridden Malfunction or Terminate map, do the following:

334. In Process Designer, open the Malfunction map and enter a name for the first step on the map.

335. Open the Terminate map and replace the instructions with a System step that contains the instructions. 

It is not possible to modify the step names in active workflows. (doc DTS 196980)


Resolved in P8PE-3.5.1-002

	Defect ID
	Description

	164636
	Process Simulation and Process Orchestration will fail on an Oracle Application Server, running on Unix platforms. The failure is due to missing permission settings for the Oracle Application Server user, “oracle”, belonging to the “others” group. The “others” group must have read/write permissions on the P8BPMWSBroker.properties file located in: (Doc DTS 164648)

<AE_install_path>/FileNet/Workplace/WEB-INF (Default: /opt/FileNet/Workplace/WEB-INF)
To set the correct permissions for the “other” group take the following steps:

· Change the permission for “others” group to read/write: 
# chmod 666 P8BPMWSBroker.properties

· Restart the Oracle Application Server.

· Verify the modified permissions for the “others” group:
 # ls -al P8BPMWSBroker.properties 
--rw-rw-rw- 1 username groupname filesize Month Date TimeP8BPMWSBroker.properties
Where:
1 = levels of subdirectories (for files, this is by default one)
username = The owner of the file.
groupname = The group the file belongs to.
filesize = Filesize.
Month Date Time = Date/time the file was last modified.
P8BPMWSBroker.properties = Filename.


Resolved in P8AE-3.5.1-010

	Defect ID
	Description

	205337
	A multi-content document that contains TIF and PDF files does not open correctly when a TIF file or any type of image file is selected as a primary file. Work around this issue by doing the following:

336. In content_redir.properties, use the {no_multi_elements} parameter.

337. If you want to open multi-content documents and want to see a list of the document elements, add the {no_multi_elements} parameter to the end of the redirect url:image/tiff=/WcmJavaViewer.jsp?{QUERY_STRING}{no_multi_elements} in the content_redir.properties.

338. Any element in the multi-content document regardless of a mime type being different from the primary’s mime type. (Doc DTS 213420)


Resolved in P8AE-3.5.1-009

	Defect ID
	Description

	199507
	The Workplace topic "Choice list size" (FileNet P8 Documentation > Workplace > Admin tools > Site Preferences > General Preferences > General Settings – Display > Choice list size) incorrectly states the maximum number of choice list elements to be 1000. The maximum is in fact 5000. However, the Caution at the bottom of this topic should also have warned against configuring excessively large numbers of list items, which can cause Workplace performance and display issues. (Doc DTS 199509)

	198100
	When a multi-content document containing files using Chinese characters is downloaded or emailed as a ZIP file from Workplace, the ZIP file cannot be extracted because the file names of the content will become corrupted as "???". These are not recognized in Windows. The workaround is to download each file individually. Target release is P8AE-3.5.1-009.


Resolved in P8AE-3.5.1-001

	Defect ID
	Description

	164923
	(Doc DTS 164923) After upgrading to Workplace 3.5.1, an ‘Out of Bounds’ error occurs when you execute a 3.5.0 simple search configured to include all five properties. To work around this error, click Modify on the simple search page, and then click Accept. The error no longer appears.

	148286
	The create time and last modified time are displayed incorrectly in Workplace when the client browser is set for daylight savings time. The time is displayed as GMT instead of the user's correct Daylight Savings Time.(Doc DTS 148461)

	146167
	When the current Image Viewer session times out on the server, you cannot continue to work with annotations. An error message may be displayed that mentions an internal server error or a 500 error. For best results, make sure that you keep a Workplace window open when working in Image Viewer, and be sure to save your work after a few minutes. Your system administrator determines the session time out settings.


Resolved in P8AE-3.5.1

	Defect ID
	

	138570
	When uninstalling the Application Engine, the app_engine.war is not removed. 

To complete the removal you must manually delete the Workplace folder or the file itself from:

· UNIX - <AE_install_path>/FileNet/Workplace/
· Windows - <AE_install_path>\FileNet\Workplace\(Doc DTS 147823)

	138669
	Security for non-admin users with Deny access does not work as expected. If you add a non-admin user to the access control list (security) for an annotation and explicitly deny the user all access, then that non-admin user is removed from the list of users assigned for that annotation. The non-admin user permissions for the annotation are changed from 'Deny all' to 'View content and View properties', which is the default for #Authenticated-Users.


Resolved in P8CFS-3.5.1-002

	Defect ID
	

	202373
	If a federation rule name contains an apostrophe (for example, Tester’s Rule ), the rule cannot be rescheduled by clicking the Rescheduled link in the Federator Administration interface. The user must select the rule checkbox and use the drop-down action menu to reschedule the rule. (docs FNDTS00202373)


Fixed in Service Pack SP1 (Content Java API)

	Defect ID
	Description

	119133
	The AuditDefinition and AuditDefinitions interfaces have the wrong inheritance. They do not currently extend the BaseObject and BaseObjects interfaces, respectively, but will in a future release.


Resolved in the release of 3.5.0a media

Application  Engine

	Defect ID
	

	148759
	The AIX installer corrupts ODM when installing the Application Engine. Perform the following steps to fix the corruption to the ODM. 

To check if the ODM has been corrupted perform the following commands:

339. Run the ‘lppchk -v’ command to check for ODM corruption, if corruption exists then proceed to step 2.
340. If there is a corruption the output looks like this:

hq-cfgaix2# lppchk -v

lppchk: A lexical error occurred for cff533ab82241cffa2d9b211bef6f7f3 3.1.0.0

on line 1, column 10.

There is an illegal number: 4f.

Use local problem reporting procedures.

lppchk: The following filesets need to be installed or corrected to bring

the system to a consistent state: 

cff533ab82241cffa2d9b211bef6f7f3 3.1.0.0 (UNKNOWN)

341. To clear the ODM corruption, run the following command (using the above output as an example):
hq-cfgaix2# ODMDIR=/usr/lib/objrepos odmdelete -o product -q "lpp_name = cff533ab82241cffa2d9b211bef6f7f3"

342. Run the InstallShield Uninstaller for the Application Engine.

343. Install the Application Engine using the Application Engine 3.5.0a AIX media. 
If you are upgrading to version 3.5.0 follow the existing upgrade procedures, and then run the above steps.


Process Engine

	Defect ID
	

	160755
	In the Process Administrator, an out of memory error can occur when the number of items returned by a search is too great. This is most likely when the search mode is set to Edit (all fields) and the option "Max returned per set" is greater than 1000. The symptoms of this problem are as follows:

· A long delay in displaying the work items matching the search criteria. 

· Not all the work items returned as expected. 

· A dialog with nothing in it except "VWResource.s"

To reduce the likelihood of this problem, the option "Max returned per set" should be less than 1000.

	156978
	When you transfer a workflow that contains a rule-set definition, the transfer takes substantial time, and the rule-set is not created in the rules repository.  

Solution: The classpath to the Rules Engine is incomplete. Use the following steps to correct the classpath:

344. On the Process Engine, edit taskman.properties using a text editor.
FNSW\BIN\taskman.properties

345. For Windows, add the following to the RulesEngine classpath:
c:\\ilog\\jrules46\\lib\\sdm.jar

For Unix, add the following:
/opt/ILOG/JRules46/lib/sdm.jar (Doc DTS 158852)


Resolved in 3.5.0c update of FileNet P8 Documentation

	Defect ID
	Description

	187287
	The Overview topic of the Content Java API Developer's Guide for release 3.5.2 contains incorrect references to release 3.5.1. These references will be removed and replaced with appropriate text in the next documentation refresh.

	148730
	The Shutdown and Startup procedures have several errors. 

· The “Manual shutdown procedures” topic, “To stop Application Engine processes” section, step 1, should refer to the Process Application Engine Services Manager rather than the Process Engine Services Manager. Step 3 should include JBoss.

· The “Manual shutdown procedures” topic, “To stop Content Engine processes” section, step 2b, should refer to the Process Services Manager rather than the Process Engine Services Manager. In addition, prior to step 1, you must stop the FileNet P8 CFS Server for Image Services service via the Windows Services console.

· The “Manual startup procedures” topic, “To start Content Engine processes” section, step 2b, should refer to the Process Services Manager rather than the Process Engine Services Manager. In addition, add the FileNet P8 CFS Server for Image Services to the list of services to start.

· The “Manual startup procedures” topic, “To start Application Engine processes” section, step 2, should refer to the Process Application Engine Services Manager rather than the Process Engine Services Manager. Step 1 should include JBoss.

· The “Command line and batch file shutdown procedures” topic, “To stop the Application Engine processes” section, step 4 for Windows, should read net stop “VWServicesAE”. Step 5 should include JBoss.

· The “Command line and batch file shutdown procedures” topic, “To stop processes on the Content Engine” section, should include the command net stop “FileNet P8 CFS Server for Image Services” at the beginning. 

· The “Command line and batch file startup procedures” topic, “To start the Process Engine services” section for Windows, should include the command net start “IMSService” at the beginning. 

· The “Command line and batch file startup procedures” topic, “To start processes on the Content Engine” section, should include the command net start “FileNet P8 CFS Server for Image Services” at the end. 

The “Command line and batch file startup procedures” topic, “To start the Application Engine processes” section, should include JBoss.

	147507
	Process Engine installation procedures for all three UNIX platforms have incorrect directory structure information. 
Corrections are as follows:

· On AIX, navigate to /cdrom instead of /ProcessEngine.AIX

· On HP-UX, navigate to /cdrom instead of /ProcessEngine/HPUX

· On Solaris: navigate to /cdrom/p8pe35sol instead of /ProcessEngine.Solaris


Resolved in P8eF-3.5.1-003

	Defect ID
	Description

	192332
	Using the setCurrentPage function on inaccessible pages causes an exception.

	191765
	The combination of YearOf and CreationDate functions do not work as expected. The numbers that are entered in text cells are formatted incorrectly.

	191677
	Calculations appear to not fire past the visible extent of a scrolling table.

	188920
189854
	Table content is incorrect when a single underscore is used in the data.

Initial Fix Pack: P8eF-3.5.1-1002

	188835
	When eForms is running with a workflow policy, users receive the following error after they select an attachment and sign the form: "Cannot execute code from a freed script."

	188620
	Users cannot open a complicated eForm template after upgrading to P8eF-3.5.1-001.

	187295
	Users cannot sign a form that uses the CharForm() function to check formula in signature cells.

	187007
188378
	The Cell1[Row + 1] calculation does not populate table cells after upgrading to P8eF-3.5.1-001.

Initial Fix Pack: P8eF-3.5.1-1002

	186043
188747
	Java script API: When Cell1.setEnabled(true) in form.addOnLoad(InitHandlers) is followed by a page switch, Cell1 in the UI is set to read only.

Initial Fix Pack: P8eF-3.5.1-1002

	180555
	Form data takes 20+ seconds longer to display for users whose form data security setting is "View Content" and View Props" than users who have full control.


Resolved in P8eF-3.5.1-002

	Defect ID
	Description

	184783
184654
	Cannot populate table using the tokenize function when a large number of rows need to be populated. 

Initial Fix Pack: P8eF-3.5.1.1001.

	181947
183823
	For any application server that uses a .war file: when eForms fix pack 3.5.1-001 is applied, custom settings will not be retained if the steps in the installation guide are followed.

Workarounds: 

· Perform this workaround after every eForms 3.5 fix pack: 

346. Copy customizations into the Workplace (or some other location).

347. Install and deploy eForms as you normally do. 

348. Move the customizations back into the deployed space. 

· Perform this workaround to eliminate any issues with future eForms fix packs losing customizations:

349. Place the customizations directly into the WAR file either before or after installation of eForms. 

NOTE This fix occurs in the documentation release that corresponds with the P8eF-3.5.1-002 fix pack release.

	181328
182737
	The tab order is incorrect when a lookup is invoked in a table.

Initial Fix Pack: P8eF-3.5.1.1001.

	180415
	In a scrollable table that has a drop-down list in the first cell of each row, the drop-down list does not appear in rows that are added to the table.

NOTE Fixed indirectly: Both P8eF-3.5.1-1000 and P8eF-3.5.1-001 have solved this issue.

	180249
	Users can change the contents of a display-only date cell.

	176468
	Firefox treats incompatible style sheet properties as JavaScript errors.

	169707
	Mapping a value to a table column displays the value in all the rows of the column.


Resolved in P8eF-3.5.1-001

	Defect ID
	Description

	176224
176713
	Alert is not working when users use the check function.

Initial Fix Pack: P8eF-3.5.0-1012.

	178144
179612
180469
	HTTP lookup from a choice list does not populate the data first time. Subsequent lookup after the initial one works.

	175492
175997
180464
	Timespan function does not account for daylight savings time.

Note the following when using the TimeSpan() function, in regard to Daylight Savings Time (DST).  If the client system is in an area that is observing DST and the server is in an area that is not observing DST, or the other way around, there will be a one hour difference between the results of client side and server side use of the TimeSpan() function.  This does not affect most cases, as normally a user is only concerned with processing results at the client.  This issue will be addressed in the P8eF 4.0 release.

Initial Fix Pack: P8eF-3.5.0-1011.

	173058
176954
180465
	Users can insert and delete rows in a table that has display-only columns. 

Initial Fix Pack: P8eF-3.5.0-1012.

	178670
179437
	Check function is slow when a lot of characters are entered in a text cell.

Initial Fix Pack: P8eF-3.5.0-1013.

	178222
179436
	Check box array values are not always pushed to the workflow fields they are mapped to.

Initial Fix Pack: P8eF-3.5.0-1013.

	178134
179435
	Users receive "Array length must be assigned a finite positive number" error after P8eF-3.5.0-1012 has been applied.

Initial Fix Pack: P8eF-3.5.0-1013.

	178065
179434
	Tokenize function does not populate table as expected under a certain condition.

Initial Fix Pack: P8eF-3.5.0-1013.

	177999
179432
	An unexpected result occurs when mapping string array from a form table to a PE data field under a certain condition.

Initial Fix Pack: P8eF-3.5.0-1013.

	177982
179351
	Users are able to click the Launch button more than once, resulting in the creation of multiple work items.

Initial Fix Pack: P8eF-3.5.0-1013.

	176766
179311
180621
	Data in choice list cells disappear when a space is placed after the entry in the lookup cell and you tab out.

Initial Fix Pack: P8eF-3.5.0-1012.

	176199
176948
	Tables show concatenation of other rows in the first row.

Initial Fix Pack: P8eF-3.5.0-1012.

	182626
	Users cannot see beyond the 9th page of an eForms template.

	177161
	HTTP lookup takes longer than 25 seconds to populate form cells but indicates the lookup is done after 25 seconds has passed. 

	168351
	In a German environment, the comma character (,) is dropped when mapping class properties with forms.

NOTE This defect was resolved in P8AE-3.5.1-1012, a fix pack built on top of P8AE3.5.1-002.


Resolved in P8eF-3.5.1

	Defect ID
	Description

	175284
	A better alert description is needed when closing an eForms window. 

	175019
175165
	The Up arrow in a table's scrollbar is disabled when switching between pages. 

	173786
	Transliterate function does not worked when deployed. 

	169845
171826
	A table scrollbar is grayed out when the table content is populated by a HTTP lookup. 

	168906
171795
	eForms date calculation within a table fails to display correctly when testing with the Test Form Template from Workplace.


Resolved in P8eF-3.5.0-004

	Defect ID
	Description

	150327
159854
164387
167938
169063
	When a form has more than one page, you cannot scroll to see the remaining pages. 

	169305
	Previous lookup values are added to subsequent choice list entries. 

	168987
	eForm template generates a java.lang.ArrayIndexOutOfBoundsException when HTTP lookup returns an empty string. 

	168942
	eForms Install Guide: Document setting $DISPLAY to display attached images if AE is on a UNIX server.

For more information, see the FileNet eForms for FileNet P8 Platform Workplace Installation Guide on the (www.ibm.com/software/data/support).

	167938
	When a form has more than one page, you cannot scroll to see the remaining pages of the form. 

For more information, see the FileNet eForms for FileNet P8 Platform Workplace Help on the (www.ibm.com/software/data/support)

	167635
	Error occurs during fix pack P8eF-3.5.0-003 installation. 

	166507
	When a form is configured with an HTTP auto-increment and a vbCrLf (Visual Basic Carriage Return Line Feed) is returned from the ASP page, the characters "\r\n" are added to the returned value. 

	165805
	Row function in table is not working in FileNet P8 Platform Workplace. 

	165500
	(Doc DTS 166372)The eForms for FileNet P8 Workplace Installation Guide does not include instructions about how to resolve the error that displays if you try to launch the eForms installer without having a valid JRE installed. Instructions should be added to use the command line flag –is:javahome to point to the _jvm directory where the Application Engine is installed. 

	165500
	P8 eForms installer on Linux requires JRE.

For more information, see the FileNet eForms for FileNet P8 Platform Workplace Installation Guide on the (www.ibm.com/software/data/support).

	165282
	No documentation for upgrading of Print Services.

For more information, see the FileNet eForms for FileNet P8 Platform Workplace Installation Guide on the (www.ibm.com/software/data/support).

	165020
	Values do not display in tables when scrolling occurs. 

	165017
	Calculating values from hidden rows between two scrolling tables results in runtime error. 

	162948
	Help text is needed for new attachments action "Add/Replace Using Form Template."

For more information, see the FileNet eForms for FileNet P8 Platform Workplace Help on the (www.ibm.com/software/data/support).


Resolved in P8eF-3.5.0-003

	Defect ID
	Description

	164725
	If you have a calculated choice list on a page other than the start or current page, and if you have script debugging enabled for your browser, opening the form causes a “This.proxies[…].hField’ is null or not an object” runtime error to display and the form locks up. This is a duplicate of 156929.  

	164269
	For HTTP lookups where the content type is “text/plain,” an error message displays if the jsp page includes an <html> tag. 

	164266
	In a locale where a dot is used as a thousands separator (e.g., German), the dot does not display when the form is generated as a PDF.

	162746
	The locale settings in which a form is opened the first time get cached with the template and don’t get reset for subsequent users. As a result, the form always opens with the date, time, and number settings of the first locale.

	162438
	If you configure a table with a scrollbar and you clear the “show always” option in eForms Designer, the scrollbar still displays when the form opens. 

	161997
	When a table with constant values uses functions like MakeColumn in more than one column of the table, the returned results are incorrect. 

	160927
	For HTTP lookups where the content type is "text/plain," an error message displays if the jsp page includes an <html> tag. 

	160463
	A JDBC auto-increment that is configured for an Oracle database does not work if the column type in the database is Number. 

	159041
	Cells on a form page that use constant values are being recalculated when returning to the page after navigating away from it. This was originally logged as a problem with checkbox selections being overwritten with the default value when returning to a page.

	157490
	For cells whose values are being used to create the URL for HTTP actions, the data is not being automatically URL-encoded.  

	157337
	Cells on a form page that use constant values are being recalculated when returning to the page after navigating away from it. This was originally logged as a problem with a value being lost from a dynamic choice list when returning to a page. 

	157072
	When including cell data in a URL, empty values and date values show unexpected results. 

	155042
	If you obtain a new signing certificate for use with the Microsoft CSP signing service, you cannot sign a form with that certificate until approximately 12 hours have passed. This fix requires CAPICOM version 2.1.0.1 

	154637
	If a form is configured with an HTTP lookup and the data being returned includes a .jpeg image file, an “index out of bounds” error message displays.  

	153341
	When a form is configured with an HTTP lookup and one of the values that is returned is blank, an error message displays. 

	152637
	Cells configured with an incorrect time format accepts times between 24:00 and 24:59. 

	147998
	Instructions should be added in the localization document on how to enter country-specific UI strings when naming the Strings.properties file.

	146468
	On an operating system with Japanese regional settings, the Long Date format in the I-Sign Signature Details dialog box incorrectly appears in a US-English date mask with Japanese translated text.


Resolved in P8eF-3.5.0-002

	Defect ID
	Description

	184783
184654
	Cannot populate table using the tokenize function when a large number of rows need to be populated. 
Initial Fix Pack: P8eF-3.5.1.1001.

	181328
182737
	The tab order is incorrect when a lookup is invoked in a table.

Initial Fix Pack: P8eF-3.5.1.1001.

	180415
	In a scrollable table that has a drop-down list in the first cell of each row, the drop-down list does not appear in rows that are added to the table.

NOTE Fixed indirectly: Both P8eF-3.5.1-1000 and P8eF-3.5.1-001 have solved this issue.

	180249
	Users can change the contents of a display-only date cell.

	176468
	Firefox treats incompatible style sheet properties as JavaScript errors.

	169707
	Mapping a value to a table column displays the value in all the rows of the column.

	184783
184654
	Cannot populate table using the tokenize function when a large number of rows need to be populated. 

Initial Fix Pack: P8eF-3.5.1.1001.

	155718
	When opening a document policy for a form configured with an HTTP auto-increment, the auto-increment fails and an error message appears. 

	155400
	[eForms now supports Oracle Application Server]. Requires AE 3.5.1-- FileNet eForms does not currently support Oracle Application Server  

	155129
	An error occurs when a second form is rendered to PDF and is opened in the same window as a previous form that was rendered to PDF. 

	154632
	On some platforms, the first user to open a form is presented with an error message that states ".../Workplaceforms/misc/Functions.xml" cannot be found." Subsequent users to open the form are presented with a JavaScript error. 

	153614  
	The "Files for Like Browser" feature does not work as expected for HTTP data submits. 

	153292
	If a number cell is formatted with a '*' as a placeholder for a digit and the '*' is left blank, the number is deleted and the cell remains empty. 

	153119
	When the user clicks the Sign button in a signature cell, a selection dialog box displays Secure Email and Encrypting File System certificates when there is only one valid digital signature certificate available. 

	152915
	The currency symbol does not display in the correct location. 

	152677
	The scrolling buttons in a table do not display consistently when the user tabs through some columns on the table. 

	152651
	When the file name of an image contains non-ASCII characters and is uploaded to a picture cell, the file name becomes corrupted when it is displayed in the File Download dialog box. 

	152637  
	Time formatted cells incorrectly accept values between 24:00 and 24:59. 

	152631
	Number formatted cells that are saved with a zero only incorrectly display without a value when the saved form data document is opened. 

	152631
	Number formatted cells that are saved with a zero only incorrectly display without a value when the saved form data document is opened. 

	152470
	If a debit amount is entered into a '#,##0.00 Cr;#,##0.00 Dr;0.00' formatted number cell, the amount is incorrectly converted to a credit or deleted. 

	151862
	A signature cell that contains a transparent background color and is configured with I-Sign (Ink) displays a broken image link. 

	151718
	A form will not display when characters such as returns and backslashes are included on form button labels.  

	149688
	The user cannot insert the '@' character into a cell when the regional settings and keyboard are set to Spanish or French.  

	149390
	The defined default selection from an ASP for a dynamic choice list does not display consistently in a choice list cell.  

	148025
	Cells configured for number formatted values with auto-decimals do not display correctly. 

	148009
	The WorkDays function returns different values in eForms Designer test mode and in P8 eForms. 

	146572
	HTTP lookup enhancements are required for tables and picture cells. 

	146128
	When a form is translated, the watermark that appears in picture and signature cells is not centered as expected.

	146003
	A null pointer exception occurs when the user tabs from a choice list configured with a conditional tabbing calculation to a checkbox cell. 

	144923
	In an error exception message, some Japanese characters are incorrectly translated as question mark symbols (i.e., ???).  

	137010
	HTTP lookup requests to a JSP do not work when characters such as | or ; or & are included in the request. 


Resolved in P8eF-3.5.0-001

	Defect ID
	Description

	149727
	Invalid overflow pages result when there is a large text font size in a cell or if there is a checkbox field on the form. 

	149732
	Text contained in a right or left justified field wraps incorrectly in PDF generated forms. 

	150345
	Overflow pages incorrectly display all cells on a form instead of just the cells that are configured with the overflow page option. 

	151582
	If a table cell is configured to print on overflow pages and the text in that cell exceeds the number of visible lines in the table, the text displays incorrectly when the form is generated as a PDF. 


Resolved in eFD-5.0.0-003

	Defect ID
	Description

	 165779
	(Doc DTS 167367)The eForms Designer Help, in the “FileNet P8 menu options,” “Set the Workplace address,” “Log out from an object store,” and “What’s new?” topics, contains incorrect terminology for extensible authentication. The words “single sign-on” are used when  “extensible authentication” should be used instead.

	163294
	(Doc DTS 167370)The eForms Designer Help, in the “Configure JDBC lookups,” “Configure JDBC auto-increments,” and “Configure JDBC submits” topics, incorrectly contains a note suggesting that the system assumes that Microsoft SQL Server 2000 driver is used if the Driver class file field is left blank.

	162847
	(Doc DTS 167379)The eForms Designer Help, in the “Number cell type” topic, contains the sub-heading “Auto decimal” which should read “Auto-decimal (Desktop eForms only).”

	155141
	(Doc DTS 167378)The eForms Designer Help, in the “Draw a button” topic, contains the incorrect sub-heading “Desktop eForms, Forms Manager” under the heading “Button label.” The sub-heading should read “Desktop eForms.”


Resolved in eFD-5.0.0-002


	Defect ID
	Description

	150839
138710
	Certain PCL6 and PCL5e printer drivers could cause application instability.

	162158
	When using the Add New command from the FileNet P8 menu, you cannot select ITX Form Template sub-classes.

	161870
	With multiple cells selected, changing the property of a cell changes all the cell labels.

	161254

160450
	For the Web Services eForms fill platform, if you configure a number cell with the General format, an incorrect number of significant digits are entered in the eForms Web Template and rounding errors will occur.

	159368
	When you create a form that has a cell with a name longer than 31 characters, memory gets corrupted after the form is saved as an ITX.

	157673
	When configuring deployment for a form with Forms Manager eForms selected as the target platform, the default format is ITP rather than ITX.

	157075
	When you save a template as an ITX Form Template 4.1x from within eForms Designer, information in the XML is missing. When the form is opened in a web browser and a PDF is generated, the titles of the cells fo not display.  

	135795
	The Go to cell button type is not functioning correctly

	123555
	For some languages, special characters (for example, the circumflex) that appear above capitalized letters do not display correctly in some dialog boxes.

	
	The simplified Chinese locale is supported only in Windows XP for eForms Designer 5.0.0.


Resolved in eFD-5.0.0-001

	Defect ID
	Description

	158541
	The eForms Designer Help, in the topic “Configure JDBC lookups,” contains the incorrect connection string format example JDBC.oracle:thin:@//servername:port/serverinstance. This should read  JDBC.oracle:thin:@//servername:port:serverinstance.  
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